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About This Guide

This user’s guide contains the instructions necessary to operate and maintain 
your BD FACSAria™ Fusion flow cytometer. Because many instrument functions 
are controlled by BD FACSDiva™ software, this guide also contains basic 
software information needed for instrument setup. For detailed information on 
software functions, see the BD FACSDiva Software Reference Manual.

The BD FACSAria Fusion User’s Guide assumes you have a working knowledge 
of basic Microsoft® Windows® operation. If you are not familiar with the 
Windows operating system, see the documentation provided with your computer.

Before using the BD FACSAria Fusion flow cytometer for the first time, review 
the following information:

• System Components on page 17 to become familiar with system 
components

• Theory of Operation on page 47 to understand how the instrument works 
and to learn about the software components used to control different 
subsystems

• Using BD FACSDiva Software on page 81 to see where software controls 
are located 

Instructions for routine acquisition, analysis, and sorting can be found in 
Chapters 4 and 5.
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Conventions

The following tables list conventions used throughout this guide. Table 1 lists the 
symbols that are used in this guide or on safety labels to alert you to a potential 
hazard. Text and keyboard conventions are shown in Table 2.

Table 1  Hazard symbols

Symbola

a. Although these symbols appear in color on the instrument, they are in black and white throughout this user’s 
guide; their meaning remains unchanged.

Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Electrical danger

Laser radiation

Biological risk

Pinch hazard

Table 2  Text and keyboard conventions

Convention Use

Tip Highlights features or hints that can save time and prevent difficulties

NOTE Describes important features or instructions 

Italics Italics are used to highlight book titles. 

Bold Bold text indicates software elements such as windows, menus, buttons, 
and tabs that are used to complete tasks.
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Technical Assistance

For technical questions or assistance in solving a problem:

• Read the section of the user’s guide specific to the operation you are 
performing. 

• See Troubleshooting on page 253.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• Product name, part number, and serial number

• Any error messages

• Details of recent system performance

For instrument support from within the US, call 877.232.8995.

For support from within Canada, call 888.259.0187.

Customers outside the US and Canada, contact your local BD representative or 
distributor.

> The arrow indicates a menu choice. For example, “select File > Print” 
means to select Print from the File menu.

Ctrl+X When used with key names, a plus sign means to press two keys 
simultaneously. For example, Ctrl+P means to hold down the Control key 
while pressing the letter p. 

Table 2  Text and keyboard conventions (continued)

Convention Use
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Limitations

This instrument is for Research Use Only. Not for use in diagnostic or 
therapeutic procedures.

BD Biosciences is providing software without warranty of any kind on an as-is 
basis. The software and workstations are intended for running the instruments 
supplied by BD Biosciences. It is the responsibility of the buyer/user to ensure 
that all added electronic files including software and transport media are virus-
free. If the workstation is used for internet access or purposes other than those 
specified by BD Biosciences, it is the buyer/user’s responsibility to install and 
maintain up-to-date virus protection software. BD Biosciences does not make any 
warranty with respect to the workstation remaining virus-free after installation. 
BD Biosciences is not liable for any claims related to or resulting from the buyer/
user's failure to install and maintain virus protection.
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1

System Components

The following topics are covered in this chapter:

• BD FACSAria Fusion System on page 18

• Workstation on page 19

• Biosafety Cabinet on page 20

• Flow Cytometer on page 21

• Emergency Stop Button on page 44
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BD FACSAria Fusion System

The BD FACSAria Fusion flow cytometer is a high-speed fixed-alignment 
benchtop cell sorter. With its fixed-optics design and digital electronics, the 
BD FACSAria Fusion flow cytometer enables multicolor analysis of up to 
18 fluorescence and two scatter options simultaneously.

The BD FACSAria Fusion system improves on BD FACSAria™ III technology 
with the following features:

• Higher power blue, red, and violet lasers for better multicolor performance 
and small particle resolution.

• Easier access to the fluidics, detectors, and electronics located in the base of 
the system.

• Enhanced biosafety with an optional biosafety cabinet (BSC) and 
integrated Aerosol Management System (AMS) that operates 
independently.

The system consists of three main components: the BD FACSAria Fusion, the 
BSC, and the workstation, as shown in Figure 1-1 on page 19.
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Figure 1-1  BD FACSAria Fusion system with the BSC

Workstation

Data acquisition and analysis, as well as most BD FACSAria Fusion cytometer 
functions, are controlled by BD FACSDiva software on a PC workstation. The 
workstation includes a desktop computer, one or two monitors, and a color 
printer, and is equipped with the following applications:

• Microsoft® Windows® 7 operating system

• BD FACSDiva software, version 8.0 or later

- Data acquisition and analysis

- Automatic fluidics startup, shutdown, and cleaning modes

BSC

Workstation

Optics

Fluidics
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- Sort setup, stream monitoring, clog detection, and recovery

- BD™ Cytometer Setup and Tracking (CS&T) module for setup and 
tracking performance

• Supporting documentation for the software

For information about software features specific to the BD FACSAria Fusion, see 
Chapter 2, Theory of Operation, and Chapter 3, Using BD FACSDiva Software. 
For general software information, see the BD FACSDiva Software Reference 
Manual.

BD FACSDiva software version 8 includes the CS&T module version 3.0. For 
information on running the CS&T module with the BD FACSAria Fusion, see 
Checking Cytometer Performance on page 134. For information about the 
CS&T module, see the BD Cytometer Setup and Tracking Application Guide.

Tip     For easy access to the online BD FACSDiva Software Reference Manual, 
select Help > Documentation > Reference Manual.

Biosafety Cabinet

The optional BSC for the BD FACSAria Fusion has been verified to meet 
personnel and product protection standards for a Class II Type A2 biosafety 
cabinet, the National Sanitation Foundation International Standard 49, and the 
Australian Standard® AS 2252.2–2009. The BSC is suitable for work with 
Biosafety Level (BSL) 1, 2, and 3 (low to moderate risk) infectious agents.

The BSC has an integrated Aerosol Management System (AMS). See page 333 for 
information.
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Flow Cytometer

The BD FACSAria Fusion cytometer consists of three subsystems (fluidics, optics, 
and electronics). The BD FACSAria Fusion cytometer is relatively compact, with 
a much smaller footprint than most sorters with the same capabilities. The 
cytometer requires only a 20-A electrical outlet and an in-house air source (or 
optional compressor) for the fluidics. See Figure 1-2 for a view of the 
BD FACSAria Fusion cytometer without the optional BSC.

Figure 1-2  BD FACSAria Fusion system without the optional BSC

See the following sections for more information on each subsytem:

• Fluidics System on page 22

• Optics System on page 35

• Cytometer Electronics on page 43

Optics access door

Storage cabinet door

Flow cell access door

Sort collection

Fluidics access door

chamber door
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Fluidics System

The fluidics system supplies sheath and cleaning fluids, and collects waste from 
the cytometer. The contents of the fluidics drawer and the fluidics components 
located inside the cytometer make up the fluidics system.

Fluidics Drawer

The fluid containers, lines, and filters, and the connectors panel are located inside 
the fluidics drawer. The fluidics drawer slides out for easy access to its contents. 
Press down the yellow lever on the top right side of the drawer to release the lock 
and slide the drawer out or in.

Figure 1-3  Location of fluidics drawer and lock-release lever

Containers

The fluidics drawer holds a 10-L stainless steel sheath tank, a 5-L stainless steel 
ethanol shutdown tank, a 10-L waste container, and three 5-L auxiliary cleaning 
fluid containers (Figure 1-4 on page 23).
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Figure 1-4  Fluidics drawer containers

Pressure Gauge

A pressure gauge is located on the sheath fluid tank to confirm that the tank is 
pressurized.

Figure 1-5  Sheath pressure gauge

Sheath tank with pressure gauge

Ethanol shutdown tank

Waste tank

Connectors panel

BD FACS cleaning solution

DI water

Ethanol
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Fluid Filters

The fluid filters for DI water, BD FACS™ cleaning solution, and ethanol are 
located in the outside left panel of the fluidics drawer.

Connectors Panel

The connectors panel is located in the top right section of the fluidics drawer. A 
fluid line and a sensor connect each container to the panel.

Sensor

Fluid outWaste outFluid in

Sensor

Fluid in

Sensor

Fluid in

Waste
line

Sensor

Waste
sensor
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Fluidics Components

When the fluidics system is activated, the sheath fluid from the pressurized sheath 
tank is forced from the fluidics drawer up into the cuvette flow cell where 
hydrodynamic focusing forces particles from the sample injection chamber 
through the cuvette in a single-file stream.

Within the cuvette flow cell, laser light is focused on the sample core stream. 
Fluorescent molecules excited by the different laser wavelengths are detected by 
the optics and analyzed by the electronics. Particles are then either transported to 
waste reservoirs via the waste aspirator, or sorted into a collection device within 
the sort collection chamber. 

The following fluidics components are described in this section. For more 
information about fluidics, see Fluid Movement on page 48.

• Sample Injection Chamber on page 26

• Tube Holders on page 28

• Cuvette Flow Cell on page 28

• Integrated Nozzle on page 29

• Sort Block on page 30

• Sort Collection Chamber on page 34
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Figure 1-6  Overview of the flow cell region

Sample Injection Chamber

The sample injection chamber is where sample is introduced into the flow 
cytometer. During acquisition, the chamber is pressurized to force sample toward 
the cuvette flow cell.

Samples can be agitated and temperature-controlled within the sample injection 
chamber using controls in the software (see Fluidics Controls on page 83). You 
can view the amount of fluid remaining in your sample tube by pressing the 
chamber light button shown in Figure 1-7. 

Do not use the chamber light for long periods with samples stained with 
light-sensitive reagents.

Pinch valve 
and bubble 
detector

Cuvette 
flow cell

Sort block 
door

Sort 
collection 
chamber

Deflection 
plates warning 
light

Nozzle holder
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Figure 1-7  Sample injection chamber

Bubble Detector

The bubble detector is an optical sensor that detects air bubbles from the sample 
tube. Located on the sample line just before the pinch valve, it triggers the pinch 
valve to close, cutting off sample flow and preventing bubbles from entering the 
flow cell. When a bubble is detected, the bulk injection chamber light and LED in 
the button blink to alert the operator.

Chamber light 
button

Sample 
loading port

Tube holder

Sample access 
door

Sample 
injection 
chamber

Bubble detector
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Tube Holders

A variety of tube holders are provided with the cytometer to accommodate tubes 
from 15-mL centrifuge tubes to 1.0-mL microtubes (Figure 1-8).

To load a tube, install the appropriate-size tube holder onto the loading port, and 
place a tube in the holder. Make sure to press the tube holder down firmly onto 
the metal rod in the loading port, so the tube holder is seated correctly each time 
a tube is installed.

When the Load button is clicked in the software (see Acquisition Controls on 
page 100), the loading port rises to enclose the tube within the chamber. The 
chamber is then pressurized so that sample will flow to the flow cell.

Figure 1-8  Tube holders

After a tube is loaded, the Load button changes to Unload. Click the Unload 
button to lower the loading port after data has been recorded. After each tube is 
unloaded, sheath fluid flushes the sample tubing inside and out to reduce 
potential sample carryover. 

Cuvette Flow Cell. The BD FACSAria Fusion system includes a next-generation 
flow cell that has been optimized for four laser beam spots. The cuvette flow cell 
is the heart of the BD FACSAria Fusion cytometer (Figure 1-9). Within the flow 

To prevent injury from moving parts, keep your hands and clothing away 
from the loading port when a tube is loading or unloading. Do not place 
objects under the loading port.

15 mL

12 x 75 mm

Tube holders

1-mL microtube
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cell, hydrodynamic focusing forces particles through the cuvette in a single-file 
stream, where laser light intercepts the stream at the sample interrogation point. 

Figure 1-9  Cuvette flow cell 

The unique flow cell design permits particles to flow through the cuvette at a low 
velocity (approximately 6 meters per second for the 70-micron sort setup), 
allowing longer exposure to laser energy. The cuvette is gel-coupled to the 
fluorescence objective lens to transmit the greatest amount of emitted light from 
the interrogation point to the collection optics (see Optics System on page 35). 
After passing through the cuvette, the stream is accelerated (to approximately 
30 meters per second with the 70-micron sort setup) as it enters the nozzle tip, 
where the drop drive breaks the stream into droplets for sorting.

Integrated Nozzle 

The BD FACSAria Fusion next-generation flow cell requires integrated nozzles 
that have been optimized for it. 

The integrated nozzles are available in four sizes (70, 85, 100, and an optional 
130 µm) to accommodate a variety of particle sizes, plus a closed-loop nozzle for 
use in cleaning and shutdown procedures. The nozzle is keyed to a fixed position 

Flow cell

Laser beams

Nozzle

Nozzle locking
lever

Interrogation point
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at the lower end of the cuvette. Because the nozzle is below the interrogation 
point, optical alignment is not affected when the nozzle is changed.

Figure 1-10  Integrated nozzle

See these sections for more information on the nozzle:

• Changing the Integrated Nozzle on page 231

• Cleaning the Integrated Nozzle on page 233

• Handling the Integrated Nozzle on page 235

Sort Block

After leaving the nozzle, particles pass through the sort block where they are 
either transported to waste via the waste aspirator, or sorted into a collection 
device in the sort collection chamber. The sort block houses the high-voltage 
deflection plates, along with the aspirator and aspirator drawer (Figure 1-11 on 
page 31).

MS indicates integrated nozzle for 
the BD FACSAria Fusion flow cell

Bottom view of nozzle
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Figure 1-11  Sort block with door open

Note that the entire sort block assembly can be rotated on a fixed pivot point to 
adjust the position of the stream in the waste aspirator. If the keyed stream 
position differs between different nozzles, the stream might not hit the center of 
the aspirator after the nozzle is changed. In this case, you can change the angle of 
the sort block by loosening the adjustment screws on both sides of the deflection 
plates and rotating the sort block. An Allen wrench is provided in the accessory 
kit. Tighten the screws when the stream is re-centered in the aspirator.

Deflection Plates. The high-voltage deflection plates are used to deflect side 
streams during sorting. The plates are turned on and off using the Voltage control 
in the Side Stream window (see Side Stream Formation on page 69). A red 
warning light is illuminated whenever the plate voltage is on (Figure 1-13 on 
page 33).

Adjustment screws

Deflection plates

Aspirator drawer

Aspirator

Sort collection 
device
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Aspirator Drawer. The aspirator drawer keeps the sort collection tubes covered 
until sorting begins (Figure 1-12). You can open and close the drawer using a 
control in the Sort Layout or Side Stream window (see Using Sorting Controls on 
page 109). When the Sweet Spot is on and a clog is detected during sorting, the 
drawer automatically closes to protect the sort collection tubes. For information 
on how to handle a clog, see Responding to a Nozzle Clog During a Sort on 
page 190.

Figure 1-12  Aspirator drawer closed (left) vs open (right)

Aerosol Management . During sample acquisition and sorting, the sort block 
door and flow cell access door should be kept closed to help contain potential 
aerosols (Figure 1-13 on page 33).

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the voltage warning light is 
illuminated, or when the software indicates that the plate voltage is on. The 
plates remain energized even when the sort block door is open. 

To avoid pinching your hands or fingers in the drawer, keep your hands 
away from the sort block during sorting.
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Figure 1-13  Sort block with door closed 

Additional aerosol removal is provided by either the AMS or the BD™ Aerosol 
Management Option (AMO). 

The AMS is integrated into the BSC and contains a high efficiency particulate air 
(HEPA) filter. See Operating the AMS on page 335 for instructions.

The AMO is an optional device for systems without a BSC. The AMO evacuates 
the sort collection chamber during sorting and is equipped with an ultra-low 
penetrating air (ULPA) filter to trap aerosolized particles. See Chapter 10, BD 
Aerosol Management Option on page 303 for complete information on using 
this option.

Cell sorters that use droplet generation methods, such as the 
BD FACSAria Fusion, can produce aerosols around the sample stream. 
When acquiring biohazardous samples, follow universal precautions at all 
times. Keep the sort block door closed during sorting. If you need to access 
the sort block and you are working with highly infectious samples, consider 
turning off the stream before opening the sort block door.

Deflection plates 
warning light

Sort block

Hydrophobic 
filter, included 
with the AMO
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Sort Collection Chamber

Collection devices are installed in the sort collection chamber to collect sorted 
samples. The collection devices are designed in two pieces with a universal top 
that can be used with different tube configurations. The universal top has three 
holes on the back side that help with aerosol evacuation when an AMO or AMS 
is installed. Figure 1-14 shows the types of collection devices that are available. 

Figure 1-14  Sort collection devices 

An automated cell deposition unit (ACDU) that sorts into multiwell plates and 
onto microscope slides is available as an option. See Figure 1-15 on page 35. 
BD Biosciences also offers a temperature control option to maintain the 
temperature of sorted samples during sorting. See Temperature Control Option 
on page 345.

Universal top (front view) Universal top (back view)

Four-way 1-mL
(optional)

Four-way 12 x 75-mm Four-way 1.5-mL
Eppendorf

Two-way 12 x 75-mm

Two-way 15-mL
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The sort collection chamber door should be kept closed when sorting onto a 
plate. The door keeps the chamber free of dust and other airborne particles, and 
seals the chamber during aerosol evacuation for cytometers equipped with the 
AMO.

Figure 1-15  Plate Loader on ACDU 

Optics System

The BD FACSAria Fusion cytometer uses innovative designs for both the 
excitation and collection optics. For detailed optics specifications, see Laser 
Options on page 285.

Excitation Optics

The excitation optics consist of lasers, fiber optic cables, beam-shaping prisms, 
and an achromatic focusing lens, as shown on the X-mount optical plate (Figure  
on page 36).
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Figure 1-16  X-mount optical plate

For information about how signals are generated, see Signal Generation on 
page 52.

The BD FACSAria Fusion cytometer uses air-cooled and solid state lasers that do 
not have special power or cooling requirements. 

The system also supports up to six installed lasers, of which only four can be used 
at once. 

See Table 1-1 for the laser choices. See Laser Options on page 285 for laser 
specifications. 

Table 1-1  Laser configurations 

Laser Wavelength (nm) Comments

Red 640 Standard

Yellow-Green 561 Optional

Blue 488 Standard

Blue-Violet 445 Optional 

Shares the blue-laser optics. See Laser Options on 
page 285.
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Fiber optics direct the laser light in a precise and constant manner onto beam-
shaping prisms, which in turn transmit the laser light to a focusing lens. The lens 
focuses the laser light onto the sample core stream within the cuvette flow cell 
(Figure 1-9). The lasers are positioned on the sample stream for optimal 
generation of signals. Since the optical pathway and sample core stream are 
fixed, optimization is constant from day to day.

X-Mount Optical Plate

The fiber optic heads for all existing lasers (except the 375-nm laser) are mounted 
on an X-mount optical plate. Figure 1-17 on page 38 shows the location for each 
fiber optic head.

The 488-nm and the 445-nm lasers share the same beam spot, so only one of 
them can be used at a time. Similarly, the 375-nm and 405-nm lasers share a 
beam spot and only one of them can be used at a time. 

Violet 405 Optional

Near UV 375 Optional 

Shares the violet-laser optics. See Laser Options 
on page 285.

Lasers emit intense, coherent electromagnetic radiation that can cause 
irreparable damage to skin and eyes. To prevent retinal burns and possible 
blindness, do not remove laser shielding, adjust laser controls, or attempt to 
service the cytometer any place where laser warning labels are attached. See 
the BD FACSAria Fusion Safety and Limitations Guide for the placement 
of laser warning labels.

Table 1-1  Laser configurations 

Laser Wavelength (nm) Comments
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Figure 1-17  The X-mount optical plate laser configuration

375-nm Laser

The 375-nm laser option features a solid state laser that also excites 
fluorochromes and dyes. It is also useful for side population studies. It uses the 
same emission pathways as the violet laser option. The laser alignment is fixed 
and requires no adjustments once it is installed.

The 375-nm laser is the only laser not mounted on the X-mount optical plate. It 
is mounted next to the flow cell as shown in the Figure 1-18.

Figure 1-18  The 375-nm laser

375-nm laser
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Collection Optics

From the cuvette flow cell, laser light is collected by a fluorescence objective lens 
that is gel-coupled to the cuvette to transmit the maximum amount of light. The 
lens collects and focuses fluorescent light emitted at each of the laser focal points 
onto individual collection fibers. These fibers transfer the emitted light to the 
collection optics, as shown in Figure 1-19.

Figure 1-19  Side view of flow cell, nozzle, and objective lens

The collection optics are set up in octagon-shaped arrays that are engineered to 
maximize signal detection from each laser. This is accomplished by transmitting 
the highest wavelengths to the first photomultiplier tube (PMT), and reflecting 
lower wavelengths to the next PMT through a series of longpass dichroic 
mirrors. Bandpass filters in front of each PMT allow fine-tuning of the spectral 
wavelengths that need to be collected. Since reflection is more efficient than 
transmission, this design greatly increases the multicolor detection capabilities of 
the cytometer. See Figure 1-20 on page 40.

Nozzle

Cuvette flow cell

Stream

Fluorescence objective lens

Individual collection 
fibers
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Figure 1-20  Transmission pathways in an octagon

Detectors 

BD FACSAria Fusion systems can be configured with up to six lasers, with four 
active at one time. For complete information about laser options, mirrors, filters, 
and fluorochromes required for each laser, see Laser Options on page 285.

The following figure shows the locations of detector arrays in a 6-laser system.
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Figure 1-21  Six-laser system with four octagons

Laser Power Panel

The laser power panel is located above and to the right of the laser octagons. 
Pressing a laser button powers up the corresponding laser. The laser button lights 
up when the laser is on. Depending on how your system is configured, you can 
choose different combinations of lasers by pressing the corresponding button in 
the laser power panel. For more information, see Excitation Optics on page 35.

561-nm laser

375/405-nm lasers

488/445-nm lasers

640-nm laser
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Stream-Viewing Optics

The BD FACSAria Fusion cytometer is equipped with optical components that 
are used to view the stream (Figure 1-22).

• The upper camera generates an image used to monitor drop formation. It is 
focused on the stream, just below the nozzle, to provide an image of the 
drop breakoff.

• The lower camera generates an image used for the BD FACS™ Accudrop 
option. It enhances the ability to see the side streams and assists in setting 
an accurate drop-delay value.

Figure 1-22  Stream-viewing optics

Special image-processing software allows you to view the stream images from 
each camera within separate windows in BD FACSDiva software. See Sorting on 
page 64 for more information about viewing the streams and to learn how 
Accudrop components are used to determine the drop delay.

Diode laser Micrometer dial Lower camera 
viewing window

Upper 
camera
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Cytometer Electronics

The electronic components consist of the power and air supply panels along with 
processing boards in the card cage. The power and air supply panels are located 
on the right side of the cytometer base in the lower left corner. Other electronic 
components are embedded within the cytometer and do not need adjustment. 
This section describes only adjustable cytometer electronics. For more 
information about the electronics, see Signal Detection on page 54.

Power and Operation

Power to the BD FACSAria Fusion is supplied by a power cord plugged directly 
into a standard electrical outlet. The optional BSC is hard-wired to the in-house 
electrical system.

Power Panel

The power panel contains the power button, a USB port for BD service, an 
ethernet connection, connectors for the stream-viewing cameras, and a serial 
communications cable (Figure 1-23).

Figure 1-23  Power panel
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Power 
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Air Supply Panel

The air supply panel (Figure 1-24 on page 44) is located to the right of the power 
panel. The air supply panel contains the external air regulator, air pressure gauge, 
power cord, external air input connector, and the cytometer circuit breaker. Air 
pressure is adjusted using BD FACSDiva software.

Figure 1-24  Air supply panel

Connecting to the External Air Supply

The BD FACSAria Fusion system requires an external (in-house) air source or 
optional compressor to operate.

To connect the fluidics to the external air supply, switch on the external air, if 
necessary. Attach the external air line to the external air input connector 
(Figure 1-24). The external air supply must provide 6.6–6.9 Bar (95–100 PSI) 
regulated. The source of the compressed air must deliver clean (<5 ppm) dry-
filtered (oil-free) air at stable pressures. 

Emergency Stop Button

The emergency stop button (Figure 1-25 on page 45) is a safety feature that can 
be used to stop the movement of the loading port and ACDU stage. The 
emergency stop button is located on the front of the optics drawer. The button 
lights up when a tube is loading to remind you to keep your hands away from the 
loading port.

Air pressure 
gauge

External air 
regulator

Power cord receptacle

External air input 
connector

System 
circuit 
breaker
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Figure 1-25  Emergency stop button

The following occur when this button is pushed:

• The tube is unloaded from the sample injection chamber.

• The ACDU stage (if in use) stops moving.

• The stream is turned off.

• The deflection plate voltage is turned off.

• The aspirator drawer (if open) closes to protect the sort collection tubes.

• A warning message is displayed on the screen.

NOTE The emergency stop button does not turn off the lasers or shut down the 
cytometer main power.

Do not reset the button until the message is displayed. To reset the button, slowly 
turn the button clockwise until the light turns off and the button returns to its 
original position.

 

Emergency stop button !
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2

Theory of Operation

This chapter describes how the BD FACSAria Fusion cytometer works and how 
BD FACSDiva software controls are used to operate different system 
components. For a general overview of the software, see Using BD FACSDiva 
Software on page 81.

See the following sections for a description of these BD FACSAria Fusion 
functions:

• Fluid Movement on page 48

• Signal Generation on page 52

• Signal Detection on page 54

• Sorting on page 64
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Fluid Movement

The fluidics system is responsible for moving particles from the sample injection 
chamber through the cuvette flow cell for interrogation, and then to waste or into 
a collection device during sorting (Figure 2-1). The following sections describe 
the controls used to move fluids through the BD FACSAria Fusion fluidics 
system. 

Figure 2-1  Fluid movement through the fluidics system 
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Sheath Flow

When you turn on the cytometer, the main air compressor starts up. The fluidics 
system is activated when you select the Fluidics Startup command in 
BD FACSDiva software. During fluidics startup, sheath fluid is forced from the 
pressurized sheath tank through a filter and is delivered to the cuvette flow cell at 
a constant pressure. You can view the current sheath pressure setting by selecting 
Cytometer > Sheath Pressure (Figure 2-2). 

Figure 2-2  Sheath pressure level 

After fluidics startup, sheath flow is controlled using the Stream button in the 
Breakoff window (Figure 2-3). When clicked, the button changes from a red “X” 
to a green check mark, and sheath flows through the cuvette flow cell at the rate 
that is specified in the Sheath Pressure dialog. (See Drop Formation on page 65 
for a complete description of the Breakoff window.)

Figure 2-3  Stream control in Breakoff window

As a general rule, the sheath pressure level is set by selecting a sort setup mode 
from the Sort menu, rather than by adjusting the sheath pressure control. Each 
sort setup mode is optimized at a preset sheath pressure. If you change the sheath 
pressure, a multitude of other values will be affected and need updating, 
including the drop-drive frequency, drop-delay value, laser delay, area scaling 
factor, and other values. For more information, see Sort Setup on page 103.
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Sample Flow

Sample is introduced into the cuvette when the Load button is clicked on the 
Acquisition Dashboard (Figure 2-4). After Load is clicked, the loading port rises 
to enclose the tube within the sample injection chamber. The chamber is 
automatically pressurized and the chamber pressure forces sample through the 
sample line into the cuvette flow cell. To stop sample flow after a tube is loaded, 
click the Stop Acquiring button. 

The sample flow rate is specified using the Flow Rate field on the Acquisition 
Dashboard. You can adjust the flow rate from 1–11, which corresponds to 
approximately 10–80 µL/minute.

Figure 2-4  Load button and Flow Rate field on the Acquisition Dashboard

Note that the relatively longer sample tubing on the BD FACSAria Fusion 
cytometer results in a different flow rate between cells and beads. Thus, absolute 
counting using BD Trucount™ beads can yield erroneous results.
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Hydrodynamic Focusing

In the flow cell, pressurized sheath fluid surrounds the sample fluid to 
hydrodynamically focus the core stream of suspended cells into the center of the 
cuvette, where the particles are intercepted by the laser beam. 

The difference in pressure between the sheath fluid and the sample fluid can be 
used to vary the diameter of the sample core. A lower difference results in a 
relatively narrow core stream, while a higher difference results in a wider sample 
stream. 

Ideally, you want the core stream at its minimum diameter so that cells pass 
through the laser beam in a single-file stream. However, depending on your 
application, a lower resolution might be acceptable in order to acquire the data 
more quickly. For example, with this three-laser configuration, a higher flow rate 
is generally used for qualitative measurements such as immunophenotyping—the 
data is less resolved but is acquired more quickly. A lower flow rate is generally 
used in applications for which greater resolution is critical.

Sheath flow Sheath flow Sheath flow
Sample flow

Sheath flow
Sample flow

Laser beams Laser beams

Low flow rate High flow rate
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Signal Generation

The following sections describe how signals are generated when cells or particles 
intercept the laser within the cuvette flow cell.

Light Scatter

When a cell or particle passes through a focused laser beam, laser light is 
scattered in all directions. Light that scatters axial to the laser beam is called 
forward scatter (FSC). Light that scatters perpendicular to the laser beam is 
called side scatter (SSC). FSC and SSC are related to certain physical properties of 
cells:

• FSC indicates relative differences in the size of the cells or particles. 

• SSC indicates relative differences in the internal complexity or granularity 
of the cells or particles. 

Forward scatter

Side scatter

Light source
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Fluorescence Signals

When cells or particles stained with fluorochrome-conjugated antibodies or other 
dyes pass through a laser beam, the dyes can absorb photons (energy) and be 
promoted to an excited electronic state. In returning to their ground state, the 
dyes release energy, most of which is emitted as light. This light emission is 
known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the 
excitation wavelength. The difference between the excitation wavelength and the 
emission wavelength is known as the Stokes shift. Some fluorescent compounds 
such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and 
emitting red light (675 nm), while other fluorochromes such as FITC have a 
smaller Stokes shift, absorbing blue light and emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in 
Figure 2-5.

Figure 2-5  Emission spectra of commonly used fluorochromes
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Signal Detection

From the cuvette flow cell, scattered and fluorescent light is collected by the 
fluorescence objective lens. The lens collects and focuses fluorescent light emitted 
at each of the laser focal points onto individual collection fibers. These fibers 
transfer the emitted light to the individual detector arrays.

The following sections describe how laser light is detected and translated into 
signals that can be displayed in a plot.

Detector Arrays

The BD FACSAria Fusion has four octagon detector arrays. Each detector array 
houses dichroic and bandpass filters, which steer and filter the emitted light, and 
PMTs, which detect light signals.

In the configuration shown in Figure 2-6, the top left octagon detects 
fluorescence signals excited by the 405-nm (violet) laser. The top right octagon 
detects fluorescence signals excited by the 640-nm (red) laser. The bottom right 
octagon detects SSC and up to seven fluorescence signals excited by the 488-nm 
(blue) laser. Each octagon can detect up to eight fluorescence channels. (An 
optical upgrade is required to fill all detection channels.) 

Figure 2-6  3-laser system with three octagons
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Filters

Optical filters modify the spectral distribution of light scatter and fluorescence 
directed to the detectors. Three kinds of filters are used in the detector arrays. 
Longpass (LP) filters are used to steer light between the detectors within a 
detector array, while bandpass (BP) and neutral density (ND) filters allow fine-
tuning of the spectral wavelengths that need to be collected (Figure 2-7).

Figure 2-7  Detectors and filters in an octagon array

Longpass

Bandpass

PMT
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Longpass Filters

LP filters pass wavelengths longer than the filter rating and reflect shorter 
wavelengths. For example, a 500 LP filter permits wavelengths longer than 500 
nm to pass through it and reflects wavelengths shorter than 500 nm (Figure 2-8).

Figure 2-8  Light reflection by longpass filter

Dichroic filters that are used to direct different color light signals to different 
detectors are called dichroic mirrors or beam splitters.

Although dichroic mirrors have the properties of LP optical filters, you cannot 
necessarily use any type of LP filter as a beam splitter. A beam splitter must have 
a surface coating that reflects certain wavelengths, but many types of LP filters 
are absorbance filters that do not have any specific reflective characteristics. Also, 
optical filters and beam splitters are rated at a specific angle of incidence. When 
used as a beam splitter, they are placed at an angle relative to the light source. 
Their optical properties are therefore designed for that angle of incidence.

The detector arrays use LP dichroic mirrors to steer progressively shorter 
wavelengths of light to the next PMT in the array. For example, in the octagon 
array, light first passes through a 735 LP filter in the A position, followed by a 
655 LP filter in the B position. Thus, wavelengths longer than 735 nm are 
detected at PMT-A. All wavelengths <735 nm are reflected to PMT-B. 
Wavelengths between 655 nm and 735 nm are detected at PMT-B. All 
wavelengths <655 nm are reflected to PMT-C, and so on. For a list of the 
longpass filters used in the detector arrays, see Laser Options on page 285.
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Bandpass Filters

BP filters transmit a relatively narrow range or band of light. Bandpass filters are 
typically designated by two numbers. The first number indicates the center 
wavelength and the second refers to the width of the band of light that is passed. 
For example, a 500/50 BP filter transmits light that is centered at 500 nm and has 
a total bandwidth of 50 nm. Therefore, this filter transmits light between 475 
and 525 nm (Figure 2-9).

Figure 2-9  Light transmittance by bandpass filters

Discriminating (DF) filters have the same general function—they transmit a 
relatively narrow band of light. The principal difference between BP and DF 
filters is their construction. DF filters have more cavities or layers of optical 
coatings, resulting in a steeper transmission curve than the curve for a BP filter. 
This steep slope means that a DF filter is better at blocking light outside the rated 
bandwidth of the filter. See Figure 2-10 on page 58.
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Figure 2-10  Bandpass (BP) vs discriminating (DF) filters

In the detector arrays, DF filters block high-intensity laser light and filter the 
remaining light to ensure that only the required wavelengths reach their intended 
detector. For example, in the octagon array, PMT-A has a 780/60 DF filter in 
front of it, which transmits light of 750–810 nm. Thus, the only wavelengths that 
will reach the A detector are those between 750 and 810 nm. 

For optimal detection of fluorescent light, a bandpass filter must always be 
installed in front of each detector. For a list of the bandpass filters used in the 
detector arrays, see Laser Options on page 285.

Neutral Density Filters

ND filters transmit a fixed percentage of light, reducing the transmitted intensity 
of all wavelengths equally. ND filters are neutral with respect to wavelength.
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The ND1.5 filter on the BD FACSAria Fusion allows approximately 15% of the 
light to be transmitted. The FSC detector has an ND filter placed in front of the 
488/10 BP filter. The percentage of light needed for detection is based on particle 
size. For applications involving small particles (for example, bacteria or 
platelets), you might need to remove the FSC ND filter. For applications 
involving large particles for which events appear off scale on the FSC axis with a 
gain of zero, a higher value ND filter is needed to decrease the FSC signal and 
keep the events on scale. 

The system comes with three ND filters: 1.0, 1.5, and 2.0. See Removing or 
Installing the FSC ND Filter on page 251.

Detectors

Detectors within each detector array convert light signals into electrical signals 
that can be processed by the electronics system.

There are two types of signal detectors in the BD FACSAria Fusion flow 
cytometer: the photodiode and PMTs. The photodiode is less sensitive to light 
signals than the PMTs, and is used to detect the stronger FSC signal. The 
photodiode detects FSC light from the blue laser, and is stored outside the 
detector arrays. PMTs are used to detect the weaker signals generated by SSC and 
all fluorescence channels. Each octagon can hold up to eight PMTs. 

Each PMT detects only one fluorochrome at a time. In BD FACSDiva software, 
the Cytometer Configuration window lets you define which fluorochromes or 
cell parameters will be measured at each PMT detector. If more than one 
fluorochrome is measured using the same PMT, you can add additional 
parameters to your configuration and select the appropriate fluorochrome within 
your software experiment. See Cytometer Configuration on page 87 for more 
information.
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Figure 2-11  Example BD FACSAria Fusion cytometer configuration

Electronic Processing

As cells or other particles pass through the focused laser beams, they scatter the 
laser light and can emit fluorescence. Because each laser beam is focused on a 
small spot and particles move rapidly through the flow cell, the scatter or 
fluorescence emission has a very brief duration—only a few microseconds. The 
PMTs convert this brief flash of light into an electrical signal called a pulse 
(Figure 2-12).
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Figure 2-12  Anatomy of a pulse

Pulse Parameters

A parameter is a pulse property that is generated by a single PMT or photodiode, 
measuring fluorescent or scattered light. You can measure three characteristics of 
a pulse: area, height, and width. The pulse height measures the maximum 
digitized value for the pulse, the pulse area calculates the sum of all height areas 
for the pulse, and the pulse width calculates 

No. Description

1 A pulse begins when a particle enters the laser beam. At this 
point, both the beam intensity and signal intensity are low.

2 The pulse reaches a maximum intensity or height when the 
particle reaches the middle of the beam, where the beam and 
signal intensity are the brightest. The peak intensity, or height of 
the pulse, is measured at this point.

3 As the particle leaves the beam, the pulse trails off.

1
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3

area
height
-------------- 64000×
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You can select which pulse characteristics you want to measure for each 
parameter using the Parameters tab. Pulse area (A) is measured by default. The 
Parameters tab also contains voltage controls that allow you to amplify signals 
by applying a voltage to PMTs or an electronic gain to the FSC signal. As the 
voltage is increased, the detector sensitivity increases, resulting in increased 
signal. As the voltage is decreased, the detector sensitivity decreases, resulting in 
decreased signal.

Digital data is displayed on an 18-bit linear scale, from 2.6–262,144. Select the 
Log checkbox to convert the display to a log scale. The Experiment Inspector 
contains an option to display log data on a four- or five-decade scale. (See the 
BD FACSDiva Software Reference Manual for more information.)
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Laser Delay

Sample interrogation takes place within the cuvette flow cell. Fiber optic cables 
are used to direct laser light through a series of prisms that focus each laser on 
the stream at a separate position. This allows optimal detection of fluorescence 
signals from each laser with minimal cross-contamination from the other beams.

In a three-laser system, the red laser intercepts the stream first, followed by the 
blue and then the violet laser. Because the laser signals are spatially separated, 
there is a slight delay between the detection of each laser’s signal (Figure 2-13). 

Figure 2-13  Signal separation over time

The delay factor in BD FACSDiva software is used to realign the signals so they 
can be measured and displayed on the same time scale. Note that signals are 
aligned with respect to the blue laser, so the red laser signals always have a 
negative delay value.

When using a fourth laser beam spot, you will notice a difference in default laser 
delays with the 561-nm or 445-nm laser compared to a three-laser configuration.

Laser delay is set automatically when you use the CS&T module. For 
information about manually adjusting the laser delay, see Manual Adjustment of 
Laser Delay on page 164.
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Sorting

During sorting, drop-drive energy is applied to the stream to break it into highly 
uniform droplets. Droplets detach from the stream a few millimeters downstream 
from the nozzle. The time between when a particle intercepts the laser and when 
it reaches the droplet breakoff point is determined using BD FACS Accudrop 
technology (see Drop-Delay Overview on page 71). 

When a particle is detected and meets the predefined sorting criteria, an electrical 
charge is applied to the stream just as the droplet containing that particle breaks 
off from the stream. Once broken off from the stream, the droplet—now 
surrounded by air—still retains its charge. The charged droplet passes by two 
strongly charged deflection plates. Electrostatic attraction and repulsion cause 
each charged droplet to be deflected to the left or right, depending on the 
droplet’s charge polarity. Uncharged droplets are not affected by the electric field 
and pass down the center to the waste aspirator. See Figure 2-14 on page 65.

The following sections describe how the BD FACSAria Fusion cytometer creates 
and charges drops, how the drops are deflected, and how sorting populations are 
identified.
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Figure 2-14  Sorting

Drop Formation

The BD FACSAria Fusion cytometer constantly applies drop-drive energy to the 
stream. Droplets form as soon as you turn on the stream. Sample interrogation 
takes place upstream of the stream vibration so that analysis is not affected by 
the drop drive.

A drop breakoff image is created using an LED strobe and a video camera. The 
image is displayed in the Breakoff window (see Breakoff Window on page 66). 
Patented Sweet Spot technology analyzes the drop breakoff image and provides 
feedback to the appropriate cytometer controls.

No. Description

1 Charge is applied via the stream-charging wire in 
the barb.

2 The sample generates light scatter and 
fluorescence signal. The signal is analyzed.

3 The charged droplet breaks off.

4 Deflection plates attract or repel the charged 
droplet.

5 Uncharged droplets pass to waste.

6 Charged drops containing particles of interest are 
collected.
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Breakoff Window

Use the Breakoff window to control a number of aspects related to drop 
formation.

Table 2-1  Breakoff window controls

Control Description

Stream button Turns the stream on and off.

Sweet Spot 
button

Enables automatic adjustment of the drop-drive 
amplitude to maintain the stability of the breakoff 
point.

When the Sweet Spot is on, the Amplitude and 
Frequency fields are disabled. The amplitude is 
automatically adjusted by the software. To enable the 
fields, turn off the Sweet Spot.

Amplitude field Adjusts the amplitude or intensity of the drop drive, 
from 1.0–80.0 volts.

The drop-drive amplitude determines the breakoff 
point. A higher amplitude value results in a shorter 
stream breakoff. A lower amplitude results in a longer 
stream breakoff. Typically, the amplitude is set once, at 
the beginning of a sorting experiment, and then 
maintained using the Sweet Spot.

Frequency field Determines the number of drops formed per second and 
the size of the drops. (Drop size is also influenced by 
the nozzle size.)

The drop-drive frequency can be adjusted from 1.0–
102.0 kHz. The higher the frequency, the more drops 
are generated per second and the smaller the drops. The 
lower the frequency, the fewer drops generated per 
second and the larger the drops.

On Off

On Off



 Chapter 2: Theory of Operation 67

Breakoff Functionality

The upper camera transmits an image of the drop breakoff to the Breakoff 
window, where video image processing software converts the visual 
characteristics of the image into numerical properties. The drop breakoff is 
analyzed for two key features: Drop 1 and Gap.

Drop 1 is defined as the number of pixels from the top of the image to the center 
of gravity of the first broken-off drop. A thin gray line on the image is used to 
identify this drop. The number shown to the right of the Drop 1 field at the 
bottom of the window is the actual pixel location of the gray line. The number 
entered into the Drop 1 field is the user-defined Drop 1 target.

The Gap is defined as the number of pixels from the first discontinuity in the 
stream to the next stream object, generally the first broken-off drop. A gray line 
of varying thickness represents the Gap. The number shown to the right of the 
Gap field is the pixel width of the gray line. The number entered into the Gap 
field is a user-defined target. 

Frequency field 
(continued)

In general, the drop-drive frequency should not need adjustment. We 
recommend using the default values that are entered with each Sort 
Setup mode.

Drop 1 field The distance between the top of the image and the center of the first 
broken-off drop, from 100–600 pixels.

When you enter a value and turn on the Sweet Spot, the cytometer 
automatically adjusts the amplitude to attain your target value.

Note that not all Drop 1 targets are attainable. The Drop 1 value 
jumps in whole increments of approximately 57 pixels according to 
your drop spacing. 

The same Drop 1 setting can be used from day to day. A difference of 
up to 10 pixels between the target value and the actual value is 
acceptable.

Gap field This represents the gap between the stream breakoff and the top of the 
first drop.

The default Gap setting for a 70-micron nozzle is 6 pixels. 

Control Description
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When the Sweet Spot is turned on, the drop-drive amplitude 
(Ampl) is automatically adjusted to approximately match the 
target Drop 1 and Gap values. The amplitude is initially adjusted 
in larger increments until Drop 1 is achieved. The amplitude is 
then adjusted in smaller increments until the cytometer attains 
the target Gap. The Sweet Spot function will make adjustments as 
necessary to maintain the required breakoff conditions 
throughout the day.

The Sweet Spot performs two other functions during sorting. 
When sorting, if the Drop 1 or Gap is out of range, sorting is 
paused until the values are back within range. This ensures that 
sorting occurs only under the proper breakoff conditions. If a 
more severe problem such as a clog is detected by the Sweet Spot, 
the stream is shut off and sorting is stopped, the deflection plates 
shut off, the aspirator drawer closes, and the sample tube is 
unloaded. 

Pre-programmed values can be downloaded to the Breakoff 
window by selecting one of the nozzle sizes (70, 85, 100, or 130 
micron) from the Sort > Sort Setup menu.

Note that changes to values in the Sort Setup windows (Breakoff 
and Side Stream) are automatically saved. At startup, the last 
settings used on the cytometer are restored, except the Stream 
and Sweet Spot controls, which always default to off. For more 
information, see Sort Setup on page 103.

Typically, when setting up for sorting, use the Amplitude to set 
the required drop breakoff, and copy the generated Drop 1 value 
to the target field. Then, turn on the Sweet Spot to maintain the 
drop breakoff. When the Sweet Spot detects a >1-pixel difference 
between the target Gap setting and the actual Gap, it adjusts the 
amplitude to reduce the Gap. When a >2-pixel difference is 
detected, the Sweet Spot stops sorting temporarily (stops charging 
the stream) until the Gap is restored. Note that when the sort is 
paused, the sample continues to flow. Once the Gap is back 
within range, sorting automatically resumes.

For information on setting the breakoff, see Setting Up the Breakoff on page 123.

Target
Value

Actual 
Value

Drop 1

Gap
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Side Stream Formation

Side streams are formed when the voltage is on and a sort is in progress, or when 
you click Voltage, then Test Sort in the Side Stream window. 

The Side Stream window displays an image of the side streams as transmitted by 
the lower camera. In addition to the stream image, the Side Stream window 
contains the controls used to adjust electrical charges and to determine the drop 
delay using Accudrop, as described in Drop-Delay Overview on page 71.

Figure 2-15  Side Stream window

Controls in the Side Stream window are described in Table 2-2 on page 70. You 
can send different values to the Side Stream window by selecting a nozzle size 
from the Sort > Sort Setup menu.

Note that changes to values in the Sort Setup windows (Side Stream and 
Breakoff) are linked to the sort setup and are automatically saved. At startup, the 
last settings used on the cytometer are restored, except the states of the Voltage, 
Test Sort, and Optical Filter buttons, which always default to off. For more 
information, see Sort Setup on page 103.
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Table 2-2  Side Stream window controls

Control Description

Voltage button Turns the plate voltage on and off.

Test Sort button Generates test side streams based on test sort pulses. 

Optical Filter button Controls the position of the optical filter in front of the lower 
(Accudrop) camera.

Attenuation button Decreases the amplitude of the drop drive. At lower pressures, 
you may need to turn on attenuation to dampen the amplitude.

Waste Drawer button Opens or closes the aspirator drawer depending on its current 
state. The default state is closed. For more information, see 
Aspirator Drawer on page 32.

Drop Delay field Sets the amount of time between when an event is measured 
and the breakoff point, from 10–140 drops. The drop-delay 
value determines which drop will be deflected. 

The drop-delay value is set in an experiment using BD FACS 
Accudrop technology.

Auto Delay Opens the Auto Drop Delay dialog. 

Voltage sliders (far 
left, left, right, far 
right)

Set the percentage of charge to be applied to the corresponding 
stream (as a percentage of maximum).

Voltage Center slider Adjusts the relative voltage between the left and right plates 
which moves the streams slightly to the left or right as a whole. 
In general, this slider rarely needs adjusting.

On Off

On Off

In Out

Off On

Closed Open
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Drop-Delay Overview

The BD FACSAria Fusion cytometer includes integrated Accudrop technology to 
assist in setting an accurate drop delay value. Accudrop components consist of 
the following:

• A diode laser, mounted to the left of the sort block

• A camera that provides an image of the side streams

• An emission filter for viewing the fluorescence from BD FACS™ Accudrop 
beads

The emission filter is installed in front of the lower camera and can be moved in 
and out by clicking the Optical Filter control. When the button is green ( ), the 
filter is out. This position is used to view the center and side streams. 

Click the button to move the filter in front of the camera when you are 
determining the drop delay. The button changes to red ( ). To determine the 
drop delay, the streams are illuminated by the diode laser just below the point of 
deflection. Specialized fluorescent particles (Accudrop beads) can be viewed in 
the center and left side streams as the delay is adjusted. The best delay yields the 
most particles in the left stream and the fewest in the center stream. 

Plate Voltage field Adjusts the total voltage difference between the plates, which 
determines the angle of stream deflection. The voltage values 
change with different nozzle sizes. 

2nd, 3rd, 4th Drop 
fields

Apply a correction factor for the drop charge as a percentage of 
the previous drop, from –100% to 100%.

Phase field Adjusts the phase between drop generation and charging of the 
droplets from 0–360°.

The selected value is sent to both the drop-charging electrode 
and the drop strobe. In general, the Phase does not need 
adjusting. You can keep the default value of zero.

Table 2-2  Side Stream window controls (continued)

Control Description
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See Determining the Drop Delay – Manual Method on page 176 for more 
information.

Auto Drop Delay

The Auto Drop Delay feature enables the system to optimize the drop delay 
automatically. See Determining the Drop Delay – Automatic Method on 
page 181.

Drop Charging

Drops are charged when an event is detected and meets the defined sorting 
criteria, as specified in the Sort Layout window.

The Sort Layout window contains all sorting instructions and controls 
(Figure 2-16). The sort layout designates which device will be used to collect 
sorted particles and which particles will be sorted into each sort location. Up to 
four sort counters can be displayed in the window to give ongoing status during a 
sort. Depending on your system’s configuration, your setup values may vary. For 
more information about the Sort Layout window, see Table 3-2 on page 104.

Figure 2-16  Sort layout for a four-way sort

Target events are identified by drawing gates around populations of interest in 
plots. The Sort Layout window specifies which gated population should be sorted 
into each sort collection tube or spot in a plate or on a slide. During sorting, 
when an event is identified within one of the sort gates, the drop containing the 
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particle of interest is charged by the stream-charging wire attached to the flow 
cell. See Figure 2-17.

Figure 2-17  Flow cell with stream-charging wire

The amount and type of charge determine where the drop will be sorted. For 
example, in a four-way sort, drops with the most charge will be deflected into the 
outer streams, while drops with less charge will be deflected into the inner 
streams.

Conflict Resolution During Sorting

During sorting, the cytometer deflects drops based on the characteristics of the 
particles in each drop and where the user wants to deflect them. Conflicts can 
occur depending on the type of target particle, where the particle is located 
within a drop, or whether the drop is free of contaminating particles. 
BD FACSDiva software accurately measures particle position to within 1/32 of a 
drop.

Mask settings determine how drops are deflected 
when sorting conflicts occur. There are three mask 
settings, each of which addresses a different type of 
conflict. These settings are combined to define sort 
precision modes. Each mode is made up of a set of 
masks. Precision modes are defined in the Sort 
Precision dialog, accessed from the Sort menu.

Stream-charging wire
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Yield Mask

The yield mask setting defines how close to the edge of the drop, in 1/32-drop 
increments, a particle of interest can be located before sorting an additional drop. 
Half of each yield mask setting defines an equal area at each end of the drop.

For example, when the yield mask is set to 16 and an event is within 8/32 from 
the beginning of a drop, the previous (leading) drop will be sorted. If an event is 
within 8/32 from the end of a drop, the following (trailing) drop will be sorted. 
See Figure 2-18.

Figure 2-18  Target particle within a yield mask of 16

If the yield mask were set to 8 for the same target particle, the target particle 
would fall outside the yield mask. Therefore, no additional drops would be 
sorted. See Figure 2-19.

Figure 2-19  Target particle outside a yield mask of 8

When the yield mask is set to zero, only one drop (the drop containing the target 
particle) will be deflected. When the mask is set to 32, two drops will always be 
deflected. Yield masks between 0 and 32 will sort either one or two drops. 

Yield masks cannot be used in conjunction with phase masks. Therefore, when 
the yield mask is greater than zero, the phase mask automatically reverts to zero.

Trailing drop: sorted Drop being interrogated Leading drop: not sorted

Target particle

Yield mask Yield mask

Trailing drop: not sorted Drop being interrogated Leading drop: not sorted

Yield mask

Target particle

Yield mask
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Purity Mask

The purity mask setting defines how close, in 1/32-drop increments, a 
contaminating drop can be located before ignoring the drop being interrogated.

For example, when the purity mask is set to 16, the drop being interrogated will 
not be sorted if a non-target particle falls within the first or last 8/32 of the 
leading or trailing drop. In the following example, a non-target particle falls 
within the first 8/32, so the interrogated drop will not be sorted. See Figure 2-20.

Figure 2-20  Non-target particle within a purity mask of 16

If the purity mask were set to 8 for the same target particle, the non-target 
particle would fall outside the purity mask, so the interrogated drop would be 
sorted. See Figure 2-21.

Figure 2-21  Non-target particle outside a purity mask of 8

With any purity mask greater than zero, the drop being interrogated must be free 
of contaminating particles or the drop will not be sorted. If the purity mask is set 
to zero, a droplet containing the event of interest will be sorted regardless of 
contaminating particles.

Trailing drop Leading drop

Purity mask Purity mask
Non-target particle

(Not sorted)

Drop being interrogated

Purity mask Purity mask
Non-target particle

(Sorted)

Trailing drop Leading dropDrop being interrogated
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Phase Mask

Particles near the drop edge can affect the breakoff and alter the trajectory of the 
deflected drop. The phase mask restricts drop deflection when an event is too 
close to the edge of a drop or when there are events close to the edge of adjacent 
drops. A phase mask is used to improve counting accuracy and side-stream 
quality at the expense of yield.

For example, when the phase mask is set to 16, the drop being interrogated will 
be sorted only if the target particle falls outside the phase mask. See Figure 2-22.

Figure 2-22  Sorted and unsorted drop with phase mask of 16

Decreasing the phase mask to 8 allows more drops to be sorted. However, 
because the target particle is closer to the edge of the drop, there is more 
variability in drop trajectory. See Figure 2-23.

Figure 2-23  Sorted drop with phase mask of 8

Tip     We recommend using a phase mask of at least 8 when sorting single cells.

Phase masks cannot be used in conjunction with yield masks. Therefore, when 
the phase mask is greater than zero, the yield mask automatically reverts to zero.

Trailing drop (Drop sorted) Leading drop

Phase mask

Trailing drop (Drop not sorted) Leading drop

Phase mask

Trailing drop Leading drop

Phase mask

(Drop sorted)
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Sort Precision Modes

Mask values can be combined in many different ways. By default, six sort 
precision modes are already defined: Purity, 4-Way Purity, Yield, Single Cell, 
Initial, and Fine Tune.

• Purity mode. The yield mask is set to the maximum to obtain the greatest 
number of particles. Because the purity mask is also set to the maximum, 
only drops free of contaminating particles will be sorted. Sorting in Purity 
mode results in a sorted sample that is highly pure, at the expense of 
recovery and yield.

• 4-Way Purity mode. The purity mask is set to the maximum, so only drops 
free of contaminating particles will be sorted. The yield mask is set to zero 
to ensure that residual charges from adjoining drops do not degrade the 
quality of side streams. The 4-Way Purity mode is recommended for four-
way sorting when precise deflection is required.

Precision Mode

Purity
4-Way 
Purity

Yield
Single 
Cell

Initial
Fine 
Tune

Yield Mask 32 0 32 0 32 0

Purity Mask 32 32 0 32 0 0

Phase Mask 0 0 0 16 0 0

Single Cell – – – X  – –
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• Yield mode. Only the yield mask is used at its maximum value. Recovery 
and yield are optimized at the expense of purity. The yield mode could be 
used as a first round sort for enrichment of target particles, followed by a 
sort for purity.

• Single Cell mode. The purity mask is set to the maximum, so only drops 
free of contaminating particles will be sorted. The phase mask is set to half 
the maximum, so only particles centered within the sorted drop are 
deflected. Drop trajectory and count accuracy are optimized at the expense 
of yield. This mode is recommended for plate sorting or situations when 
precise counting is required.

The remaining modes are used mainly during drop-delay determination. Initial 
mode is equivalent to Yield mode, but it is named differently as a reminder to use 
this as the initial mode when using Accudrop to set the drop delay.

• Initial mode. Only the yield mask is used at its maximum value. Recovery 
and yield are optimized at the expense of purity. 

• Fine Tune mode. All masks are set to zero to deflect the maximum number 
of drops. This mode is used to fine-tune the drop-delay value. See 
Determining the Drop Delay – Manual Method on page 176 for more 
information.

Defining New Precision Modes

Default precision modes cannot be edited or deleted. However, you can create 
new modes and then select them from the Precision Mode menu.

1 Select Sort > Sort Precision.
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2 Click Add.

The current sort mode is duplicated and the Mask fields are enabled.

3 (Optional) Change the name of the mode in the Precision Mode field.

4 Enter values for Yield Mask, Purity Mask, and Phase Mask.

5 Select the Single Cell checkbox, if needed.

6 Click Close.

The new mode is added to the Precision Mode menu.

To delete a mode, select it from the Precision Mode menu and click Delete.
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3

Using BD FACSDiva Software

Many BD FACSAria Fusion cytometer functions are controlled using 
BD FACSDiva software. This chapter provides a general overview of the 
workspace components and describes software controls that are unique to the 
BD FACSAria Fusion cytometer. For an in-depth description of software 
components not described in this chapter, see the BD FACSDiva Software 
Reference Manual.

The following topics are covered in this chapter:

• Workspace Components on page 82

• Cytometer Controls on page 83

• Sorting Controls on page 101

• Templates on page 114
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Workspace Components

When you start BD FACSDiva software, the workspace opens (See Figure 3-1). 
For a general overview of the workspace and to get started using the software, 
see the tutorials and quick reference guides located in the Resource Library on 
the BD Biosciences website (bdbiosciences.com). When running BD FACSDiva 
software with the BD FACSAria Fusion, two additional windows can be 
displayed by clicking the Sorting button on the Workspace toolbar. See Sorting 
Controls on page 101 for a description.

Figure 3-1  BD FACSDiva workspace

http://www.bdbiosciences.com
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Cytometer Controls

Most BD FACSAria Fusion–specific cytometer controls are accessed through the 
Cytometer menu. Controls on the Cytometer menu are described in the following 
sections:

• Fluidics Controls on page 83

• Cytometer Configuration on page 87

• Cytometer Status Report on page 90

The Cytometer Details and the Catalogs menu commands are described in the 
BD FACSDiva Software Reference Manual. Additional cytometer controls are 
located on the Acquisition Dashboard. See Acquisition Controls on page 100. 

Fluidics Controls

Fluidics control of the BD FACSAria Fusion cytometer is partially automated by 
BD FACSDiva software. The software contains pre-programmed fluidics 
protocols that are activated by selecting the corresponding menu command from 
the Cytometer menu. In addition, fluidics level indicators are available in the 
Cytometer window. See Fluidics Level Indicators on page 86. 

Fluidics Startup

During fluidics startup, waste and sheath levels are verified and the fluidics 
system is primed with sheath solution. The fluidics status is displayed at the 
bottom of the main window. 

See Cytometer Startup on page 116 for more information.
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Fluidics Shutdown

Fluidics shutdown removes sheath fluid from the lines, replaces it with ethanol, 
and cleans the cuvette with a cleaning solution. See Fluidics Shutdown (Weekly or 
As Needed) on page 207 for more details.

Change Sample Filter

Sample line filters can be installed to filter a sample before sorting. This selection 
opens the Sample Filter Change wizard, which guides you through the process. 
See Installing or Removing a Sample Line Filter on page 239 for the instructions.

Cleaning Modes

BD FACSDiva software contains pre-programmed cleaning modes that are 
activated by selecting the corresponding menu command from the Cytometer > 
Cleaning Modes menu. See Internal Cleaning on page 212 for more information.

Sheath Pressure

The sheath pressure determines how quickly particles pass through the laser 
beam. Select Cytometer > Sheath Pressure to view the current sheath pressure and 
change the pressure for custom sort setups.

Each sort setup option is optimized at a preset sheath pressure. If you 
change the sheath pressure, many other values will be affected and need 
updating, including the drop-drive frequency, drop-delay value, laser delay, 
and area scaling factor. For proper cytometer operation, change the sheath 
pressure by selecting an option from the Sort > Sort Setup menu. Do not 
adjust the pressure using controls in the Sheath Pressure dialog. Note that 
the Sheath Pressure command is disabled when the Sweet Spot is on.
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Sample Agitation

Select Cytometer > Sample Agitation to specify the speed at which samples are 
agitated. You can select from one of the specified values, or select Off to turn off 
agitation.

Sample Temperature

Use the Sample Temperature command to set the temperature inside the sample 
injection chamber. You can select from one of the specified values, or select Off to 
turn off temperature control (Figure 3-2).

Figure 3-2  Setting the sample temperature

Cooling/heating 
unit for sample 
injection chamber
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The cooling/heating unit is designed to maintain the temperature of a sample 
tube. It is not designed to cool or heat the sample. It takes approximately 45 
minutes to reach the required temperature inside the chamber, during which time 
the chamber must be kept closed.

To cool or heat the chamber, install a sample tube and click Load. Click Stop 
Acquiring to keep the chamber closed and stop running the sample. To maintain 
the temperature, do not leave the chamber open for extended periods while 
changing sample tubes.

The sample temperature retains the last setting after startup. For example, if it 
was set to 20°C the last time the system was used, then it will return to that 
setting the next time the system is started up.

Fluidics Level Indicators

BD FACSDiva software provides fluidics level indicators in the Cytometer 
window (Figure 3-3). The sheath and waste indicators provide an approximate 
indication of the fluid levels in each tank. The DI, bleach, and ethanol tank 
indicators appear full until the fluid level is below 20% of the tank capacity. 
When this occurs, the corresponding level indicator changes to black. 

NOTE The stainless steel ethanol shutdown tank does not have a level sensor. It 
must be checked manually.

Figure 3-3  Fluid level indicators

When the sheath is low or the waste is full while the stream is running, the 
corresponding indicator turns red and the following warning message is 
displayed every 5 minutes until the stream is turned off. If the warning message is 
not closed, the system automatically turns off the stream after 15 minutes. 

EthanolBleachDIWasteSheath
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Cytometer Configuration

The menu selections shown in Figure 3-4 open the CS&T module in a separate 
window. The CS&T module enables you to perform multiple functions related to 
cytometer configuration. 

NOTE When the CS&T module is open, BD FACSDiva software goes into a 
holding mode and does not accept any user input. When CS&T is closed, BD 
FACSDiva software becomes active again.

Figure 3-4  Cytometer menu selections that open CS&T

Do not close the warning message without refilling the sheath or emptying 
the waste. If you continue to run the cytometer after closing the message, 
the system could shut down.
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• View Configurations. Opens the Cytometer Configuration window within 
the main CS&T window. See the following section for an overview of this 
function. 

• CST. Opens the CS&T module. See the BD Cytometer Setup and Tracking 
Application Guide for complete information on using CS&T.

• Performance Tracking (LJ). Opens the performance tracking feature within 
the main CS&T window. See the BD Cytometer Setup and Tracking 
Application Guide for complete information on using this feature.

Cytometer Configuration Window

The BD FACSAria Fusion cytometer is equipped with a specific set of lasers, 
filters, and dichroic mirrors. The Cytometer Configuration window lets you 
define which fluorochromes or cell parameters will be measured at each PMT 
detector. Within this window, you can define parameters for an unlimited number 
of fluorochromes, up to four lasers, and all of the detectors.

Select Cytometer > View Configurations to open the window shown in 
Figure 3-5. Click the Parameter tabs for a list of parameters. Click the Filters and 
Mirrors tab for the list of optics.

The Cytometer Configuration window also displays the following settings:

• Sheath pressure

• Nozzle size

• Window extension

See the BD Cytometer Setup and Tracking Application Guide for more 
information on editing configurations, including adding parameters, mirrors, and 
filters.
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Figure 3-5  Example configuration for a four-laser system

Before you start any experiment, verify that the cytometer configuration contains 
the appropriate parameters for the samples you are running and that the 
cytometer optics match the current configuration. You cannot modify an existing 
configuration once it has been baselined. However, you can copy, paste, or 
modify a configuration as described in Custom Configurations on page 92. 

Selections in the Cytometer Configuration window determine which parameters 
are available for your experiment. When more than one parameter is available 
for a detector, the first parameter is listed by default. To select a different 
parameter, click the name in the Parameters tab of the Cytometer window in BD 
FACSDiva software and select a different parameter from the menu.

For accurate data results, the cytometer optics must match the current 
cytometer configuration.
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Cytometer Status Report

The Cytometer Status Report provides a list of all cytometer settings at the time 
the report was created. The cytometer must be connected to create the report. In 
an open experiment, click to set the current tube pointer and select Cytometer > 
Cytometer Status Report. The report is displayed in a separate window with a 
menu bar above the report header. The header lists the cytometer name, type, 
serial number, and the date and time the report was generated. See Figure 3-6 on 
page 91 for a sample report.

For a full description of the Cytometer Status Report, see the BD FACSDiva 
Software Reference Manual. A BD FACSAria Fusion cytometer report includes 
the following additional information: user access privileges, cytometer 
information, cytometer settings, and sorting settings. The report can be printed 
or exported.

• The User Access Privileges section lists access settings for the current user.

• The Cytometer Info section lists values for laser delay, area scaling, window 
extension, FSC area scaling, sheath pressure, and sample flow rate. 

• The Parameters section displays settings for the current acquisition tube. 

• The Sort Settings section lists all sort setup values, along with the Plate 
Voltage and Voltage Center values. If the Sweet Spot is off, Breakoff and 
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Gap values are shown. If the Sweet Spot is on, Drop 1 and target Gap 
values are shown.

Figure 3-6  Cytometer Status Report
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Custom Configurations

Before you can record data, you must first ensure that the cytometer 
configuration is appropriate for the experiment. If needed, you can create custom 
configurations to add parameters or filters and mirrors that are not listed in the 
base configuration. You will also need to create custom configurations for each 
sheath pressure you would like to run.

When creating custom configurations, use descriptive names that make it easy to 
identify the configuration. See the BD FACSDiva Software Reference Manual 
and the BD Cytometer Setup and Tracking Application Guide for more 
information. 

Preparing for Custom Configurations 

Custom configurations can be created only by users with administrator access. 
The easiest way to create a custom configuration is to copy and edit a base 
configuration. You can also create a new, blank configuration.

1 Log in to the software as an administrator.

2 Select Sort > Sort Setup and select the setup mode that matches the nozzle 
size you are using.

3 Verify that the correct nozzle is installed, then start the stream.

4 Select Cytometer > CST.

The Cytometer Configuration window opens (see Figure 3-5 on page 89). 
For users with administrator access, the window displays the Parameters 
and Filters and Mirrors tabs, which are not visible to users with operator 
access.

NOTE When you create a new configuration in CS&T, you need to run a 
new baseline for that configuration. Once the baseline is established, you 
cannot edit any of the settings in the configuration. 
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Adding Parameters, Filters, and Mirrors

Before creating a custom configuration, verify that the necessary parameters, 
filters, and mirrors required for the custom configuration are defined.

1 To add new parameters, do the following in the Parameters tab:

a Click Add.

b Enter a parameter name in the field provided.

2 To add filters or mirrors, do the following in the Filters and Mirrors tab:

a To add a filter, click Add under the Filter list. To add a mirror, click 
Add under the Mirror list.

b Select a pass type and enter a wavelength in the field provided.

Enter new
parameter
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Copying a Base Configuration 

You cannot edit or delete your base configuration. However, you can use it as a 
starting point to create a custom configuration. 

1 In the Configurations tab, right-click the Base Configurations folder and 
select New Folder.

2 Rename the new folder Custom Configurations.

3 Right-click the base configuration and select Copy.

Filters Mirrors
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4 If your base configuration contains lasers that share optical paths, you have 
to select which laser will be active by making selections in the dialog similar 
to the one shown in the following figure.

5 Right-click the Custom Configurations folder and select Paste.

A copy of the base configuration is added to the Custom Configurations 
folder.

6 Enter a descriptive name and press Enter.

For example, use the name 70-70, meaning 70-micron nozzle at 70 PSI. If 
you need to rename the configuration, right-click the new configuration 
and select Rename.
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Editing the Copied Configuration 

Once the base configuration is copied, you can customize the parameters, filters, 
and mirrors in the configuration.

1 In the configuration list, right-click the new configuration and select Edit 
Configuration.

The following window opens. 

Use the tabs at the bottom of the window to view each laser’s detectors 
separately.

2 To edit the nozzle size and sheath pressure for this configuration: 

See Table 3-2 on page 104 for typical sort setup values.

a Enter the appropriate sheath pressure value at the bottom of the 
configuration window.
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b Select the appropriate nozzle size.

3 Do the following to edit the optical configuration.

• To change the parameter label for a detector, select and drag a new 
parameter from the Parameters list to the appropriate detector.

• To add more than one parameter label to a detector, Crtl+click the 
parameters in the Parameters list, then drag them to the detector.

• To change a filter, select and drag a new filter from the Filters list to the 
filter slot.
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• To change a mirror, select and drag a new mirror from the Mirrors list 
to the mirror slot.

When you drag parameter labels to a detector, any labels already assigned 
to that detector are deleted. Therefore, when assigning multiple parameter 
labels to a detector, you must drag all appropriate labels to the detector at 
the same time.

Setting the Configuration

To verify that you have selected the correct configuration, do the following.

1 Select Cytometer > CST.

2 Select the appropriate configuration and select Set Configuration.

3 Select File > Exit to exit CS&T.

A mismatch dialog is displayed.

4 Select Details, and then select Use CST Settings.

Verifying that the Configuration Matches the Sort Setup 

To verify that the sheath pressure in the sort setup matches the sheath pressure in 
the configuration:

1 Select File > Exit to exit CS&T.

2 Select Sort > Sort Setup, and select the sort setup that matches the nozzle 
size listed in your configuration.
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3 Select Cytometer > Sheath Pressure and verify that the pressure matches the 
pressure in your configuration. Enter a new sheath pressure, if needed.

The new sheath pressure is automatically saved with the current sort setup 
mode. 

Tip     The name of the configuration is displayed at the top of the 
BD FACSDiva workspace. If you use a descriptive name for each 
configuration (such as 100-15-Custom, for nozzle size-sheath pressure-
sort setup mode), it will be easier to verify that the appropriate settings 
match without going back to view the configuration.

Select the sort setup that 
matches the nozzle size 
listed in your configuration.

Enter the same sheath pressure that was 
entered in the configuration.
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Acquisition Controls

Along with the controls described in the BD FACSDiva Software Reference 
Manual, the following acquisition controls are available for the 
BD FACSAria Fusion cytometer.

• Load. Lifts a tube into the sample injection chamber, starts sample 
agitation (if agitation is turned on), and starts acquisition of the sample. 

When a tube is already loaded, the button changes to Unload. Clicking 
Unload stops acquisition of the sample, turns off the agitator, and lowers 
the tube from the sample injection chamber. 

NOTE The Load button is enabled only when the workstation is connected 
to the cytometer, an experiment is open, the stream is turned on, and the 
current tube pointer is set to a tube.

• Stop Acquiring. Stops sample acquisition without unloading the sample 
tube.

The Acquire Data button functions only when a tube is loaded.

• Flow Rate. Controls sample flow rate, from 1.0–11.0 (10–80 µL/min). 

Do one of the following to change the flow rate:

- Select the value in the field and enter a new value.
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- Click the pointer in the slider bar and drag it to a new value.

- Use the mouse to click the up and down arrows or press the arrow keys 
on your keyboard to increase or decrease the values in small 
increments.

Sorting Controls

All sorting on the BD FACSAria Fusion cytometer is controlled by BD FACSDiva 
software. Sorting controls are shown in Figure 3-7. See Table 3-1 on page 102 for 
explanations of each area.

Figure 3-7  BD FACSDiva sorting controls
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4
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Sort Menu

Select commands in the Sort menu for the following:

• Sort Setup. Downloads the most recently used settings for the selected 
nozzle size. See Sort Setup on page 103.

• Sort Precision. Opens a dialog where you can select or define a sort 
precision mode for handling sorting conflicts. See Conflict Resolution 
During Sorting on page 73.

• New Sort Layout. Opens the default 2-Tube Sort Layout window where 
other sort layouts can be selected. (Note that clicking the Sort Layout 
button on the Browser toolbar performs the same function.)

• Open Sort Layout. Opens an existing sort layout. A sort layout must be 
selected in the Browser for this menu command to be enabled. 
Alternatively, double-click any sort layout to open it.

Table 3-1  Description of sorting controls  

No. Description

The Sort menu provides access to the sort setup and sort precision modes, sort 
layouts, sort reports, and sort devices used with the ACDU unit. See Sort Menu 
on page 102.

The Sort Layout window contains controls to turn on index sorting and 
designates which device will be used to collect sorted particles and which 
particles will be sorted into each sort location. Depending on your system’s 
configuration, your setup values may vary. See Table 3-2 on page 104 for more 
information.

The Breakoff window displays an image of the stream and contains controls to 
adjust drop formation. See Drop Formation on page 65. 

The Side Stream window displays an image of the side streams, and contains 
controls to adjust electrical charges and the drop delay. See Side Stream 
Formation on page 69. 

1

2

3

4
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• Home Device. Opens a dialog containing commands to move the tray 
support arm, either manually or to the home position. See Setting Up the 
Stream on page 194.

• Custom Devices. Opens a dialog where custom devices can be defined. See 
Creating a Custom Device on page 197.

• Sort Report. Displays a report showing the sort settings, acquisition 
counters, and sort layout information from the current sort. See Sort 
Report on page 112.

Sort Setup

Sort setup values for four different nozzle sizes can be downloaded using the Sort 
> Sort Setup command. Default settings are provided for each sorting option, 
along with a custom setting for each option. 

As a general rule, for optimal results when sorting large or fragile cells, use a 
larger nozzle size and lower pressure. To increase throughput and yield when 
sorting smaller or less fragile cells, use a smaller nozzle size and higher pressure.

If you make changes to any of the settings, the changes are automatically saved 
when you exit BD FACSDiva software or when you switch to a different sort 
setup mode. When you restart, the most recently used set of values is restored. 
Default settings are shown in Table 3-2 on page 104.

In addition, the Sort Setup menu has following menu items: 70 Custom, 85 
Custom, 100 Custom, and 130 Custom. Initially, all of these new setups are exact 
copies of the corresponding original setups with the same defaults. This allows 

Sort Setup Name Nozzle (microns) Default Pressure (PSI) 

70 micron 70 70

85 micron 85 45

100 micron 100 20

130 micron 130 10
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you to create two sets of sort values (pressure, for example) for the same nozzle 
size. 

Table 3-2 shows default sort setup values. Depending on your system’s 
configurations, your setup values may vary. We recommend optimizing these 
settings for your system’s configurations.

Do not use a nozzle size that is different from the sort setup setting. The gap 
values and sensitivity algorithms are optimized for particular nozzles and 
are not suitable for other nozzle sizes. The system performance could be 
unstable. 

Table 3-2  Typical sort setup values

Setting 70 micron 85 micron 100 micron 130 micron

Sheath pressure 70 45 20 10

Amplitude 60 32 12 24

Frequency 87 47 30 12

Drop 1 150 150 150 150

Gap (upper limit) 6 (14) 7 (17) 10 (21) 12 (21)

Attenuation Off Off Off Off

Drop delay 47.00 30.00 27.00 16.00

Far left voltage 100 100 80 60

Left voltage 40 35 30 20

Right voltage 40 35 30 20

Far right voltage 100 100 80 60

Plate voltage 4,500 4,000 2,500 2,000

2nd drop 20 20 10 0

3rd drop 10 10 5 0

4th drop 0 0 0 0
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The Sort Layout window contains all sorting instructions and controls. The sort 
layout designates which device will be used to collect sorted particles and which 
particles will be sorted into each sort location. Up to four sort counters can be 
displayed in the window to give ongoing status during a sort. 

Only one sort layout can be open at a time, but you can create several layouts for 
a single tube, as long as each sort layout has a different name. Sort layouts can 
also be added to global worksheets.

Sort layouts are available for up to eleven default collection devices (shown in the 
following figure). Additional custom devices can be defined. See Creating a 
Custom Device on page 197.

Laser delay (blue) 0.00 0.00 0.00 0.00

Laser delay (red) -78.00 -71.00 -80.00 -78.00

Laser delay (violet) 39.00 35.00 40.00 39.00

Laser delay (yellow green) -39.00 -35.00 -40.00 -39.00

Area scaling (blue) 0.70 1.00 0.90 0.90

Area scaling (red) 0.60 0.75 0.65 0.65

Area scaling (violet) 0.50 0.50 0.50 0.50

Area scaling (yellow green) 0.80 0.80 0.90 0.95

Window extension 2.00 2.00 2.00 4.00

Table 3-2  Typical sort setup values (continued)

Setting 70 micron 85 micron 100 micron 130 micron

Default 
collection 
devices
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Examples of sort layouts for different devices are shown in the following figures. 
Instructions for setting up a sort layout can be found in Setting Up a Sort Layout 
on page 107.

Figure 3-8  Sort layout for collection tubes (top) and for a 48-well plate (bottom)

Figure 3-9  Sort layout for a frosted slide

Sort location 
field for 
far-right tube

Sort location 
field for 
individual well

Collection 
device

Sort 
counters

Sorting 
controls

Sort location 
field for a spot 
on a slide
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Setting Up a Sort Layout 

Sort layouts can be added to tubes or global worksheets. 

• Create tube-specific layouts if you are sorting different populations or using 
different sort devices for each tube in the experiment.

• Create global worksheet–specific layouts if you are sorting the same 
populations into the same sort device for all tubes in the experiment.

NOTE To create a tube-specific sort layout, make sure a normal worksheet 
(white tab) is shown in the Worksheet window before you create the layout.

To set up a sort layout:

1 Select the icon for a tube or global worksheet in an open experiment and 
click the New Sort Layout button on the Browser toolbar. 

2 In the Sort Layout window, select the type of device from the Device menu.

Default sorting devices are listed along with any defined custom devices. 
The Sort Layout window changes depending on the selected device. The 
number of rows and columns in the window matches the number of tubes, 
wells, or spots in the collection device. 

3 Select the sort precision mode from the Precision menu.

For more information, see Sort Precision Modes on page 77.

4 Enter the number of events to be sorted in the Target Events field. 

Once entered, the number of events can be selected from the Target Events 
menu. For continuous sorting, select Continuous from the Target Events 
menu.

5 Select one of the following options from the Save Sort Reports menu: 

• Save None. Sort reports are not saved.
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• Save All. Automatically saves a sort report each time the sort is 
stopped.

• Ask User. Prompts the user each time the sort is stopped to select 
whether or not to save the sort report. This is the default option.

This setting is saved with the sort layout.

6 Select the field(s) corresponding to the tube(s), well(s), or spot(s) where the 
population will be sorted and select a defined population from the Add 
menu. 

When you click in a sort location field, a menu opens allowing you to add, 
delete, or clear all populations in the field (Figure 3-10).

Figure 3-10  Adding populations to be sorted

After you add a population, the population and the number of target events 
are added to the corresponding sort location field.

Tip     Select a row or column header to select all fields in that row or 
column. When you add a population, it will be added to all selected fields 
at once.

7 Specify whether to save sort conflicts by selecting the Save Conflicts 
checkbox.

This checkbox is enabled only when using a two- or four-tube layout. 
When selected, all sort conflicts are sorted into a default location.

• For a two-tube layout, conflicts are sorted to the right.
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• For a four-tube layout, conflicts for the far left tube are sorted to the 
left, and conflicts for the far right tube are sorted to the right. 

Editing a Sort Layout

• To change the number of events for any population, click in the Sort 
Location field(s) containing the population, then select a number from the 
Target Events menu or enter a new number.

• To remove a population from a sort location field, select the field, then 
select the corresponding population from the Delete menu. 

• To clear all populations from a field, select the field, then select Clear All.

Using Sorting Controls

Sorting controls are located at the bottom of the Sort Layout window. Use these 
controls for the following functions.

• Sort. Starts sorting events for the current acquisition tube. All counters 
reset to zero when this button is clicked. Events are sorted until the 
requested number of sorted events has been reached. 

Access Stage

Move Drawer
Pause/Resume
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Click the Sort button again to stop sorting before reaching the requested 
number of events. The counters stop at the number of sorted events. If you 
click Sort to restart sorting, the counters reset to zero. 

• Pause/Resume. Stops sorting, but not acquisition. Sort counters and sort 
timers freeze when the Pause button is clicked. Click the Resume button to 
continue sorting and to continue incrementing the sort counters and timers. 
See Pausing and Resuming a Sort on page 189.

• Access Stage. When the ACDU stage is in the back, the stage is moved 
forward to put a plate on or take a plate off the stage. When the stage is in 
the front, the stage is moved to the back and out of the way so you can 
install a collection tube holder. 

• Move Drawer. Moves the aspirator drawer in (closed) or out (open) 
depending on its current state. The default state is in. For more 
information, see Aspirator Drawer on page 32.

Using Counters

Counters provide ongoing status during sorting. Counter fields cannot be edited. 
To display fewer counters in the Sort Layout window, click the View Counters 
button and select a menu option. The corresponding counter is hidden. (Only 
counters with a checkmark next to the name are displayed.)

Counters display the following information:



 Chapter 3: Using BD FACSDiva Software 111

• Sort Rate. Number of events per second that met the sort criteria and were 
sorted.

• Conflict Count. Number of events that met the sort criteria but were not 
sorted because of conflicts.

• Conflict Rate. Number of conflicts per second.

• Efficiency. Number of sorted events/(sort conflicts + sorted events) x 100.

Monitoring a Sort

During sorting, each sort location field displays the number of actual sorted 
events (Figure 3-11). When a target number is specified, the field displays the 
actual number of events along with the number of target events. 

A progress bar opens behind the sort rate counter field showing the progress of 
the sort. 

Figure 3-11  Sort layout during sorting
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Sort Report

Select Sort > Sort Reports to view all of the saved reports for the current sort 
layout (see Figure 3-12). A sort report can be printed or exported. The Sort 
Reports menu option is enabled if either of the following is true: a sort layout is 
selected in the Browser (even if experiment is closed), or a sort layout is open. If 
both conditions are true, the Browser selection takes precedence. 

Figure 3-12  Select Sort Reports dialog

A sort report (see Figure 3-13) contains the following:

• Header information. Experiment name, specimen name, tube name, sort 
layout name, software name and version, the date and time of printing, 
type of collection device, user ID, and cytometer.

• Sort Settings. Sort setup values, precision mode, mask definitions, etc.

• Acquisition Counters. Threshold count, processed events count, electronic 
conflicts count, and elapsed time.

• Sort Counters. Counter values per sort destination, or total sort count if 
sorting sequentially.

• Sort Layout. Population(s), sort count, and target event count for each sort 
location field.
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Figure 3-13  Typical sort report 

The Sort Report window contains a File menu where you can select to print or 
export the report. Exported comma-separated value (CSV) files can be opened 
with a spreadsheet application such as Microsoft® Excel®.
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Templates

When you install BD FACSDiva software for the BD FACSAria Fusion cytometer, 
the following additional experiment templates are installed in the 
BD Export\Templates directory:

• Accudrop Drop Delay template. Contains a single specimen and tube, a 
gated plot on a standard worksheet, and a predefined sort layout. This 
experiment is used for setting the drop delay during sorting as described in 
Determining the Drop Delay – Manual Method on page 176.

• Doublet Discrimination Gating template. Contains custom cytometer 
settings, a single specimen and tube, and three gated plots on a global 
worksheet. This experiment is used to eliminate doublets as described in 
Data Collection on page 148.
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Startup and Running Samples

The following topics are covered in this chapter:

• Cytometer Startup on page 116

• Checking Cytometer Performance on page 134

• Application Settings on page 141

• Data Collection on page 148

• Data Recording and Analysis on page 155

• Manual Adjustment of Laser Delay on page 164
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Cytometer Startup

Follow these steps to start up your BD FACSAria Fusion cytometer.

1 Turn on the cytometer main power. 

Figure 4-1  Power panel 

If the cytometer was just shut down, wait until the system is fully 
depressurized (stops hissing) before you turn on the main power.

2 Switch on the house air or the optional compressor and view the sheath 
tank gauge to ensure that the tank is pressurizing properly.

3 Start up the workstation.

4 Press the laser buttons on the laser power panel (Figure 4-2 on page 117) to 
turn on the lasers you will be using. Wait 30 minutes for the lasers to warm 
up.

NOTE The 405-nm and 375-nm lasers and the 488-nm and 445-nm lasers 
share the same optics. Do not operate the 405 and 375-nm lasers or the 
488 and 445-nm lasers at the same time.

Outlet for serial 
communications 
cable

Power 
switch

Service 
USB

Ethernet 
to PC

Connectors to upper 
and lower cameras
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Figure 4-2  Laser power panel

The laser button is illuminated when the corresponding laser is on.

NOTE The laser buttons will vary depending on which lasers you have 
installed on your system. For example, if you have two lasers, only the first 
two buttons will be labeled and active.

5 If your system includes the BSC and it is not already on, turn on the blower 
by pressing the power button on the Cabinet Controls panel.

A green light indicates the power is on.

6 (Optional) If you are using the temperature control option, turn it on. See 
Temperature Control Option on page 345. 

7 Log in to Windows 7.0.

a Select Operator login.

b Type the password: Welcome#1

8 Open BD FACSDiva software by double-clicking the application shortcut 
on the desktop.
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Figure 4-3  BD FACSDiva application shortcut

9 Log in with your user name and password.

If your login name is not displayed, contact your BD FACSDiva software 
administrator to create a login name for you. For more information, see the 
BD FACSDiva Software Reference Manual.

10 Check the fluid levels in the Cytometer window. Replenish fluids or empty 
the waste, if needed.

To display the Cytometer window, click the Cytometer button on the 
Workspace toolbar. Check the fluid levels at the bottom of the window 
(Figure 4-4). Roll the mouse pointer over fluid indicators to show the fluid 
type.

Figure 4-4  Fluid levels in the Cytometer window

NOTE The ethanol level in the Cytometer window indicates the volume of 
fluid in the white auxiliary ethanol tank. There is no sensor for the stainless 
steel ethanol shutdown tank.

To service the fluid containers, see Table 4-1 on page 125 and Emptying the 
Waste Container on page 132.

EthanolBleachDIWasteSheath



 Chapter 4: Startup and Running Samples 119

Performing Fluidics Startup

This section describes the fluidics startup procedure. The status of the fluidics 
system is displayed in the bottom right corner of the main window.

1 From the BD FACSDiva Cytometer menu, select Fluidics Startup. The 
following window opens.

2 Verify that the air and fluid lines are disconnected from the ethanol tank 
and connected to the sheath tank, then click Done. See Figure 4-5.

Caution: Do not run fluidics startup with the air and fluid lines connected 
to the ethanol shutdown tank. This can cause damage to the system. 
Always verify that the lines are connected to the sheath tank.
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Figure 4-5  Air and fluid lines connected to the sheath tank or ethanol shutdown tank

NOTE The flow rate is calibrated with the sheath tank. If the location or 
elevation of the sheath tank is changed, it could affect the flow rate calibration.

3 Verify that a closed-loop nozzle is installed in the flow cell, then click Done.

The fluidics startup process starts and the progress is displayed at the 
bottom of the dialog.

4 Turn the nozzle-locking lever counter-clockwise to the 9:00 position, pull 
the closed-loop nozzle out of the cuvette flow cell, then click Done.

5 Insert the correct nozzle size in the flow cell.

Air line

Fluid line

Sheath tank
or ethanol shutdown tank

Side viewTop view

Sheath or ethanol
filter

To 
instrument

To tank

To filter
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a Verify that the O-ring is present and that it is installed in the nozzle 
groove. For more information, see Integrated Nozzle on page 29.

b Make sure the top side of the nozzle is facing up as you insert the 
nozzle.

c Push the nozzle all the way back into the flow cell.

d Turn the nozzle-locking lever clockwise to the 12:00 position.

6 Click OK to complete the process.

7 Set the appropriate optical configuration. See Setting the Configuration on 
page 98.

8 When fluidics startup is complete, select Sort > Sort Setup and verify that 
the setup mode matches the nozzle size.

For information about Sort Setup modes, see Sort Setup on page 103.

Starting the Stream

1 Confirm that the in-house air pressure, or the compressor, is on.

2 Start the stream.

a Click the Sorting button on the Workspace toolbar to display the 
Breakoff and Side Stream windows.

b Click the Stream button in the Breakoff window to turn on the stream.

3 Open the sort block door and check the stream.

When the stream is on, air pressure fluctuates between 80–100 PSI. A 
pressure reading of less than 80 PSI or greater than 100 PSI indicates that 
the fluidics are not functioning properly. If this occurs, contact your 
BD Biosciences service representative for assistance. Do not operate the 
cytometer outside the normal air pressure range.
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The stream should flow smoothly from the nozzle into the center of the 
waste aspirator. 

If the stream is flowing but is unsteady, check for bubbles in the flow cell. If 
you see bubbles, turn off the stream, wait for 10 seconds, and turn on the 
stream again.

If you see any dripping or spraying, or the stream image appears abnormal, 
turn off the stream and see Troubleshooting the Stream on page 254.

4 Close the sort block door. 

NOTE If you encounter bubbles in the sheath fluid stream at the 
130-micron sort setting, perform a sample line backflush for approximately 
1 minute. Select Cytometer > Cleaning Modes > Sample Line Backflush.

To prevent bubbles, the sheath tank should be depressurized while not in 
use to prevent air from dissolving into the sheath solution.
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Setting Up the Breakoff

Establishing a stable drop pattern in the breakoff window is an important step in 
getting optimal results from the system. See Breakoff Window on page 66 for 
more information on the parameters and controls in the breakoff window.

The following figure shows good versus poor breakoff patterns.

Good breakoff Poor breakoff

Target value
Actual value

satellite
drop
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1 Adjust the Ampl slider until the drop breakoff is approximately in the top 
third of the Breakoff window.

Do not exceed 70 volts. If you cannot achieve a drop breakoff at <70 volts, 
do the following:

• Check the flow cell for air bubbles. If you see bubbles, turn the stream 
off and back on.

• Make sure the sheath pressure and drop-drive frequency are 
appropriate. See Table 3-2 on page 104 for starting values.

• If the amplitude is <10 volts, turn on attenuation in the Side Stream 
window. See Table 2-2 on page 70.

2 Verify that the small satellite droplets are merging with the large droplets.

If the satellites are not merging, you might need to clean the nozzle by 
sonicating. The satellite drops should merge into the drops in 6 satellites or 
fewer.

3 Enter the actual Drop 1 value as the target in the Drop 1 field.

The actual value is displayed in the gray background next to the Drop 1 
field. Once a valid target has been established, you do not need to reset it 
unless you change the nozzle or your sort setup option.

Tip     If the target value causes the amplitude to exceed 70 volts, perform 
the recommendations under step 1 and re-enter the Drop 1 target value.

4 Turn on the Sweet Spot when the drop pattern is stable.

The Sweet Spot is designed to automatically adjust the drop-drive 
amplitude to maintain the stability of the breakoff point. When the Sweet 
Spot is on, the Amplitude and Frequency fields are disabled. The values are 
automatically adjusted by the software. For more information, see Breakoff 
Window on page 66.

.
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The breakoff patterns in Table 4-1 are intended as examples. The patterns will 
not always look exactly like these. 

Table 4-1  Examples of breakoff patterns at each nozzle size 

70 micron 85 micron 100 micron 130 micron
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Setting Up the Fluidics

Check the fluid levels in the sheath tank and waste containers every time you use 
the cytometer. This ensures that you will not run out of sheath fluid during an 
experiment or have to service the containers during a sort. Fluid level indicators 
are shown in the Cytometer window in BD FACSDiva software. See Figure 4-4 
on page 118.

If a fluid container is running low, refill it with the fluid indicated on the 
container label. For best results, fill the containers only with the fluids shown in 
Table 4-2. For ordering information, see Reagents on page 283.

For instructions on emptying the waste, see page 132.

NOTE Make sure the blue sheath fluid line between the sheath tank and the 
cytometer does not come into contact with anything that could introduce 
vibration that might affect the stability of the stream.

Table 4-2  Recommended fluids

Container Compatible Fluids Capacity

Sheatha 

a. Users should select solutions that are compatible with their specific samples and experiments.

• BD FACSFlow™ sheath fluid (non-sterile)

• 1X phosphate-buffered saline (PBS), with or without 
preservatives

One 10-L 
stainless steel 

container

Ethanol 
Shutdown

70% solution diluted in deionized (DI) or laboratory-
grade water

One 5-L stainless 
steel container

Bleach • 10% household bleach (0.5% sodium hypochlorite)

• BD™ FACSClean solution

5 L

DI Deionized water (Milli-Q or equivalent). Add 3 mL of 
bleach per liter of DI water.

5 L

Ethanol 70% solution diluted in DI or laboratory-grade water 5 L
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Refilling the Sheath Tank

The fluid level in the pressurized stainless steel sheath tank should be checked 
often and refilled when low. The startup times for the breakoff stream will 
increase when the tank is low. If the cytometer is run until the sheath supply is 
too low, the system will turn off the stream.

Figure 4-6  Sheath tank connectors 

To refill the sheath tank:

1 Turn off the stream.

2 Disconnect the air line.

3 Pull up on the ring of the pressure relief valve to release pressure from the 
tank.

Make sure the tank is fully vented.

4 Unscrew the sheath tank cover knob and remove the cover.

5 Fill the tank with sheath fluid up to the upper weld line on the inside of the 
tank. See Figure 4-7.
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NOTE Do not overfill the sheath tank because this can cause incorrect 
sample flow rates.

Figure 4-7  Sheath tank fill level

6 Replace the cover and tighten the knob. 

Make sure the large O-ring on the inside lip of the cover is seated correctly 
and has not slipped out of position. The tank can leak if the cover is not 
secured properly.

7 If you removed the sheath tank to refill it, place the tank back in its original 
position. See Figure 4-8 on page 128.

The flow rate is calibrated with the sheath tank in the fluidics drawer. If the 
location or elevation of the sheath tank is changed, it could affect the flow 
rate calibration.

Figure 4-8  Sheath tank location label 

8 Connect the air line. 

Upper weld line to 
indicate fill level

ATTENTION
SHEATH TANK (W)

to  be

LOCATED HERE
during  instrument  operation

to  maintain  calibration
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9 Close the vent release valve and use the sheath tank gauge to ensure the 
tank is pressurizing properly.

The system is ready to run again.

Refilling the Ethanol Shutdown Tank 

The fluid level in the stainless steel ethanol shutdown tank should be checked 
before starting the fluidics shutdown procedure and refilled when low. This tank 
does not have a sensor, so it must be checked manually.

Figure 4-9  Ethanol shutdown tank connectors

1 Turn off the stream.

2 If the air line on the ethanol shutdown tank is connected, disconnect it.

3 Pull up on the ring of the pressure relief valve to release pressure from the 
tank. 

Make sure the tank is fully vented.

4 Unscrew the tank cover knob and remove the cover.

5 Fill the tank with ethanol to the level shown in Figure 4-10.

6 Replace the cover and tighten the knob. 
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Make sure the large O-ring on the inside of the cover is seated correctly and 
has not slipped out of position. The tank can leak if the cover is not secured 
properly.

7 If you are going to perform fluidics shutdown, connect the air line.

Figure 4-10  Ethanol shutdown tank fill level

Refilling the Plastic Containers

You can refill the plastic containers directly in the fluidics drawer without 
detaching any lines, or you can remove the container for refilling. Note that 
during operation, you can add fluid to a container through the large cap without 
any interruption to your experiment, but if you detach any lines, you will need to 
prime the system.

1 (Optional) Disconnect the container’s sensor and quick-release connector 
from the connectors panel if you need to move the container. (See 
Figure 4-11 on page 131.)

If you do not need to move the container, skip to step 2.

Fill level
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Figure 4-11  Plastic fluidics container

2 Remove the large-sized cap from the container (See Figure 4-11.)

3 Fill the container with the fluid indicated on the container label.

4 Replace the container cap and hand-tighten it until it is fully closed.

5 If you disconnected the sensor and quick-release connectors in step 1:

a Reconnect the sensor and quick-release connectors to their respective 
ports.

b Prime the fluidics system.

From the BD FACSDiva menu bar, select Cytometer > Cleaning 
Modes > Prime after Tank Refill. In the dialog that opens, select the 
fluid to prime, then click OK.

To ensure that the appropriate solutions are dispensed, do not switch the 
tank positions. Make sure the label on each container matches the labeled 
port on the fluidics drawer. 

Quick-release 
connector

Large-sized 
cap

Sensor
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Emptying the Waste Container 

Empty the waste container daily and when the fluid indicator shows the waste is 
getting full. To prolong the life of the container, we recommend that you switch 
to the alternate container each time the waste is emptied. 

Figure 4-12  Waste container details

e

1 Disconnect the waste container’s sensor and fluid line connectors from the 
connector panel in the fluidics drawer. 

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total volume) 
before disposal. Dispose of waste in accordance with local regulations. Use 
proper precautions and wear suitable protective clothing, eyewear, and 
gloves.

Change the waste container cap every month, or when it has gotten wet, to 
prevent container pressurization. To order new replacement caps, contact 
your local BD Biosciences representative.

Waste container

Disposable waste
cap with trap

Waste fluid lines

Waste sensor

Connectors panel
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Figure 4-13  Waste section of connector’s panel 

2 Remove the disposable waste cap (large-sized cap) and attached trap from 
the container. Place the assembly on the bench label-side up. 

Figure 4-14  Draining liquid from the trap 

3 Empty the waste container according to your standard laboratory 
procedures for biohazardous waste.

4 Add approximately 1 L of bleach to the waste container (10-L container).

The waste container can become pressurized when the cytometer is 
running. Always disconnect the container from the connectors panel before 
you empty it. Wait at least 1 minute for pressure to dissipate before you 
open the container.

Do not wet the cap on top of the trap. If you see liquid inside the trap, 
remove the drain plug and fully drain the liquid before you replace the plug 
(Figure 4-14).

Waste fluid lines Waste sensor

Drain plug

Trap
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Add a sufficient amount so that 10% of the total waste volume is bleach.

5 Replace the waste trap and attached filter cap. Hand-tighten the trap and 
cap until they are fully closed. 

6 If one month has passed since you last changed the cap, replace the filter 
cap with a new one. Write the date on the new cap as a reminder.

7 Reconnect the sensor and fluid line connectors to their respective ports.

Checking Cytometer Performance

Before setting up an experiment, you should first run a performance check. A 
performance check ensures that the cytometer is performing consistently over 
time. It also generates default cytometer settings that places each PMT within an 
optimal range.

NOTE You can also use the quality control process originally established for BD 
FACSDiva software. See the BD Cytometer Setup and Tracking Application 
Guide.

To run a performance check, start the CS&T application within BD FACSDiva 
software and select the appropriate cytometer configuration. Each configuration 
must have a valid baseline. See the BD Cytometer Setup and Tracking 
Application Guide for more information on running a baseline.

To prevent over-pressurization during fluidics startup, do not overtighten 
the trap or attached filter cap. Tighten each component only until it is 
hand-tight. Do not use sealants such as Teflon® tape or other adhesives.

338677 Rev A

Waste (A)

Space for date
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Preparing the CS&T Workspace

To ensure that your cytometer is performing consistently over time, it’s important 
to keep as many variables constant as possible, such as bead type, sheath 
pressure, and cytometer settings. For this reason, you should run the daily 
performance check using the same cytometer configuration each day. 

1 Turn off the Sweet Spot (if it is on), then select Cytometer > CST.

The cytometer disconnects from the BD FACSDiva interface and connects 
to the CS&T interface. A window similar to Figure 4-15 opens.

Figure 4-15  Main CS&T window 
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2 Verify that the bead lot information under Setup Beads matches the CS&T 
research bead lot. 

Select the correct lot ID from the menu. The bead lot ID number is located 
on the CS&T research bead vial.

3 Verify that the cytometer configuration is correct for your experiment. 

If the cytometer is not set to the correct configuration:

a Click Select Configuration in the Setup Control window. 

b Select the correct configuration from the list.
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c Click Set Configuration. Click OK.

4 Verify that the current configuration has a valid baseline defined.

If not, see the BD Cytometer Setup and Tracking Application Guide for 
more information on running a baseline.

Valid baseline

Performance check date
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Preparing the BD FACSDiva CS&T Research Beads

BD FACSDiva CS&T research beads consist of bright, mid, and dim beads dyed 
with a mixture of fluorochromes. Use the beads to define a baseline and to check 
cytometer performance using the CS&T application. 

See the BD FACSDiva CS&T research beads technical data sheet for instructions 
about preparing the bead suspension. Instructions vary based on the task you are 
performing.

Running a Performance Check

The performance check function of CS&T will check the cytometer’s daily 
performance.

1 Install the bead tube onto the cytometer loading port.

2 In the Setup Control window, select Check Performance from the 
Characterize menu.

3 Click Run.

Plots are displayed under the Setup tab and the performance check is run. 
The performance check takes approximately 5 minutes to complete.

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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Reviewing the Results

1 Once the performance check is complete, click View Report.

2 Print the report. 

3 Verify that the performance check passed.

In the Setup tab, the Cytometer Performance Results should have a green 
checkmark and the word Passed next to it.

If any parameters did not pass, see the BD Cytometer Setup and Tracking 
Application Guide for troubleshooting information.

4 Select File > Exit to close the CS&T window and connect back to the BD 
FACSDiva interface.

5 Click Use CST Settings in the CST Mismatch dialog that opens.

See CST Mismatch Dialog on page 140 for more information.

When CS&T settings are applied to new experiments, the settings applied 
include PMT voltages, threshold, laser delays, and area scaling factors. 
(The window extension values are generated from the cytometer 
configuration.)
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When CS&T settings are applied to existing experiments, the settings 
applied include PMT voltages, laser delays, area scaling factors, and 
window extensions. Threshold values remain the same.

NOTE There is a system preference to always use current CS&T settings 
that can be set by the administrator. For BD FACSAria Fusion users, we 
recommend that you do not enable this preference.

At this point you can do one of the following:

• Create application settings for an experiment you will use frequently. See 
Application Settings on page 141.

• Collect data using existing application settings. See Data Collection on 
page 148.

CST Mismatch Dialog

If there is a mismatch between the CS&T settings and those in BD FACSDiva 
software, a dialog opens (Figure 4-16) to indicate what the differences are, and 
gives you the following options:

• Use CST Settings. Select this option if you want to use the settings 
generated from the most recent performance check.

• Keep BD FACSDiva Settings. Select this option if you want to keep the 
settings that are associated with your cytometer.

• Details. Click this button to view the differences between the two settings 
to help with your selection.
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Figure 4-16  CST Mismatch dialog

• See Data Collection on page 148.

Application Settings

Application settings are associated with a cytometer configuration and include 
the parameters needed for the application, area scaling values, PMT voltages, and 
threshold values, but not compensation. Each time a performance check is run 
for a configuration, the application settings associated with that configuration 
are updated in the catalog. To update the application settings in an existing 
experiment, right-click the application settings in the Browser and select 
Application Settings > Apply.

Using application settings provides an easy, consistent, and reproducible way to 
reuse cytometer settings for your commonly used applications. See the BD 
Cytometer Setup and Tracking Application Guide for information on running a 
baseline and for other details on using the CS&T application.

Before creating application settings you must:

• Perform the cytometer startup procedure described in Cytometer Startup 
on page 116.

• Run a performance check for the cytometer configuration that will be used 
for the application.
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Creating Application Settings

This section describes how to create and save application settings for a multi-
color immunophenotyping sample. 

Setting Up the Workspace

1 Select Cytometer > View Configurations, and verify that the current 
configuration is appropriate for the type of sample you are running.

2 Verify that there is a valid performance check for the configuration.

3 Create a new folder.

4 Create a new experiment.

5 Select the Cytometer Settings in the Browser.

6 In the Inspector window, click the Parameters tab and delete any unneeded 
parameters.

7 Select the H check box to select height for each parameter. 
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Adjusting Area Scaling

The required area scaling factor changes based on sheath pressure and particle 
size. The area scaling factors should be verified for each experiment performed 
on the cytometer. 

NOTE You will need to modify the template to support the lasers installed on 
your system. Don’t forget to save the settings when you are done.

1 In the Browser, right-click Global Sheet1 and select Apply Analysis 
Template.

2 In the Template dialog, select the Area Scaling worksheet and click OK.

3 Create a new specimen by clicking the New Specimen button on the 
Browser toolbar.

4 Expand the new specimen, then click to set the current tube pointer to 
Tube_001.

5 Install the FITC-positive control tube onto the loading port and click Load 
on the Acquisition Dashboard.

6 Adjust the FSC and SSC voltages to place the particles on scale. 

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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7 Adjust the P1 gate around the population of interest in the FSC vs SSC plot. 

8 Adjust the FSC area scaling.

a Click the Laser tab in the Cytometer window. 

b Adjust the FSC area scaling factor until the FSC-A signal matches the 
FSC-H signal. See Figure 4-17 on page 145. 

• Increase the area scaling factor if the FSC-A signal is lower than 
FSC-H. 

• Decrease the area scaling factor if the FSC-A signal is higher than 
FSC-H.

c View the result of your change in the histograms and statistics views.
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Figure 4-17  FSC area scaling comparison

9 Adjust the blue laser area scaling until the FITC-A signal matches the FITC-
H signal, if needed. 

10 Unload the FITC-positive control tube, then load the APC-positive control 
tube.

11 Adjust the red laser area scaling until the APC-A signal matches the APC-H 
signal, if needed.

12 Check and adjust, as necessary, the area scaling for the remaining lasers 
using a single color stained tube.

Only one parameter from each laser needs to be used for area scaling.

13 In the Inspector window, clear the checkboxes for height for all parameters. 
See Figure 4-18 on page 146.

Incorrect FSC area scaling Correct FSC area scaling
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Figure 4-18  Inspector window

Optimizing PMT Voltages 

1 Right-click Cytometer Settings in the Browser, then select Application 
Settings > Create Worksheet.

A second global sheet is added with the plots created according to your 
selections in the Parameters tab. (See Figure 4-19.) Use the gray boxes and 
crosshairs to guide your optimization. 

NOTE The gray boxes and crosshairs are not displayed until acquisition 
starts.

Figure 4-19  Optimizing PMT voltages

2 Load a multicolor sample tube onto the cytometer.

3 In the Cytometer window, optimize the settings for your application.
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a Optimize the FSC and SSC voltages to place the population of interest 
on scale.

b Optimize the FSC threshold value to eliminate debris without 
interfering with the population of interest.

4 Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that 
parameter until the positive population can be seen entirely on scale.

5 Unload the multicolor sample from the cytometer.

Saving Application Settings

1 Right-click Cytometer Settings in the Browser, then select Application 
Settings > Save, to save the values for reuse. See Figure 4-20.

Figure 4-20  Saving application settings

a In the Application Settings dialog, rename the application settings with 
a descriptive name.

b Click OK.

The application settings are saved to the catalog.
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Data Collection

Before you record data for a sample, cytometer settings should be optimized to 
position the cells of interest on scale for scatter and fluorescence parameters. In 
the previous section, application settings were created by taking into 
consideration the following:

• FSC and fluorescence area scaling

• FSC and SSC voltages

• FSC threshold

• Fluorescence PMT voltages

In this section, the application settings will be applied and compensation will be 
calculated before collecting test data.

The following sections describe how to use previously optimized application 
settings for a 4-color experiment. See Application Settings on page 141 for more 
information. 

Compensation will be automatically calculated using the compensation setup 
feature. For more information about this function, see the BD FACSDiva 
Software Reference Manual. If you are performing compensation manually, not 
all steps will apply.

Setting Up the Workspace

Before you begin optimizing settings, it is important to verify the cytometer 
configuration and create an experiment containing appropriate parameters for 
the assay.

1 Select Cytometer > View Configurations, and verify that the current 
configuration is appropriate for the type of sample you are running.

2 Verify that there is a valid performance check for the configuration.
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3 Make sure that the octagon(s) contain appropriate filters.

For assistance, see Cytometer Configuration on page 87.

4 Click the corresponding buttons on the Workspace toolbar to display the 
Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and 
Acquisition Dashboard ( ) windows, as needed.

5 (Optional) Create a folder for your experiment.

Select the icon for your database and press Ctrl+N. Rename the folder 
appropriately. See the BD FACSDiva Software Reference Manual for ideas 
on how to organize experiments.

Tip     To place an experiment inside a folder, select the folder before you 
create the experiment.

6 Create an experiment from the Doublet Discrimination Gating template. 
See Figure 4-21 on page 150.

For best results, we recommend that you perform doublet discrimination in 
order to record only singlet events. This template contains cytometer 
settings and gated plots for this purpose. A procedure is given in Recording 
Data on page 159.

For accurate data results, the cytometer optics must match the current 
cytometer configuration.
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Figure 4-21  Experiment created from the Doublet Discrimination Gating template

To use the template, select Experiment > New Experiment and select the 
Doublet Discrimination Gating template. Click OK to add a copy of the 
template to the Browser.

7 Rename the experiment appropriately (for example, 4-Color experiment).

8 Right-click the experiment level Cytometer Settings in the Browser and 
select Apply Application Settings. See Figure 4-22 on page 151. 
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Figure 4-22  Application Settings window

See Application Settings on page 141 for instructions on creating 
application settings.

9 Select the application setting for your sample and click Apply.

See Figure 4-23 for a typical error message if there are any mismatches 
between the application and cytometer settings.

Figure 4-23  Example mismatch error message 

10 Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog opens, listing only those 
parameters associated with the application settings.

11 Click OK to add the specified controls.

Alternatively, add and define label-specific controls, then click OK. 
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Figure 4-24  Create Compensation Controls dialog

Add label-specific controls when your experiment contains samples stained 
with the same fluorophore conjugated to different antibodies (labels) that 
require different compensation values. This is especially useful with tandem 
conjugates due to lot-to-lot variation. See the BD FACSDiva Software 
Reference Manual for more information about this function.

A compensation specimen is added to the experiment, along with a stained 
control tube for each compensation control. (Expand the specimen to view 
all tubes.) Worksheets containing appropriate plots are added for each 
compensation tube.

Calculating Compensation

The unstained control will be used to verify the settings for FSC, SSC, and FSC 
threshold, and to gate the population of interest.

1 Install the unstained control tube onto the cytometer. 

2 Expand the compensation specimen in the Browser.
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3 Set the current tube pointer to the unstained control tube and click Load.

4 Verify that the population of interest is displayed appropriately on the FSC 
vs SSC plot. Adjust if needed. (See Figure 4-25.)

Since the application settings have already been optimized for your sample, 
the cytometer settings should require little or no adjustment (unless you are 
using BD™ CompBead particles).

Figure 4-25  Voltages adjusted

5 Click the Threshold tab and adjust the FSC threshold, if needed.

Set the threshold to remove most of the debris without cutting off the 
singlet population (Figure 4-25).

6 Adjust the P1 gate to surround only the singlets (Figure 4-25).

7 Right-click the P1 gate and select Apply to All Compensation Controls.

The P1 gate on each stained control worksheet is updated with your 
changes.

8 Click Record Data. 

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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9 When recording is finished, click Unload and remove the unstained control 
tube from the cytometer.

10 Install the next tube onto the cytometer and repeat steps 8 and 9 until data 
for all stained control tubes has been recorded.

11 Double-click the first stained control tube to display the corresponding 
worksheet.

12 Verify that the snap-to interval gate encompasses the positive population. 
Adjust the gate, if needed.

13 Repeat steps 11 and 12 for the remaining compensation tubes.

14 Select Experiment > Compensation Setup > Calculate Compensation.

15 Enter the name of your experiment as the setup name, then click Link & 
Save. 

Do not change the PMT voltages after the first compensation control has 
been recorded. In order to calculate compensation, all controls must be 
recorded with the same PMT voltage settings. If you need to adjust the 
PMT voltage for a subsequent compensation control, you will need to 
record all compensation controls again.
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Tip     To keep track of compensation setups, include the experiment 
name, date, or both in the setup name.

NOTE We recommend that you always visually and statistically inspect 
automatically calculated overlap values. The means of the positive controls 
should be aligned with the means of the negative.

Data Recording and Analysis

Once you have optimized the cytometer electronics for your sample type, you are 
ready to record and analyze data. 

Before you record data, we recommend that you gate out doublets in order to 
record only singlet events. The Doublet Discrimination Gating template provides 
gated plots for this purpose.

During analysis, recorded data is displayed in plots, and gates are used to define 
populations of interest. BD FACSDiva software analyzes the gated data and 
calculates statistics that you can print or export. With global worksheets, data 
can be shown for a series of tubes on the same worksheet, manually or in an 
automated batch analysis.

The following sections describe how to use BD FACSDiva software features to 
record and analyze sample data. 
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Setting Up the Experiment

Before you record data, set up an experiment with appropriate tubes, plots, and 
labels for your assay. This section describes how to add Browser and worksheet 
elements to the experiment that was started in the previous section, Data 
Collection.

1 Rename Specimen_001 to a descriptive name.

2 Rename Tube_001 to 4-color_001.

3 Set the current tube pointer to the 4-color_001 tube.

4 Click Next Tube in the Acquisition Dashboard to duplicate the first tube 
with the name 4-color_002.

5 Use the experiment layout to specify the number of events to record for 
each tube.

The experiment layout can be used to define the events to record as well as 
parameter labels for all tubes in an experiment. Labels are displayed on the 
plot axes and in all statistics views.

a Select Experiment > Experiment Layout.

b In the Acquisition tab, select the events to record field for all specimen 
tubes, and select or enter 5,000 events.

c Click OK. 
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Setting Up the Global Worksheet

A global worksheet is used to perform doublet discrimination and to set up plots 
to preview and record data.

1 Click the Worksheets View button on the Worksheet toolbar.

The global worksheet is shown. If you are using the Doublet 
Discrimination Gating template, the worksheet shows the predefined plots 
and gates used to distinguish singlets from doublets. 

The second and third plots are set up to display gated data from the first 
and second plots, respectively, as shown in the population hierarchy.

2 Create two dot plots for previewing and recording data.

For this example, create a FITC vs PE plot and an APC vs PerCP-Cy™5.5 
plot.

Tip     Double-click the Plot button to keep it selected until you create all 
plots. Click any other button to undo the selection.
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3 Turn on biexponential display. 

a Select the two plots.

b In the Inspector, select the checkbox for X Axis and Y Axis under 
Biexponential Display. 

4 Set up the fluorescence plots to display data from the FSC gate.

The FSC gate defines singlet events. By gating the fluorescence plots 
through this population, only singlet events will be recorded.

a Select the two plots. 

b In the Inspector, select the FSC Gate checkbox.

5 Arrange the fluorescence plots so they fill the page vertically.

For an example, see Figure 4-27 on page 162. 
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Recording Data

This section describes how to adjust the gates to eliminate doublets and record 
singlet events.

1 Move the current tube pointer to the 4-color_001 tube.

2 Install the first mixed sample tube onto the loading port and click Load.

3 Change the Events to Display to 5,000 events.

4 Adjust the scatter gate to encompass the singlet events.

5 Adjust the SSC gate to encompass the low SSC-W population.

6 Adjust the FSC gate to encompass the low FSC-W population.

Figure 4-26  Discriminating singlet events

7 Click Record in the Acquisition Dashboard to record data.

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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8 When all events have been recorded, click Unload and remove the tube 
from the cytometer.

9 Install the next tube, then click Next Tube in the Acquisition Dashboard to 
move the current tube pointer to the next tube.

10 Repeat steps 7 through 9 for the remaining tubes.

Analyzing Data

This section describes how to set up plots, gates, and a statistics view to analyze 
the recorded data. By the end of this section, your analysis should look similar to 
that shown in Figure 4-27 on page 162.

1 Select Edit > User Preferences. 

2 In the Gates tab, set the preferences as follows.

3 Create the following gates:

• Quadrant gate on the FITC vs PE plot. 

• Interval gate on the APC vs PerCP-Cy5.5 plot to capture the APC 
beads.

• Rectangle gate on the APC vs PerCP-Cy5.5 plot to capture the PerCP-
Cy5.5 beads. 
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4 Rename each population in the population hierarchy. 

Tip     Press the Enter key twice to move to the next population without 
using the mouse.

5 Right-click either fluorescence plot and select Create Statistics View. 

A statistics view is added to the worksheet.

6 Right-click the statistics view and select Edit Statistics View.

7 Edit the statistics view as follows:

• In the Header tab, select the Use 2 columns for display checkbox.

• In the Populations tab, clear the checkboxes for all populations except 
FITC, PE, PerCP-Cy5.5, and APC. 

• In the Statistics tab, select the Mean checkboxes for the fluorescence-A 
parameters.

8 Resize the statistics view so it fits on the page.

9 (Optional) Print the analysis.



162 BD FACSAria Fusion User’s Guide   

Figure 4-27  Sample analysis for mixed-bead tube

Performing a Batch Analysis

Batch analysis allows you to automatically advance through a selected set of tube 
data when using a global worksheet. 

To perform a batch analysis:

1 Verify that the global worksheet you will be using for analysis is displayed 
in the worksheet window.
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2 Right-click the specimen to analyze in the Browser and select Batch 
Analysis.

The Batch Analysis dialog opens.

Only tubes under the selected specimen will be processed. Tubes without 
data are skipped during a batch analysis.

3 Do the following in the Batch Analysis dialog.

• Select Auto to analyze all the files without user intervention. 

• Select 5 from the View Time menu to pause the analysis for 5 seconds 
after each tube is loaded.

• Select the Output to Printer checkbox to print a copy of the analysis 
after the data for each tube is loaded. 

• Select the Statistics checkbox to export the statistics to a separate file, 
then enter a name for the statistics file. By default, the file is saved at 
D:\BDExport\Statistics.

• Select the Freeze Biexponential Scales checkbox to process all files with 
the same biexponential scales.

• Clear the Use Preferred Global Worksheet checkbox to display analyses 
of tubes within the same global worksheets. This option is useful for 
analyzing panels that require a separate global worksheet for each 
tube.
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See the BD FACSDiva Software Reference Manual for more information 
on batch analysis.

4 Click Start to begin the analysis.

When the analysis is finished, a completion dialog opens.

Manual Adjustment of Laser Delay

Laser delay is automatically adjusted during performance checks. However, you 
may want to adjust laser delay manually, for example, when changing sheath 
pressure.

In a BD FACSAria Fusion system with red, blue, and violet lasers, the red laser 
intercepts the stream first, followed by the blue and violet lasers, respectively. 
Because the laser signals are spatially separated, there is a slight delay between 
the detection of each laser’s signal.

The laser-delay factor in BD FACSDiva software is used to realign the signals so 
they can be measured and displayed on the same time scale. Signals are aligned 
with respect to the blue laser, so the blue laser will have a 0 delay value, the red 
laser will have a negative delay value, and the violet laser will have a positive 
delay value.

To manually adjust the delay:

1 Select your experiment folder in the Browser and create a new experiment.

2 Rename the experiment Laser Delay.

3 Create a specimen and a tube in the experiment and set the current tube 
pointer next to the tube.
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4 On the global worksheet, create a plot for FSC vs SSC and then histograms 
for each laser. 

5 Create a P1 gate on the FSC vs SSC plot and change the histograms to view 
P1.

6 Prepare a tube of Spherotech™ Rainbow beads.

7 Load the tube of Spherotech Rainbow beads and click Load.

8 Place the population on scale in the FSC vs SSC plot. 

9 Adjust P1 to encompass the singlet population, if needed.

a Optimize the delay setting for the red laser.

BD FACSFlow Solution
Spherotech Rainbow 
Particles (3.0–3.4 µm)

Ordering Info

1 mL 2 to 3 drops Cat. No. 556291

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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b Click the Laser tab in the Cytometer window.

c While watching the peak in the APC-A histogram, change the window 
extension to 0.

• If the APC-A signal stayed the same or had little change, then go to 
step d.

• If the APC-A signal decreased, then follow steps c through d.

d Adjust the laser-delay value until the maximum APC-A signal is 
achieved.

e Reset the window extension to the appropriate setting (typically 2). 

10 Repeat step a for each laser, using the appropriate fluorochrome for each 
laser.

11 (Optional) To return to the laser delay values determined by CS&T, right-
click the cytometer settings in the Browser and select Apply CST Settings.

Red laser delay field

Window Extension field
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12 (Optional) To save this worksheet for future use, export it as an analysis 
template.

a Right-click the global worksheet in the Browser.

b Select Export > Analysis Template.

c Name the template Laser Delay Plots and click Save.
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5

Sorting

You can program BD FACSDiva software to sort a specified number of particles 
from multiple populations into a variety of sorting devices including tubes, 
plates, and slides. Hardware for sorting into plates and slides is available as an 
option. Up to four defined populations can be sorted into each tube, allowing up 
to 16 populations to be sorted at one time.

The following topics are covered in this chapter:

• Setting Up for Sorting on page 170

• Determining the Drop Delay – Manual Method on page 176

• Determining the Drop Delay – Automatic Method on page 181

• Sorting on page 183

• Setting Up for Sorting onto a Plate or Slide on page 192

• Index Sorting on page 199

• Terasaki Plate Adapter on page 203
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Setting Up for Sorting

In general, do the following to set up for a sorting experiment. Each step is 
explained in more detail in previous or subsequent sections. 

1 Start up the cytometer and the computer.

See Cytometer Startup on page 116. 

2 Install the appropriate size nozzle.

3 Select a new sort setup mode, if needed, and select an appropriate 
cytometer configuration.

To change your current sort setup mode, select a nozzle size from the Sort > 
Sort Setup menu. 

For more information, see Sort Setup on page 103.

4 Install a sample line filter, if needed.

See Installing or Removing a Sample Line Filter on page 239.

5 Check the laser delay for your sheath pressure and particle size. 

• To set the laser delay automatically using the CS&T module, see 
Checking Cytometer Performance on page 134.

• To set the laser delay manually, see Manual Adjustment of Laser Delay 
on page 164.

6 If you have the AMO, turn it on at 20%. 

See Operating the BD Aerosol Management Option on page 306.

7 Optimize cytometer settings for the sample to be sorted.

See Data Collection on page 148.
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8 Install the required collection device and set up the side streams.

See Setting Up for Bulk Sorting on page 171 or Setting Up for Sorting onto 
a Plate or Slide on page 192.

9 Calculate the drop delay.

See Determining the Drop Delay – Manual Method on page 176.

10 Use gating tools and subsetting methods to define the population(s) of 
interest.

Examples of gating analyses can be found in Analyzing Data on page 160.

11 Define a sort layout for the tube containing the defined sort populations 
and proceed with sorting. 

See Sorting on page 183. 

Setting Up for Bulk Sorting

This section describes how to set up the streams for two- or four-way sorting. For 
sorting using the ACDU option, see Setting Up for Sorting onto a Plate or Slide 
on page 192.

To set up for bulk sorting:

1 Install collection tubes in the appropriate collection device.

Collection tube holders are available for 1-mL microtubes, 1.5-mL 
Eppendorf® tubes, 12 x 75-mm tubes, and 15-mL centrifuge tubes. For 
compatible tubes, see Labware on page 284. 

2 Install the collection tube holder onto the cytometer.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves.
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a Close the sort block door and open the sort collection chamber door, if 
needed. The sort block door must be closed to install the tube holder.

b Slide the holder into the slotted fittings below the sort aspirator drawer, 
then close the sort collection chamber door.

3 Turn on the deflection plates.

Click the Voltage button in the Side Stream window (Figure 5-1 on 
page 172). The voltage warning light illuminates, indicating that the plates 
are charged. 

Figure 5-1  Turning on the deflection plates 

Make sure the center stream image does not move after the plates are 
turned on. Major movement of the center stream could indicate that the 
plates or the area around the plates needs cleaning. 

Before installing the collection tube holder, ensure that an O-ring is 
installed in the groove between the two sections of the tube holder. The 
O-ring minimizes the chance of aerosols escaping. It can be found in the 
accessory kit (Catalog No. 337897).

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the plate voltage is on. The plates 
remain energized even when the sort block door is open.

Voltage 
button
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4 Click the Test Sort button and optimize the side streams. See Figure 5-2.

Adjust the voltage sliders to view the required number of streams. 

Figure 5-2  Turning on Test Sort 

If you cannot see a stream image or the image is dim, adjust the micrometer 
dial on the diode laser to better view the streams (Figure 1-22 on page 42). 

5 Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and 
fine-tune the side streams, if needed.

Generally, the sort setup mode provides good starting values for these 
settings. Adjust the values only if needed to optimize the streams.

6 Open the aspirator drawer and aim the side stream(s) into each collection 
tube.

a In the Side Stream window, click the Waste Drawer button to open the 
drawer.

b Open the sort block door and aim each side stream into the tube as you 
adjust the corresponding slider in the Side Stream window.

c When you are satisfied with the side stream deflection, close the sort 
block door.

7 Click the Voltage button to turn off the deflection plates.

Test Sort 
button

Voltage 
sliders
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8 Optimize the drop delay.

See one of the following procedures:

• Determining the Drop Delay – Manual Method on page 176

• Determining the Drop Delay – Automatic Method on page 181

Using the 1.5-mL Side Stream Alignment Tool

If you are using 1.5-mL Eppendorf tubes, use the 1.5-mL side stream alignment 
tool to align the side streams and verify drop placement.

1 Set the optimal breakoff.

2 Ensure that the center stream is aligned with the center of the aspirator 
drawer.

3 With the aspirator drawer closed (retracted), position the alignment tool in 
the sort block as shown.

4 Turn on the deflection plates.

5 Click Test Sort, then adjust sliders to align each side stream to the 
corresponding notch on the alignment tool.

Alignment tool
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Tip Place a wipe or paper towel inside the sample collection chamber to 
prevent the stream fluid from pooling or splashing.

6 Turn off the deflection plates.

7 Carefully remove the alignment tool.

8 To verify stream alignment, place four capped Eppendorf tubes inside the 
Eppendorf collection tube holder and insert the tube holder into the sort 
collection chamber.

9 Turn on the deflection plates.

10 Quickly click Test Sort twice to deposit a drop on the Eppendorf tube lids.

11 Verify that the drops are deposited on the center of each Eppendorf tube 
lid.

Tip For future reference, record the slider values or take a screen shot of 
the stream setup window.

Drop on Eppendorf tube lid
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Determining the Drop Delay – Manual Method

BD FACS Accudrop technology is used to determine the optimal drop-delay 
setting for your sorting application. For more information, see Drop-Delay 
Overview on page 71. 

There are two methods for determining the drop delay.

• Manual drop delay. Using the standard method as described in the 
following sections.

• Auto drop delay. Using an automated algorithm method. See Determining 
the Drop Delay – Automatic Method on page 181.

NOTE Before beginning these procedures, make sure the stream is stable and the 
Sweet Spot is on. 

Setting Up the Experiment

This section describes how to set the drop delay using the Accudrop experiment 
template. Because no data is recorded, the experiment can be reused as often as 
you like. 

1 Create an experiment from the Accudrop Drop Delay template.

Select Experiment > New Experiment. Select the Accudrop Drop Delay 
experiment and click OK. See Figure 5-3 on page 177.
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Figure 5-3  Experiment Templates window

2 Expand Specimen_001 and Tube_001.

3 Set the current tube pointer to Tube_001.

4 Open the sort layout by double-clicking it.
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Using Manual Drop Delay

This section describes the manual method of optimizing the drop delay. 

1 Load a tube filled with a suspension of Accudrop beads (approximately one 
to two drops of beads in 0.5 mL of PBS).

2 In the Laser tab of the Cytometer window, set the window extension to 
zero.

3 Adjust the flow rate to achieve an event rate of 1,000–3,000 events per 
second.

4 Turn on the voltage in the Side Stream window. Click Sort in the Sort 
Layout window.

5 Click Cancel at the Confirm dialog (Figure 5-4 on page 179).

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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Figure 5-4  Confirm dialog

There is no need to collect the beads. When the drawer is closed, the beads 
are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-22 on page 42) to obtain the 
brightest bead spot on the center stream. 

7 Click the Optical Filter button in the Side Stream window.

This control moves the emission filter that allows you to view the Accudrop 
beads in front of the lower camera. When the control is clicked, the image 
switches from a raw image to a processed (digitized) image. The two boxes 
indicate the region of the image where the left and center stream intensities 
are calculated during image processing. The numbers shown are 
percentages of the total intensity. 

If the left side stream is not completely contained in the left region, adjust 
the voltage slider to place the stream in the center of the region.

8 Verify that the sort precision mode is set to Initial. 

See Sort Precision Modes on page 77 for more information.

9 Optimize the drop delay.

Adjust the drop-delay value in 1-drop increments (Ctrl+click arrow 
control) to achieve close to 100% intensity in the left side stream. Wait a 
few seconds after each click for a complete response to the delay change. 
See Figure 5-5 on page 180.
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Figure 5-5  Sorting Accudrop beads in Initial mode 

10 In the Sort Layout window, change the precision mode to Fine Tune.

11 Optimize the drop delay.

Adjust the drop-delay value in 0.03-drop increments (click the arrow 
control) until the left side stream intensity is greater than or equal to 90%. 
Wait a few seconds after each click for a complete response to the delay 
change. 

Figure 5-6  Sorting Accudrop beads in Fine-Tune mode

12 Click the Optical Filter button to move the emission filter away from the 
camera.

13 Reset the window extension to its original setting (typically 2).
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14 Turn off the deflection plates.

Determining the Drop Delay – Automatic Method

The auto drop delay feature automates setting the drop delay to get optimized 
results from sorting. You should use this method after you have a good 
understanding of how drop delay works in general. See Using Manual Drop 
Delay on page 178 for more information.

Overview of Auto Drop Delay

Auto drop delay works best when the sort system is stable, and assumes that 
Accudrop beads are used. When the process is started, the auto drop algorithm 
uses several passes to find best drop delay possible under the current conditions 
of the system. Coarse passes are used to find the initial drop delay within 2 drops 
of the ideal. The coarse passes are faster than the fine-tune passes. Fine-tune 
passes are used to locate the ideal drop delay value considering the current 
conditions.

Using Auto Drop Delay

1 Set up an experiment for drop delay as described in Setting Up the 
Experiment on page 176.

2 Load a tube filled with a suspension of Accudrop beads (approximately 2 
drops of beads in 0.5 mL of PBS).

3 Adjust the flow rate to achieve these values of events per second:

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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70 micron = 1,000 to 3,000
85 micron = 800 to 2,000
100 micron = 600 to 1,500
130 micron = 400 to 1,200

Tip     If this cannot be achieved using a flow rate setting between 1 and 
5, adjust the bead concentration.

4 Turn on the voltage in the Side Stream window. Click Sort in the Sort 
Layout window.

5 Click Cancel in the Confirm dialog.

There is no need to collect the beads. When the drawer is closed, the beads 
are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-22 on page 42) to obtain the 
brightest bead spot on the center stream. 

7 Click the Auto Delay button in the Side Stream window.

A dialog similar to Figure 5-7 on page 183 opens. The graph in the left 
pane of the dialog represents brightness of the stream (Y axis) versus drop 
delay (X axis). Typically the graph should have a flat portion, with several 
small peaks in either direction (up or down) or one prominent peak. 

NOTE If the original drop delay value was close to the appropriate value 
prior to starting auto delay, then you may not get a graph displayed 
because few data points were required to determine the optimal drop delay.

8 Select Start Run in the Auto Drop Delay dialog.

9 Monitor the Auto Drop Delay dialog for progress. 

A message is displayed when the process is completed.

NOTE If the sort is stopped during algorithm execution (either by user 
action or because the system detected a failure), the run will be stopped 
with an appropriate message. Start the sort again, verify that the stream is 
stable and the sort is not pausing, and re-run the auto drop delay.
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Figure 5-7  Auto drop delay dialog

Sorting

Before beginning the sort, do the following:

1 Perform the steps outlined in Setting Up for Sorting on page 170.

2 Use gating tools and subsetting methods to define the population(s) of 
interest.

Examples of gating analysis can be found in Analyzing Data on page 160.

NOTE Gates drawn on a biexponential scale can be used for sorting. 
However, the cytometer will sort on a log scale. Therefore, a gate that 
crosses the zero boundaries will sort all events below zero into that gated 
population. This can cause a variance between the sort results and the 
statistical results in the software. If the gate is completely below zero on a 
biexponential plot, no events will be sorted.

NOTE Snap-to gates cannot be used for sort gates.



184 BD FACSAria Fusion User’s Guide   

Setting Up the Experiment

Tip     When more than one drop is deflected in the same direction, residual charge 
from the first drop degrades the quality of the side streams. Thus, when four-way 
sorting or sorting into small wells where precise deflection is required, use the 4-
Way Purity mode or select a mode with a yield mask of zero. For more information, 
see Yield Mask on page 74.

1 Create a new sort layout by clicking the New Sort Layout button on the 
Browser toolbar. 

By default, the 2-Tube Sort Layout is displayed.

2 Make appropriate entries in the Sort Layout window.

• Select the collection device from the Device menu.

• Change the sort precision mode to Purity (two tubes), 4-Way Purity 
(four tubes), or Single Cell (plate or slide).

• Enter the number of target events by selecting a value from the menu or 
entering a number in the field. 

• Select a Save Sort Reports option: Save None, Save All, or Ask User. 
See Setting Up a Sort Layout on page 107.

• Select the Save Conflicts checkbox if you are using a 2- or 4-tube sort 
layout and want to save conflicts.
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• Select the Index Sorting checkbox if you are doing an index sort. See 
Index Sorting on page 199.

• Select the sort location field(s) to be sorted into. Select multiple fields 
by dragging the mouse. Select a row or column by clicking the row or 
column header. 

• Add the required population(s) to each sort location field. 

• To display fewer counters in the Sort Layout window, click the View 
Counters button and clear a menu option. The corresponding counter 
is hidden. (Only counters with a checkmark next to the name are 
displayed.)

Starting and Monitoring the Sort

To start the sort:

1 Open the sort collection chamber door and install the collection tubes, 
plate, or slide.

2 Close the sort collection chamber door.

The flow cell access door is equipped with a shutter mechanism that shuts 
off the laser light when the door is opened. To ensure there is no 
interruption to data acquisition, do not open the door while sorting or 
recording. 

Failure to close the sort collection chamber door prevents the evacuator 
from generating negative pressure in the chamber and could affect drop 
placement while sorting.
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3 Install the sample tube onto the loading port and click Load.

4 Adjust the flow rate.

Sorting results are typically optimized at lower flow rates.

5 (Optional) Turn on the deflection plates and open the aspirator drawer.

The deflection plates turn off automatically each time a tube is unloaded. If 
you do not turn them back on before beginning a sort, a dialog is displayed 
in which you can turn on the plates and open the aspirator drawer by 
clicking OK.

6 Verify that the current tube pointer is indicating the appropriate tube in the 
Browser, then click Sort.

7 Click OK if you are prompted to open the aspirator drawer or turn on the 
deflection plates.

Tip     Click Record Data to save data for the tube. Acquisition and 
sorting continue after the required number of events has been recorded.

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.

If you click Cancel, sorting will begin with the deflection plates off and the 
drawer closed. As a result, sort populations will be identified and counted, 
but no deflection (or sorting) will occur. If you sort with the drawer closed, 
events will be sorted to waste.
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Sorting continues until the required number of cells has been sorted. 
Acquisition stops and the drawer closes when sorting is complete. If the 
number of Target Events is set to Continuous, sorting continues until you 
manually stop sorting by clicking the Stop Acquiring button in the 
Dashboard, or the Sort button in the Sort Layout window. 

Monitor the sort progress in the Sort Layout window. The number of 
events sorted into each sort location is displayed in the corresponding field. 
The sort rate and sort conflict rate are displayed in the corresponding 
counter fields.

NOTE When the Sweet Spot is on, sorting pauses automatically if the 
Drop 1 or Gap values are out of range. This ensures that sorting occurs 
only under the proper breakoff conditions. If a more severe problem such 
as a clog is detected, the stream shuts off and sorting stops. The deflection 
plates shut off, the aspirator drawer closes, and the sample tube is 
unloaded. To clear a clogged nozzle, see Responding to a Nozzle Clog 
During a Sort on page 190.

8 (Optional) You can print the sort report at this time, or open the report 
later and print it then. You can also export the report.

Stopping and Resuming a Sort

The Stop/Resume function allows you to temporarily stop the sort and still retain 
the counter values. This is particularly useful when the sample volume is low and 
you need to refill the tube, or to replace collection tubes. 
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Replacing a Sample Tube 

1 To stop a sort while it is running, click the Sort button in the Sort Layout 
window. 

2 If prompted, click OK to save the sort report. 

You can set the sort report to save automatically after each sort. See Setting 
Up a Sort Layout on page 107.

3 Unload the sample tube by clicking Unload on the Acquisition Dashboard.

4 Refill the sample tube, then click Load in the Acquisition Dashboard.

5 Click the Resume button in the Sort Layout window to continue sorting.

6 Click OK when you are prompted to open the aspirator drawer or turn on 
the deflection plates.

The sort counters resume from the value where they stopped. The threshold 
counter restarts. However, the value is accumulated and the total count is 
saved in the final sort report.

Replacing the Collection Tubes 

1 To stop a sort while it is running, click the Sort button in the Sort Layout 
window. 

2 If prompted, click OK to save the sort report. 

You can set the sort report to save automatically after each sort. See Setting 
Up a Sort Layout on page 107.

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.
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3 Click Stop Acquiring in the Acquisition Dashboard to stop the sample flow.

4 Turn off the deflection plates by clicking the Voltage button in the Side 
Stream window.

5 Remove the lower section of collection tube holder by lifting up on the 
handle and pulling the lower section of the holder down and forward.

6 Replace the collection tubes as needed.

7 Reinstall the tube holder and pull down on the handle to secure it in place.

8 Click Acquire Data in the Acquisition Dashboard to restart the sample 
flow.

9 Click the Resume button in the Sort Layout window to continue sorting.

10 Click OK when you are prompted to open the aspirator drawer or turn on 
the deflection plates.

The sort counters resume from the value where they stopped. The threshold 
counter restarts. However, the value is accumulated and the total count is 
saved in the final sort report.

Pausing and Resuming a Sort

The Pause/Resume function allows you to temporarily pause the sort, and still 
retain the sort counter values. This is useful when you need to make adjustments 
to an experiment during a sort. Be aware that the sample continues to flow 
during a pause.

NOTE If you need to replace the sample tube to refill it, or to replace collection 
tubes, you should stop the sort. See Stopping and Resuming a Sort on page 187.

1 To pause a sort while it is running, click the Pause button in the Sort 
Layout window.

2 Make adjustments to the experiment as needed.
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3 Click the Resume button in the Sort Layout window to continue sorting.

Responding to a Nozzle Clog During a Sort

Follow this procedure if your system does not have a BSC or the Aerosol 
Management Option (AMO).

If your system:

• Does not have a BSC, but does have the AMO, see Responding to a Nozzle 
Clog During a Sort with the AMO on page 310.

• Does have a BSC and the Aerosol Management System (AMS), see 
Responding to a Nozzle Clog During a Sort on page 336.

If the stream is disturbed during the sort (due in part to a clogged nozzle), the 
sort is designed to stop automatically and block the sort tubes (if Sweet Spot is 
on). The sort will not restart until the operator has cleared the clog. In the event 
of a nozzle clog, do not open the sort collection chamber door or access the sort 
tubes before following this procedure.

To clear a clogged nozzle:

1 If the stream has not already shut down automatically, turn off the stream 
by clicking the Stream button (with a checkmark) at the top of the Breakoff 
window.

This will shut off the stream, unload the sample, and close the aspirator 
drawer.

2 Turn on the stream and view the breakoff.

Cell sorters that use droplet generation methods, such as the 
BD FACSAria Fusion, can produce aerosols around the sample stream. 
When acquiring biohazardous samples, follow universal precautions at all 
times. Keep the sort block door and the sort collection chamber door closed 
during sorting. Follow these steps to stop sample flow and evacuate 
potential aerosols before opening the sort collection chamber door.
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If the clog is removed, the breakoff will be similar to the breakoff before 
the clog.

3 If the clog is not cleared, turn the stream on and off several times to see if 
the clog will clear itself.

4 If the clog is not removed, turn the stream off and perform the Clean Flow 
Cell procedure with DI water (see Cleaning the Flow Cell (Daily) on 
page 206), followed by turning the stream on to see if the clog will be 
cleared.

5 With the aspirator drawer closed, wait for at least 3 minutes to clear 
aerosols before opening the sort collection chamber and the sort block 
door.

6 If it is necessary to change nozzles or remove a clog from a nozzle, see 
Cleaning the Integrated Nozzle on page 233.

7 With the stream turned off, open the sort block door and dry the plates and 
surfaces as needed.

8 Make sure that all chamber doors are closed and restart the stream.

9 Perform these tasks if needed:

• Turn on the Sweet Spot

• Check the drop delay

• Check the side stream deflection

When removing collection tubes, be aware that the outside of the tube is 
potentially contaminated. Use alcohol swabs or bleach to wipe the outsides 
of tubes.
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Setting Up for Sorting onto a Plate or Slide

The following sections describe how to set up for sorting onto a plate or slide. 
For general guidelines, see Setting Up for Sorting on page 170.

Installing the Sorting Hardware

1 Install the splash shield below the aspirator drawer.

a Close the sort block door and open the sort collection chamber door, if 
needed. 

The sort block door must be closed in order to open the collection 
chamber door. 

b Remove the tube holder, if one is installed.

c Slide the splash shield into the slotted fittings below the sort aspirator 
drawer and push it all the way in.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves.

Splash shield
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2 Click the Access Stage button to bring the ACDU stage to the front.

a Open an experiment, if one is not already open, and create a sort 
layout for any of the tubes.

b In the Sort Layout window, click the Access Stage button to move the 
stage to the front of the sort collection chamber.

3 Install the appropriate collection device on the stage (Figure 5-8).

• If you are sorting into a plate, install the plate with well A1 toward the 
front of the stage.

• If you are sorting onto a slide, install the slide-adapter tray with the 
printed side up. If your slide has a frosted end, place the frosted end to 
the right.

Figure 5-8  ACDU stage set up with plate (left) and slide (right)

Sorting starts on the front left corner of the device (A1 location), and 
proceeds from front to back, and then from left to right, sorting in a 
serpentine motion. Thus, for a plate, sorting proceeds from well A1–A12, 
B12–B1, C1–C12, and so on. 

When sorting onto a slide, sorting proceeds in rows across the short end of 
the slide, and in columns along the long end of the slide. Make sure that 
you set up your sort layout accordingly. See Figure 5-9 on page 194.

Well A1

Well A1
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Figure 5-9  Sort order on a slide

Setting Up the Stream

This section describes how to optimize side stream deflection and how to adjust 
the home location.

When sorting onto a plate or slide, the stage is pre-programmed to move a set 
distance between wells on a plate or spots on a slide. The home location is used 
as the starting point. The far left stream should hit the center of the well in the 
top left corner of a plate or the top left corner of a slide at the home location.

Default home location coordinates exist for each standard sort collection device: 
Falcon® multiwell plates with 6, 24, 48, 96, and 384 wells, and standard or 
frosted-end slides. For other plate types, you will need to create a custom device. 
See Creating a Custom Device on page 197.

Use the following procedure to verify the home location and adjust it.

(A1)

(A2)

(A3)
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1 Turn on the deflection plates.

Click the Voltage button in the Side Stream window. The voltage warning 
light illuminates, indicating that the plates are charged.

NOTE Make sure the center stream image does not move after the plates 
are turned on. Major movement of the center stream could indicate that the 
plates or the area around the plates needs cleaning. See External Cleaning 
on page 210.

2 Select Sort > Home Device. 

3 In the Device Setup dialog, select the collection device you are using and 
click Go to Home (Figure 5-10 on page 195).

Figure 5-10  Device Setup dialog

The stage moves to the pre-programmed home position.

4 Click the Test Sort button and optimize the far left side stream, then click 
the Test Sort button again to turn it off. 

Ensure that the aspirator drawer is open. Adjust the far left slider for 
minimal deflection of the stream. The stream should be deflected just 
enough to clear the hole in the splash shield. Do not adjust the other sliders.

Test sort button
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If you cannot see a stream image or the image is dim, adjust the micrometer 
dial on the diode laser (Figure 1-22 on page 42) to better view the streams. 

5 Double-click the Test Sort button to deposit a drop at the home location.

NOTE To ensure consistent drop placement, keep the sort collection door 
closed when depositing drops on the vessel.

6 Inspect the collection device to see where the drop was deposited.

If you need to move the stage to the front, close the Device Setup dialog 
and click the Access Stage button in the Sort Layout window. 

7 Wipe the collection device dry and place it back on the tray support.

If needed, click the Access Stage button to send the stage back and select 
Sort > Home Position to access the Device Setup dialog again.

8 Adjust the home location, if necessary.

Click the appropriate arrow buttons to move the tray support as needed. 
Large arrows move the tray by five steps. Small arrows move the tray by 
one step.

9 Repeat steps 5 through 8 until the drop is centered appropriately.

10 Click Set Home, then Close.

11 Click the Voltage button to turn off the deflection plates.

12 Optimize the drop delay.

See one of the following procedures:

• Determining the Drop Delay – Manual Method on page 176

• Determining the Drop Delay – Automatic Method on page 181

13 Proceed with Sorting on page 183.
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Creating a Custom Device

You can program the ACDU stage to sort into any grid configuration. Create a 
custom device by entering the number of rows and columns and setting the home 
and farthest locations. BD FACSDiva software calculates the increment between 
rows and columns to determine the sort locations. The home and farthest 
locations for a 96-well plate are A1 and H12, respectively.

Figure 5-11  Home and farthest location on 9-drop slide (example)

1 Select Sort > Custom Devices.

2 Click the Add button in the Custom Devices dialog.

A new device is added to the list of custom devices. By default, devices are 
named Custom Device_00x, where x is the next consecutively numbered 
device.

Home

Farthest

New device
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3 Select the text in the Name field and enter a new name.

4 Enter the number of sort location rows and columns.

A device can have up to 60 rows and 25 columns.

5 Use the arrow buttons and the Test Sort button to set the home location, 
then click Set Home.

See Setting Up the Stream on page 194 for details. There are no default 
values for custom devices, so greater initial adjustment with the arrow 
buttons is required.

6 Use the same procedure to set the farthest location, then click Set Farthest.

The farthest sort location is the well or spot on the lower-right corner of the 
collection device.

7 Click Close.

After you set the home and farthest locations, custom devices are listed in 
the Device menu in the Sort Layout window. 

NOTE Once custom devices are defined, you cannot change the number of 
rows and columns.

8 Click the Voltage button to turn off the deflection plates.

9 Proceed with Determining the Drop Delay – Manual Method on page 176 
and Sorting on page 183.

Deleting a Custom Device 

1 Select Sort > Custom Devices.

2 Select the name of the custom device to be deleted in the Custom Devices 
dialog.

3 Click Delete. 
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The device is deleted from the Custom Device list, but is retained within 
any sort layouts where it was used.

Index Sorting

Index sorting allows you to sort single cells onto a plate or slide and indexes the 
well or slide location to the collected parameters for that cell. You can use this 
function to ensure that a sorted cell with a specific phenotype has been sorted. 
Index sorting is useful in characterizing subpopulations of phenotypically similar 
events using post-sort genetic, chemical, and/or metabolic applications.

Setting Up for Index Sorting

Index sorting uses the same steps as required in setting up for a plate or slide sort. 
Review the instructions in these sections:

• Setting Up for Sorting on page 170

• Setting Up for Sorting onto a Plate or Slide on page 192

To perform an index sort:

1 Create a new experiment, using a global worksheet, for the index sort.

NOTE If you want to export data from each well into one CSV file, you 
must use a global worksheet.

2 Create a new global worksheet.

3 Create the plots and gates needed to define the populations of interest.

4 Create a new sort layout or select an existing sort layout defined for index 
sorting.

5 Make the following selections in the Sort Layout window.

• Precision = Single cell (recommended setting)
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• Target events = 1

• Index sorting checkbox = Selected

Make the other selections in the Sort Layout window according to your 
experiment requirements.

6 Click the Sort button in the Sort Layout window to start the sort.

You must be acquiring sample to start a sort. A new tube is automatically 
added to the experiment. Upon completion, the new tube will contain the 
index sort data.

7 When the sort is finished, right-click the new tube in the experiment and 
select Index Sorting Analysis.

The Index Sorting Analysis displays, as shown in Figure 5-12 on page 201.
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Figure 5-12  Index Sorting Analysis window

The color legend for the wells is shown in the following table.

8 Select a well in the Index Sort Analysis to see the event sorted into that well 
displayed in a plot.

After selecting an individual well, the other wells in the Index Sort Analysis 
turn to gray, indicating that they contain data, but are not being displayed.

Color Indication

Black Sorted well data is showing in the plots

Gray Sorted well data is available, but not showing in the plots

White No sorted events

Red More than one event sorted into a well
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You can select multiple wells by Shift+clicking or Ctrl+clicking. You can 
also drag over multiple wells in the Index Sort Analysis to display multiple 
wells.

9 To increase the size of a dot on a plot for better visibility, open the 
population hierarchy, select a population, navigate to the Population 
Inspector, and select a larger size. 

10 To see the statistics for an index sort, right-click a plot and select Create 
Statistics View.

11 To export the statistics for an index sort as a CSV file, right-click in the 
statistics view and select Export Index Sort Statistics.

12 In the dialog that opens, navigate to the location where you want to save 
the CSV file and click Save.



 Chapter 5: Sorting 203

Terasaki Plate Adapter

A Terasaki plate adapter is available as an option to enable the use of 60-well and 
72-well Terasaki plates with the ACDU. A Terasaki plate is installed into the 
adapter, and then the plate/adapter assembly is loaded onto the ACDU. 

Using the Adapter

The adapter has three set screws that enable the fit to be adjusted for the plates. 

1 Install a Terasaki plate into the adapter with the A10 or A12 well at the 
bottom left corner of the adapter.

2 Tighten the set screws so the plate is held firmly and does not move within 
the adapter, but do not over-tighten because you need to be able to remove 
plates easily.

The set screws should not have to be adjusted after the initial fitting 
process.

Terasaki plate adapter showing 
location of set screws

Terasaki plate in adapter installed 
on ACDU
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Using the Correct Device in the Sort Layout

During the sort layout setup process, you have to select the correct device in the 
Sort Layout window so the ACDU knows the layout and location of the wells on 
the Terasaki plate.

1 In the Sort Layout window, select the Device menu.

2 Navigate to the bottom of the list, then select the plate you are using 
(60-well or 72-well).

The sort layout displays with the correct number of rows and columns.
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6

Shutdown and Maintenance

The BD FACSAria Fusion cytometer is designed to require minimum 
maintenance. However, to preserve the reliability of the cytometer, you must 
regularly perform basic preventive maintenance procedures. This chapter 
explains the routine maintenance procedures you should follow to keep your 
cytometer in good condition.

Shutdown and maintenance procedures are presented as follows:

• Daily Shutdown on page 206

• Scheduled Maintenance on page 211

• Unscheduled Maintenance on page 230
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Daily Shutdown

In the BD FACSAria Fusion system, the recommended daily shutdown procedure 
is to run the Clean Flow Cell command with the closed-loop nozzle installed (see 
the next section). This procedure fills the flow cell with cleaning solution. This is 
normally sufficient to keep the flow cell clean and operating properly.

If the system is used to process many different sample types, or the system has 
problems with contamination, you can perform a more extensive cleaning by 
running the Fluidics Shutdown command. See Fluidics Shutdown (Weekly or As 
Needed) on page 207.

In addition to one of these procedures, you should also perform an external 
cleaning. See External Cleaning on page 210.

Cleaning the Flow Cell (Daily)

Use the Clean Flow Cell command to run a tube of DI water through the sample 
line and flow cell.

NOTE After the procedure is complete, the DI water remains in the flow cell 
until the stream is restarted.

To clean the flow cell:

1 Turn off the stream.

2 Remove the nozzle and install the integrated closed-loop nozzle. See 
Figure 6-1 on page 208.

If you are using a standard closed-loop nozzle, verify that there is an O-ring 
in the nozzle before installing it.

3 Select Cytometer > Cleaning Modes > Clean Flow Cell.

4 When prompted, install a tube containing approximately 3 mL of sterile, 
filtered DI water, then click OK.
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The cytometer loads the tube and fills the flow cell with the DI water.

5 Click OK when the completion dialog opens. 

6 Turn off the lasers using the laser buttons on the Laser Power Panel.

7 Turn off the cytometer main power.

8 Turn off the Temperature Control Option if it was used.

9 Exit BD FACSDiva software and shut down the computer.

10 Turn off the in-house air or the compressor.

11 Vent the air pressure from the sheath tank by pulling up on the vent ring.

12 Leave the BSC blower on and close the view screen by lowering the sash to 
the lowest (ready safe mode) position.

Fluidics Shutdown (Weekly or As Needed)

The Fluidics Shutdown command can be used to perform an extensive cleaning if 
the system is used to process many different sample types, or the system has 
problems with contamination. This procedure removes sheath fluid from the 
lines and fills them with 70% ethanol, and cleans the flow cell.

Preparing for Shutdown

1 Unload the sample tube, if one is loaded.

2 Turn off the stream.

3 Check the waste container and empty it if needed. 

See Emptying the Waste Container on page 132. 

4 Check the ethanol shutdown tank and refill it if needed. 
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See Refilling the Ethanol Shutdown Tank on page 129.

Running Fluidics Shutdown

1 Select Cytometer > Fluidics Shutdown. 

The Fluidics Shutdown dialog opens.

2 Remove the nozzle from the flow cell assembly and click Done.

3 Insert the integrated closed-loop nozzle into the flow cell assembly and 
click Done. See Figure 6-1. 

If you are using a standard closed-loop nozzle, verify that there is an O-ring 
in the nozzle before installing it.

Figure 6-1  Closed-loop nozzle installed in flow cell 

4 Connect the air and fluid lines to the stainless steel ethanol shutdown tank. 
See Figure 6-2.

a Disconnect the air line from the sheath tank and connect it to the air 
port on the ethanol shutdown tank.

b Disconnect the fluid line from the bottom side of the sheath filter and 
connect it to the ethanol filter on the ethanol shutdown tank. See 
Figure 6-2.

Remove the sheath filter and replace with the ethanol filter. Do not run 
ethanol through the sheath filter.

c Click Done.
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The system starts the cleaning process, and then displays a message at the 
bottom of the dialog.

Figure 6-2  Connecting air and fluid lines for shutdown procedure 

5 When prompted, install a tube containing 3 mL of sterile, filtered DI water 
on the loading port, then click Done.

The cytometer loads the tube and continues the cleaning process. A 
progress message is displayed, and then Done is displayed when the process 
is complete.

6 Click OK when you see a message informing you that the system can be 
turned off.

7 Turn off the in-house air or the compressor.

Disconnect 
here

Air line

Fluid line

Ethanol shutdown tank

Side viewTop view

Ethanol
filter

To tank
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8 Vent the air pressure from the sheath tank by pulling up on the ring on the 
pressure relief valve.

9 Turn off the lasers by pressing the lighted buttons on the Laser Power 
Panel.

10 Turn off the cytometer main power. 

11 Turn off the Temperature Control Option if it was used.

12 Exit BD FACSDiva software and shut down the computer.

13 Leave the BSC blower on and close the view screen by lowering the sash to 
the lowest (ready safe mode) position.

External Cleaning

To keep the system free from salt buildup, wipe down all cytometer surfaces that 
have been exposed to sheath fluid. Clean surfaces with a cloth dampened with a 
10% bleach solution, followed by DI water.

The following surfaces should be inspected and cleaned when necessary:

• Inside the sort chamber

• Deflection plates

• Sample loading port

• Collection devices

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing, eyewear, and gloves.

To prevent shock, turn off the plate voltage before cleaning on or around 
the deflection plates. To prevent arcing (sparking), make sure the plates are 
completely dry before you turn the plate voltage back on.
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Scheduled Maintenance

For optimal cytometer functioning, perform the following procedures according 
to the recommended maintenance schedule.

Table 6-1  Scheduled Maintenance

Procedure Recommended Frequency

Internal Cleaning on page 212 See Table 6-2 on page 212

Purging the Fluid Filters on page 217 Weekly

Purging the Sheath Filter on page 218 Weekly

Changing the disposable waste cap (see Emptying 
the Waste Container on page 132)

Monthly

Changing the Fluid Filters on page 218 Every 6 months

Changing the Sheath/Ethanol Filter on page 219 Every 6 months

Changing the Sample Lines on page 221 Every 4–6 months, or as needed

Changing the Air Filter on page 229 Every 6–12 months, depending 
on cytometer use and the quality 
of the air

Changing the Sheath Tank Air Filter on page 229 Every 6 months
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Internal Cleaning

BD FACSDiva software includes four pre-programmed cleaning modes that can 
be used alone or in combination to provide the required level of cleaning. The 
following sections describe the different cleaning modes. See Table 6-2 for an 
overview of each mode. 

Sample Line Backflush

After a sample tube is unloaded, the sample line tubing within the sample 
injection chamber is automatically flushed inside and out with sheath fluid to 
eliminate potential sample carryover. Use the Sample Line Backflush command to 
perform additional backflushing of the inside of the sample line after a tube is 
unloaded. Perform the sample line backflush when you observe sample carryover 
or after running samples with adherent cells or dye.

NOTE Keep the stream running while performing the backflush.

1 Select Cytometer > Cleaning Modes > Sample Line Backflush.

2 Click Start to start the backflush.

Table 6-2  Cytometer cleaning modes

Cleaning Mode Summary Frequency

Sample Line Backflush on 
page 212

Flushes the sample line with 
sheath fluid.

After running samples with 
adherent cells or dye.

Cleaning the Flow Cell 
(Daily) on page 206

Cleans the sample path and 
the flow cell with DI water.

When indicated by 
distorted scatter or high 
CVs, or as a daily 
shutdown procedure.

Prime After Tank Refill on 
page 213

Primes the fluid lines for the 
designated fluid(s).

When a fluidics line is 
unplugged to refill a tank.

Prepare for Aseptic Sort 
on page 215

Decontaminates the complete 
sheath path and sample path 
with bleach, DI water, and 
ethanol.

When needed before 
aseptic sorting.
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3 Click Stop to stop the backflush, or click Cancel to stop the backflush and 
close the dialog.

The backflush does not stop automatically.

Prime After Tank Refill

Use the Prime After Tank Refill command to prime the fluid lines if a 5-L plastic 
fluidics container was disconnected for refilling.

1 Turn off the stream.

2 Select Cytometer > Cleaning Modes > Prime After Tank Refill.

3 Select the checkboxes for the tanks that were refilled, then click OK.

The cytometer proceeds with priming the specified tanks. A progress dialog 
opens while the tanks are being primed.

4 Click OK when the tank prime is complete.

Removing the Sheath Probe 

The sheath probe must be removed from the sheath tank before autoclaving the 
tank in preparation for performing the aseptic sort procedure.

NOTE Do not autoclave the sheath probe. It is not designed to withstand the 
conditions of autoclaving.

Make sure to perform the following steps in sequence, so the containment device 
works properly.

1 Disconnect the air line from the sheath tank.

2 Vent the air pressure from the sheath tank by pulling up on the pressure 
relief valve. Verify that all of the pressure is released by pulling up a second 
time.

3 Loosen the nut at the top of the probe with a wrench (Figure 6-3).
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Figure 6-3  Sheath probe containment device 

4 Loosen the thumbscrew on the containment device.

5 Pull the top section of the containment device straight up and out of the 
bottom section. See Figure 6-4.

Figure 6-4  Removing sheath probe

6 Finish loosening the 11/16-inch nut at the top of the probe and pull the 
probe straight up and out of the sheath tank.

7 Decontaminate the sheath probe using 70% ethanol. See Figure 6-5.

Figure 6-5  Sheath probe

Sheath probe

Containment 
device

Thumbscrew

Pressure relief valve

11/16-inch nut

Top section of 
containment 
device
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Prepare for Aseptic Sort

Use the Prepare for Aseptic Sort command when you want to decontaminate the 
entire sheath path. This procedure cleans the system with bleach, DI water, and 
ethanol. 

Perform the following steps before starting the Prepare for Aseptic Sort 
command:

1 Verify that the pressure has been vented from the sheath tank and the 
sheath probe has been removed. See the preceding section.

2 Disconnect the fluid and air lines from the sheath tank.

3 Empty the sheath tank and rinse it with DI water.

4 Autoclave the sheath tank at 125°C and 15 psig for 30 minutes with a 7.5-
minute warmup and shutdown cycle.

5 Fill the sterilized sheath tank with sterile sheath fluid.

6 Obtain a new sheath filter to replace the old filter when instructed to do so 
in the wizard. See Changing the Sheath Filter on page 221. 

7 Install the decontaminated sheath probe into the sheath tank and tighten 
the nut securely with a wrench.

8 Install the top section of the containment device into the bottom section, 
and then tighten the thumbscrew.

9 Sterilize the DI water sensor by soaking in a 10% bleach solution for 10 
minutes.

10 Fill the DI water container with sterile DI water and 3 mL of bleach per 
liter of DI water, and then reinstall the sterilized DI water sensor.

To run the Prepare for Aseptic Sort command:

1 Select Cytometer > Cleaning Modes > Prepare for Aseptic Sort.
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Follow the instructions on screen as you perform the procedure.

2 Install the integrated closed-loop nozzle in the flow cell and click Done.

If you are using a standard closed-loop nozzle, verify that there is an O-ring 
in the nozzle before installing it.

3 Remove the fluid line from the DI water port, connect the fluid line from 
the bleach/BD FACSClean container to the DI water port, then click Done. 
See Figure 6-6.

Do not disconnect the sensors from either container.

Figure 6-6  Moving the bleach/BD FACSClean fluid line 

4 Disconnect the bleach/BD FACSClean fluid line from the DI water port, 
and connect it back to the bleach container port, then reconnect the DI 
fluid line to the DI water port, and click Done.

5 Disconnect the sheath fluid line from the sheath filter (at the output side) 
and connect it to the fluid out port on the connectors panel on the side of 
the fluidics drawer (see Figure 6-7). Click Done.

The system cleaning takes approximately 20 minutes.

Bleach/BD FACSClean tank DI water tank

Fluid line from DI water port

Fluid line from bleach/
BD FACSClean container
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Figure 6-7  Moving the sheath fluid line 

6 Disconnect the fluid line from the fluid out port on the side of the fluidics 
drawer and connect it to a new 0.2-µm sheath filter. See Changing the 
Sheath Filter on page 221.

7 Remove the old sheath filter and connect the new 0.2-µm sheath filter to 
the liquid port of the sterilized sheath tank.

8 Reconnect the fluid and air lines to the sheath tank.

9 To complete the process, select one of the two options.

• To continue running samples, perform fluidics startup.

• To turn off the system, perform the flow cell cleaning procedure.

Purging the Fluid Filters

Once a week, purge air from the fluid filters for the 5-L plastic containers by 
opening the bleeder valve on the top of each filter. This ensures that the filters 
will not dry out.

1 Open the bleeder valve a small amount and leave it open until fluid seeps 
out through the valve (see Figure 6-8 on page 218).

Tip If the fluid does not seep, close the valve, prime the fluid lines, and 
try again. It might take a few minutes for the air to purge.

2 Close the valve.

3 Wipe up any excess fluid that might have dripped into the fluidics drawer.

Fluid out port
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Purging the Sheath Filter

Once a week, purge air from the sheath filter by opening the bleeder valve on the 
top of the filter. The sheath tank is pressurized, so do this task carefully to avoid 
spraying sheath fluid on any equipment. 

1 Place a small container under the bleeder valve to catch any fluid.

2 Slowly open the bleeder valve a small amount and leave it open until fluid 
seeps out through the valve (see Figure 6-9 on page 221).

3 Close the valve.

4 Wipe up any excess fluid that might have dripped into the fluidics drawer.

Changing the Fluid Filters

We recommend changing the fluid filters every six months. Spare filters are 
included with the accessory kit. 

Figure 6-8  Fluid filters

1 Remove the filter by pressing the tabs on each quick-disconnect coupling. 
(See Figure 6-8.)

2 Install the new filter with the flow arrow point down and connect the 
quick-disconnect couplings (Figure 6-8).

Flow arrow

Quick-disconnect



 Chapter 6: Shutdown and Maintenance 219

3 Write the current date on the new filter so you will know when to replace 
it.

4 Open the bleeder valve on top of the filter a small amount and leave it open 
until fluid seeps out through the valve.

5 Close the valve.

6 Wipe up any excess fluid that might have dripped into the fluidics drawer.

Changing the Sheath/Ethanol Filter

Introduction

The sheath/ethanol filter can be used to filter either sheath fluid or ethanol fluid. 
You need to change the filter depending on the procedure you are doing and the 
indications in the software.

About this task

NOTE Before it is installed, a fluid filter can be used as a sheath filter, or an 
ethanol filter. After the filter is installed for one of these purposes, however, you 
cannot use it for a different purpose. Because of this, you should label each filter 
so that you know which one to use for each purpose.

When you use the filter as a sheath filter, you should change it every six months, 
or when increased debris in an FSC vs SSC plot indicates that the sheath filter 
needs to be replaced.

Spare filters are included with the accessory kit.

Procedure

To change the sheath/ethanol filter:

1 Turn off the stream.
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2 Disconnect the air line from the sheath tank.

3 Pull up on the ring of the pressure relief valve to release the pressure from 
the tank. Verify that all of the pressure is released by pulling up a second 
time.

4 Disconnect the filter by the pressing the metal tabs on each end.

5 Write the current date on the filter so that you will know when to replace 
it.

6 Use the arrows on the filters that indicate the direction of the flow through 
the filter; replace the filter with a new one in the same orientation.

7 Reconnect the air line and check for leaks when the pressure is turned on.

 No.  Description

 1  Tabs

To instrument

To tank

D
irection of flow



 Chapter 6: Shutdown and Maintenance 221

Changing the Sample Lines

The primary sample line between the sample injection chamber and the pinch 
valve should be changed every 4–6 months or when decreased event rates 
indicate that the sample line might be clogged. The secondary sample line 
between the pinch valve and the cuvette flow cell needs changing only when it is 
kinked or clogged.

Figure 6-9  Primary and secondary sample lines

To withstand the high pressures generated by the BD FACSAria Fusion flow 
cytometer, the sample lines are attached using a two-piece compression fitting, in 
which a cone-shaped ferrule is compressed onto the tubing as the connecting nut 
is tightened. 

To replace the tubing, you will need a 12-inch length of replacement tubing for 
the primary sample line, or a 7-inch length for the secondary line. Replacement 
tubing is supplied in the accessory kit. The ferrules and connecting nuts can be 
reused when the tubing is replaced.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle used tubing and fittings as if 
capable of transmitting infection. Wear suitable protective clothing, 
eyewear, and gloves. 

Primary 
sample line

Secondary
 sample line

Connecting nut

Sample injection 
chamber

Connecting
nut

Flow cell
assembly
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Changing the Primary Sample Line

To replace the primary sample line, you will need a 12-inch length of replacement 
tubing from the accessory kit. There is a different fitting at each end of the 
tubing, so the procedure is divided into two sections. 

Assembling the Collet Fitting at the Pinch Valve

At the pinch valve end of the primary sample line, a collet fitting joins the sample 
line to the pinch valve tubing. 

To replace the tubing:

1 Turn the stream off (if needed). Make sure the loading port is in the unload 
position.

2 Unscrew the nut from the collet fitting and pull the nut and collet apart.

3 Pull the pinch valve tubing out of the nut, and then pull the sample line out 
of the pinch valve tubing. See Figure 6-10.

4 Locate a new 12-inch piece of sample line tubing.

a Slide the collet over the pinch valve tubing, then slide the nut over the 
new sample line tubing.

Figure 6-10  Collet nut fitting on pinch valve tubing

Collet Nut

Sample line 
tubing

6 mm

Pinch valve 
tubing
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b Slide the pinch valve tubing over one end of the sample line tubing until 
approximately 6 mm of the sample line is inside the pinch valve tubing.

c Slide the pinch valve tubing on the inside of the teeth of the nut until it 
stops.

d Couple both pieces of the fitting together and then tighten until finger-
tight.

Primary Sample Line – Sample Injection End

At the sample injection end of the primary sample line, a compression fitting 
secures the sample line at the top of the sample injection chamber. 

Figure 6-11  Primary sample line insertion

1 Turn the stream off (if needed). Make sure the loading port is in the unload 
position.

Ensure that the pinch valve tubing is inserted inside the teeth of the nut. 
Failure to do so can cause the bubble detector to malfunction.

Ferrule

Sample injection 
chamber

Nut

Primary sample 
line
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2 If there is a sample line filter installed, remove it by pulling it off the sample 
line.

To gain access to the filter, see Installing or Removing a Sample Line Filter 
on page 239.

3 Unscrew the connecting nut at the top of the sample injection chamber and 
slowly pull out the sample line. (See Figure 6-9 on page 221.) 

4 Ensure that a cone-shaped ferrule is attached to the sample line.

Figure 6-11 shows an example of a ferrule. If the ferrule was left behind in 
the injection chamber fitting, gently push the tip of the ferrule-removal tool 
(included in a small vial inside the accessory kit) into the top of the ferrule 
and pull the ferrule straight out. See Figure 6-12.

After using the tool, you might need to replace the ferrule. If the ferrule is 
damaged, replace it with a spare (included in the accessory kit).

Figure 6-12  Ferrule tool

5 Slide the ferrule and nut off the end of the sample line.

6 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 5 inches (12.7 cm) of tubing extending out of the 
sample injection chamber end. (This length can be adjusted depending on 
the depth of your sample tube.) This length is referred to as the pilot, as 
shown in Figure 6-13.
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Figure 6-13  Components of a compression fitting 

7 Insert the pilot tubing into its fitting, ensuring that the tubing reaches the 
intended pilot depth.

Insert the sample line into the sample injection chamber fitting. Push the 
tubing from the top until it is slightly above the bottom of the chamber 
viewing window. Finger-tighten the nut on top of the chamber so the 
sample line is secure. 

8 Check the fitting connections at both ends to make sure they are not 
leaking.

Turn on the stream, load a tube of DI water, and make sure none of the 
fittings are leaking. If needed, unload the tube, turn off the stream, and 
tighten the fittings. After tightening, if leaking still occurs, replace the 
ferrule. 

9 Verify the length of the sample line.

Do not to bend the primary sample line during insertion.

Do not overtighten the nut and do not use tools. Over-tightening the nut 
can kink or damage the tubing.

Make sure all fittings are securely tightened. If any fitting is loose, the 
tubing could detach during high-pressure operation, exposing the 
operator to potentially biohazardous sample spray.

External view Internal view

Ferrule

Tubing Pilot 
length

Pilot depth

Ferrule Pilot length

Tubing
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The sample line should not bow or bend when a tube is loaded. If you need 
to adjust the length, unscrew the nut on top of the sample injection 
chamber, adjust the length, and tighten the nut again. 

See Installing or Removing a Sample Line Filter on page 239 for detailed 
instructions on verifying sample line length. Disregard any steps that do not 
apply.

Changing the Secondary Sample Line

This section describes changing the secondary sample line (see Figure 6-9 on 
page 221). There is a different fitting at each end of the tubing, so the procedure 
is divided into two sections. 

Pinch Valve End

The procedure to replace the secondary sample line at the pinch valve end is the 
same as for the primary sample line, except the replacement line is a 7-inch 
length. See Assembling the Collet Fitting at the Pinch Valve on page 222.

Flow Cell End

1 Turn the stream off. 

2 Unscrew the connecting nut at the top of the flow cell and slowly pull out 
the sample line. (See Figure 6-14.) 
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Figure 6-14  Secondary sample line insertion

3 Ensure that a cone-shaped ferrule is attached to the sample line.

If the ferrule was left behind in the flow cell fitting, gently push the tip of 
the ferrule-removal tool (included in the accessory kit) into the top of the 
ferrule and pull the ferrule straight out. 

After using the tool, you might need to replace the ferrule. If the ferrule is 
damaged, replace it with a spare (included in the accessory kit).

4 Slide the ferrule and nut off the end of the sample line.

5 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 0.1 inch (0.25 cm) of tubing extending out of the 
ferrule. This length is referred to as the pilot, as shown in Figure 6-13 on 
page 225.

6 Insert the pilot tubing into its fitting at the top of the flow cell, ensuring 
that the tubing reaches the intended pilot depth.

Within the cuvette flow cell fitting, make sure the pilot is seated flush 
against the pilot depth. Dead volume between the pilot and the pilot depth 
can lead to sample carryover or leaking.

Nut

Secondary sample line

Ferrule

Flow cell
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7 Finger-tighten the nut at the top of the flow cell to secure the sample line. 

8 Check the fitting connections at both ends to make sure they are not 
leaking.

Turn on the stream, load a tube of DI water, and make sure none of the 
fittings are leaking. If needed, unload the tube, turn off the stream, and 
tighten the fittings. After tightening, if leaking still occurs, replace the 
ferrule. 

Do not overtighten the nut and do not use tools. Over-tightening the nut 
can kink or damage the tubing.

Make sure all fittings are securely tightened. If any fitting is loose, the 
tubing could detach during high-pressure operation, exposing the 
operator to potentially biohazardous sample spray.
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Changing the Air Filter

The BD FACSAria Fusion cytometer has an air filter in the sort collection 
chamber door.

To change the filter in the sort collection chamber door, slide out the old filter 
and slide in the new filter. See Replacing the Air Filter on page 317 for more 
information.

Changing the Sheath Tank Air Filter

Check the inline air filter on the sheath tank air line periodically for any signs of 
debris or discoloration. Replace with a new air filter from the accessory kit every 
six months, or sooner if needed. 

Sort collection chamber door

Air filter
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Figure 6-15  Inline air filter for sheath tank

1 Turn off the cytometer.

2 Pull the tubing off each end of the air filter.

3 Install a new filter with the directional arrow pointing toward the sheath 
tank.

Unscheduled Maintenance

There are several cytometer components that should be cleaned periodically or 
checked for wear and replaced if necessary. See the indicated sections for the 
following maintenance procedures.

Table 6-3  Unscheduled maintenance

Procedure Recommended Frequency

Changing the Integrated Nozzle on page 231 As needed for different sized particles

Cleaning the Integrated Nozzle on page 233 When stream irregularities indicate 
that the nozzle is clogged

Temporary Replacement of a Seal on page 236 As needed when seal is lost or 
damaged in an integrated nozzle

Closed-Loop Nozzle Maintenance on page 237 As needed

Sheath tank inline 
air filter
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Changing the Integrated Nozzle

Three sizes of nozzles are provided with your cytometer: 70, 85, and 100 µm. A 
130-µm nozzle can be ordered as an option. The size is marked on the nozzle. 
The closed-loop nozzle used for cleaning and shutdown procedures is also 
changed with this procedure. 

1 Turn off the stream and open the flow cell access door.

2 Turn the nozzle-locking lever counterclockwise to the 9:00 position, and 
pull the nozzle out of the cuvette flow cell (Figure 6-16).

Installing or Removing a Sample Line Filter on 
page 239

When the sample line filter needs to be 
installed or changed

Changing the Pinch Valve Tubing on page 241 As needed

Cleaning the Camera Windows on page 244 When smudges appear in the Breakoff 
or Side Stream windows

Removing the Deflection Plates on page 247 As needed to clean the deflection plates

Lubricating the Sample Injection Chamber O-Ring on 
page 248

As needed when the O-ring is dry

Using Custom Optical Filters on page 249 As needed

Cleaning the Optical Filters on page 250 As needed when changing a filter

Removing or Installing the FSC ND Filter on page 251 As needed

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing, eyewear, and gloves. 

Table 6-3  Unscheduled maintenance

Procedure Recommended Frequency
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Figure 6-16  Nozzle-locking lever

3 Insert the new nozzle into the flow cell (with the top side facing up) and 
push it gently all the way forward until it stops.

4 Turn the nozzle-locking lever clockwise to the 12:00 position.

5 Turn on the stream and make sure it flows smoothly from the nozzle into 
the center of the waste aspirator. 

If the stream is flowing but the breakoff is too long or the gap is unsteady, 
this could indicate that there are bubbles in the flow cell. If these conditions 
occur, turn off the stream, wait for 10 seconds, and turn on the stream 
again.

If you see any dripping or spraying, or the stream image appears abnormal, 
turn off the stream and see Troubleshooting the Stream on page 254.

NOTE After changing the nozzle, you might need to adjust the angle of the sort 
block to re-center the stream in the aspirator. To do so, loosen the adjustment 
screws on both sides of the deflection plates and rotate the sort block (see 
Figure 1-11 on page 31). Tighten the screws when the stream is centered in the 
aspirator. For further assistance, see Troubleshooting the Stream on page 254.

Nozzle-locking 
lever in 12:00 position
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Cleaning the Integrated Nozzle

Use the following procedure to clean the nozzle when the stream appears blocked 
or distorted. To verify that the nozzle is clogged, examine the opening at the 
center of the seal area under a microscope. Figure 6-17 shows an example of an 
unclogged nozzle tip.

Figure 6-17  Magnified view of an integrated nozzle tip

To clean the integrated nozzle:

1 Remove the nozzle from the flow cell by turning the nozzle-locking lever 
counterclockwise to the 6:00 position, then pull the nozzle straight out. 

2 Sonicate the nozzle for approximately 1 minute in a test tube containing DI 
water. Repeat the sonication until the nozzle is clean. 

3 Allow the nozzle to air dry for a few minutes. Do not wipe the nozzle with 
anything, because it could leave fibers or other contamination.

4 Insert the nozzle into the flow cell with top side facing up and push it gently 
forward until it stops.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle nozzles as if capable of 
transmitting infection. Wear suitable protective clothing, eyewear, and 
gloves.

Do not use bleach, Contrad®, or any strong detergents to clean the nozzle. 
See Table 6-1 on page 211.

Seal in 
integrated nozzle
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5 Turn the nozzle-locking lever clockwise to the 12:00 position.

6 Turn on the stream and make sure it flows through the nozzle properly.

Note that after re-installing the nozzle, you might need to change the angle of the 
sort block to re-center the stream in the aspirator. To do so, loosen the 
adjustment screws on both sides of the deflection plates and rotate the sort block 
(see Figure 1-11 on page 31). Tighten the screws when the stream is centered in 
the aspirator. For further assistance, see Troubleshooting the Stream on 
page 254.

Flow cell

Nozzle

Nozzle-locking
lever
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Handling the Integrated Nozzle

In addition to following proper cleaning instructions, follow these precautions 
when handling the integrated nozzles. 

Precaution Result

Always use the integrated closed-loop 
nozzle for cleaning and shutdown 
procedures.

Keeps the flow cell clean and reduces the 
chances for clogs. A clean flow cell 
provides improved sensitivity and higher 
performance.

Do not expose integrated nozzles for long 
periods of time to bleach or detergents. 
However, you can prepare for the aseptic 
sort procedure without causing any 
problems to the O-ring in the integrated 
nozzle.

Prevents the seal from coming loose and 
falling out.

Do not expose integrated nozzles to strong 
base solutions such as Contrad 70.

Prevents the seal from coming loose and 
falling out. Any contact with such 
solutions might damage the seal.

Do not wipe the surface of the seal with 
anything.

Prevents damage to the seal that could 
result in leaking.
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Temporary Replacement of a Seal

The standard O-ring can be used as a short-term replacement in the integrated 
nozzle, if the original seal has been lost or damaged, but a new integrated nozzle 
will provide better long-term usability. See Accessory Kit on page 278 for part 
numbers for ordering integrated nozzles. 

Standard O-rings (part number 333084) are supplied in the accessory kit. The 
following procedure describes how to install a standard O-ring in an integrated 
nozzle.

1 Make sure the groove in the nozzle is clean. 

If the any part of the seal is still in the nozzle groove, sonicate the nozzle in 
a bleach solution until the seal comes out. Rinse the nozzle in DI water 
after sonicating.

2 Use the wooden end of a cotton swab, or similar tool, to install the O-ring 
in the nozzle groove, then allow the nozzle to air dry for a few minutes. 

Do not wipe the nozzle with anything, because it could leave fibers or other 
contamination, or dislodge the O-ring.

3 Use the magnifier in the accessory kit, or a microscope, to inspect the 
nozzle to verify that the O-ring is installed all the way into in the groove.
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Closed-Loop Nozzle Maintenance

The closed-loop nozzle and related tubing should be cleaned if there are any 
indications of clogging or kinked tubing.

Cleaning the Integrated Closed-Loop Nozzle 

1 Turn off the stream and open the flow cell access door.

2 Remove the closed-loop nozzle from the cuvette flow cell. 

Turn the nozzle-locking lever counterclockwise to the 6:00 position. 
Remove the nozzle by pulling it straight out. See Figure 6-18.

Figure 6-18  Closed-loop nozzle

3 Unscrew the nut on the side of the nozzle to remove the tubing.

Make sure that the ferrule stays on the tubing as you remove it.

4 Sonicate the nozzle for approximately 1 minute.

Sonicate the nozzle in a test tube containing DI water or a mild detergent. 
Repeat the sonication as needed until the nozzle is clean.

5 Make sure that the ferrule is on the tubing, then screw the nut back into the 
hole in the side of the closed-loop nozzle. See Figure 6-19.
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Replacing the Tubing on the Closed-Loop Nozzle 

To replace the tubing on the closed-loop nozzle, use this procedure. Use a 7-inch 
length of sample tubing from the accessory kit as the replacement.

Figure 6-19  Replacing tubing from closed-loop nozzle

To replace the tubing:

1 Unscrew the nut from the closed-loop nozzle and from the union fitting and 
pull out the tubing from both places.

Make sure that the ferrule comes out on the tubing on both ends. If not, use 
the ferrule tool to remove it. See Figure 6-12 on page 224. 

2 Slide the nut and ferrule off each end of the tubing.

3 Slide the nut and ferrule onto the new tubing as shown in Figure 6-19.

Insert the tubing into the closed-loop nozzle and slowly tighten the nut 
until secure. Do not over-tighten. Make sure that the tubing is pushed all 
the way in while tightening the nut.

4 Insert the tubing into the union fitting and slowly tighten the nut until 
secure. Do not over-tighten. Pull gently on the tubing to ensure that it is 
secure.

Closed-loop 
nozzle

Ferrule Nut Tubing (7-inch length) 

Union fitting
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Installing or Removing a Sample Line Filter

Sample filters can be installed on the end of the sample line to filter out large 
particles from a sample. Pre-filtering the sample before beginning any sorting is 
recommended.

Two sizes of sample line filters are included in the accessories kit: 35 micron 
(green) and 50 micron (blue). The filters can be changed as often as required. The 
sample filters are not intended for use with the 1-mL microtubes.

NOTE When a sample filter is installed, the sample flow rate can be slowed 
down due to the effect of particles in the sample fluid clogging the filter.

1 With the stream turned on, select Change Sample Filter from the Cytometer 
menu.

2 A wizard opens with the instructions. See Figure 6-20.

Figure 6-20  Sample line filter wizard

3 Loosen the sample line fitting nut at the top of the injection chamber to 
allow the sample line to slide freely through the fitting. See Figure 6-21.
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Figure 6-21  Loosen nut to move sample line 

4 Push the sample line down so the end is below the bottom of the sample 
injection chamber.

Figure 6-22  Sample line filter installed 

5 Install the sample line filter by sliding it onto the end of the line, then click 
Done. See Figure 6-22.

Do not bend the sample line while installing the filter.

6 Pull the sample line up to operation height, slightly above the chamber 
viewing window.

Sample injection 
chamber

Nut

Sample line

Sample line 
filter
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7 Place a tube onto the loading port. 

8 Click Done to raise the sample injection chamber. 

The sample line should not bow or bend when a tube is loaded.

9 Adjust the sample line height if needed.

10 Tighten the sample line fitting and click Done. 

The bulk injection chamber is lowered and the sample purge mode is 
turned on for about 5 seconds until several drips exit the filter. A message is 
displayed at the bottom of the wizard.

11 Click Done to complete the process.

Changing the Pinch Valve Tubing

The tubing that runs through the bubble detector and the pinch valve should be 
changed as needed. The system ships with replacement tubing cut into 3-inch 
lengths, found in the accessory kit.

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. Keep your hands and clothing away from the loading 
port when a tube is loading or unloading. Do not place objects underneath 
the loading port.

Be careful of a pinching hazard as the sample injection chamber is raised.
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Figure 6-23  Pinch valve tubing

To replace the tubing: 

1 Turn off the stream. Make sure the loading port is in the unload position.

2 Pull the existing pinch valve tubing out of the slot in the pinch valve and 
the bubble detector.

Grasp the tubing with two fingers next to the pinch valve and two fingers 
next to the bubble detector. Pull the tubing straight out from the slots. The 
tubing pops out with a small amount of pulling action. See Figure 6-24.

Figure 6-24  Removing tubing from bubble detector and pinch valve

3 Unscrew the nut on the black collet fitting at each end of the tubing, and 
pull the pinch valve tubing out of both fittings.

Pinch valve

Bubble detector

Pinch valve collet fittings

Pinch valve tubing

Sample line tubing
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Leave both pieces of the fitting on the sample line tubing.

4 Install a new 3-inch piece of pinch valve tubing. See Figure 6-25 on 
page 243.

a Slip the collet over one end of the new pinch valve tubing.

b Slide the pinch valve tubing over the sample line tubing until 
approximately 6 mm of the sample line is inside the pinch valve tubing.

c Slide the pinch valve tubing on the inside of the teeth of the nut until it 
stops.

d Couple both pieces of the fitting together and then tighten until finger-
tight.

e Repeat steps a through d at the other end of the tubing.

f Check to see that both ends of the new pinch valve tubing are held 
securely in the compression fittings.

Figure 6-25  Collet nut fitting on pinch valve tubing 

5 Install the new pinch valve tubing into the slots in the pinch valve and 
bubble detector.

Make sure that the tubing goes all the way into the back of each slot. The 
sample line can drip if the pinch valve tubing is not all the way into the slot 
in the pinch valve and the bubble detector.

Collet Nut

Sample line 
tubing

6 mm

Pinch valve 
tubing
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Cleaning the Camera Windows

Lower Camera Window

Clean the lower camera window and the diode laser window when you have 
trouble viewing the side streams or you cannot set the drop delay using 
Accudrop. 

To clean the lower camera window and the diode laser window:

1 Ensure that the deflection plates are turned off (warning light is not 
illuminated).

2 Turn off the stream.

3 Open the sort block door. 

4 Wipe the windows with a soft, lint-free cloth soaked with DI water, and 
then dry the windows (see Figure 6-26 on page 245).

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the plate voltage is on. The plates 
remain energized even when the sort block door is open.
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Figure 6-26  Lower camera and diode laser windows

Upper Camera Window

Clean the strobe lens and upper camera window when smudges appear in the 
processed (digitized) image in the Breakoff window, or when dark spots appear 
to interfere with Sweet Spot monitoring. You might need to clean these 
components after a clog, or after sheath fluid has leaked or sprayed. Follow the 
steps in this section to clean the strobe lens and upper camera window. 

To clean the strobe lens and upper camera window:

1 Ensure that the deflection plates are turned off (warning light is not 
illuminated).

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the plate voltage is on. The plates 
remain energized even when the sort block door is open.

Diode laser window

Lower camera window
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2 Turn off the stream.

3 Open the sort block door. 

4 Place 1–2 drops of DI water or ethanol on a cotton swab.

5 Click the Breakoff window and select Raw Image.

Visible smudges are more apparent in the raw image view.

6 While viewing the image in the Breakoff window, insert the swab just 
below the bottom of the flow cell.

The strobe lens and upper camera windows are located behind two circular 
openings on either side of the top of the sort chamber. You will see the end 
of the swab in the Breakoff window when you intercept either opening. 

7 Gently wipe the upper camera window, and then the strobe lens (opposite 
the window) to remove any saline.

Upper 
camera 
window

Strobe lens 
window
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8 Repeat with isopropyl alcohol or 70% ethanol until clean.

Removing the Deflection Plates

You can remove the deflection plates for cleaning by pulling the plates out using 
the deflection plate removal tool, supplied in the accessory kit.

Figure 6-27  Deflection plate removal tool 

1 Make sure that the deflection plates are turned off.

2 Open the sort block door.

3 Slide the deflection plate removal tool behind one of the plates and pull 
straight out from the sort block.

Hold your thumb on the plate (or use your other hand) as you pull it out so 
it does not fall as you remove it.

Figure 6-28  Using the deflection plate removal tool



248 BD FACSAria Fusion User’s Guide   

Lubricating the Sample Injection Chamber O-Ring

The O-ring at the bottom of the sample injection chamber should be lubricated as 
needed to maintain proper operation.

1 Verify that the loading port is in the down position, and open the hinged 
cover.

2 Check the O-ring (located at the opening in the bottom of the chamber) to 
see if it is dry.

3 If the O-ring is dry, it must be lubricated with O-ring lubricant from the 
accessory kit.

a Remove the clear plastic tube holder from the tube holder base.

b Apply a small amount of O-ring lubricant to the outside beveled edge 
of the tube holder base. This is where the base contacts the O-ring 
inside the sample injection chamber.

c Wipe off any excess lubricant.

d Replace the tube holder on the base.

Figure 6-29  Sample injection chamber with tube holder removed

Outside beveled edge 
of tube holder base
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Using Custom Optical Filters

If you want to install a custom filter or dichroic, the filter should comply with the 
following specifications. 

For the longpass filters, the surface that faces the center of the octagon or trigon 
should be coated directly on its surface, not between two or more pieces of glass. 
The coating should transmit >70% of the wavelength range you want the filter to 
transmit, with a minimum transmission of >50%, and it should reflect >90% of 
the wavelength range you want the filter to reflect.

The opposite surface (facing away from the center) should be coated with an 
anti-reflective coating with a minimum reflection of ≤1% of the wavelength 
range you want the filter to reflect.

Note that filters must be installed in front of each PMT to block unwanted laser 
light. For the dichroic, carefully assemble the glass filter in the holder using the 
retaining spring. Assemble the filter with the arrow pointing toward the center of 
the octagon or trigon. The angle of the dichroic is critical to achieving optimal 
results.

Note that any time you modify a detector array, you will need to create a new 
cytometer configuration to identify which PMT (identified by laser color and 
letter) will detect the emitted light. See Custom Configurations on page 92 for 
instructions.

Table 6-4  BD FACSAria Fusion filter specifications

Filter Characteristic Dichroic LP Filters BP Filters

Diameter 0.622 ±0.003 in. 1.00 ±0.010 in.

Thickness 0.125 ±0.005 in. 0.12–0.35 in.

Minimum clear aperture 0.562 in. 0.85 in.

Incident angle 11 ±1° 0°
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Cleaning the Optical Filters

Optical filters should be inspected occasionally and cleaned as necessary. The 
frequency will depend on how often the filters are handled. 

1 Wrap a triangular section of the lens paper around the cotton end of a 
cotton swab. Moisten and seal the end with a few drops of alcohol.

2 Holding the cotton swab in a horizontal position, gently rub any spots on 
the filter surface and wipe clean.

3 Allow the solvent to evaporate and check the filter surface for streaks.

4 Inspect a ¼-inch–diameter section in the center of the filter for scratches.

Filters are coated with different dielectrics that can get scratched. If you see 
scratches, replace the filter.

5 Insert the cleaned filter into the octagon or trigon.

Make sure the filters are pushed all the way in. 

When cleaning or replacing a filter, handle with care to avoid scratching the 
surface and to prevent the filter from falling out of the holder. Use cotton 
swabs, optical lens paper, and spectral-grade methanol or absolute ethanol 
in a dropper bottle (do not use acetone) to clean the optical filters.
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Removing or Installing the FSC ND Filter

For applications involving large particles in which events appear off scale on the 
FSC axis with a voltage of zero, keep the FSC ND filter in place to decrease the 
FSC signal and keep the events on scale. For applications involving small 
particles (for example, bacteria or platelets), you might need to remove the FSC 
ND filter as follows.

1 Open the flow cell access door.

2 Locate and pull out the FSC ND filter (Figure 6-30).

The filter is installed at the left end of the FSC detector block, just to the 
right of the flow cell. To remove the filter, loosen the set screw and pull the 
filter out of the slot. 

Figure 6-30  Removing the FSC ND filter

3 To reinstall the filter, slide it into the slot with the filter side down and the 
label facing the flow cell. 

NOTE You can remove the nozzle holder to get better access to the ND 
filter slot.

Nozzle holder

FSC ND filter

Set screw
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7

Troubleshooting

The tips in this chapter are designed to help you troubleshoot your experiments. 
Additional troubleshooting information can be found in the BD FACSDiva 
Software Reference Manual.

If additional assistance is required, contact your local BD Biosciences technical 
support representative. See Technical Assistance on page xv.

Troubleshooting suggestions in this chapter are grouped under the following 
headings:

• Troubleshooting the Stream on page 254

• Troubleshooting the Breakoff on page 259

• Sorting Troubleshooting on page 260

• Acquisition Troubleshooting on page 265

• Fluidics Troubleshooting on page 272

• Electronics Troubleshooting on page 274
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Troubleshooting the Stream
Observation Possible Causes Recommended Solutions

Stream not in center 
of aspirator

Difference in keyed stream 
position between nozzles

If you have just changed the 
nozzle, use an Allen wrench to 
loosen the screws on either side of 
the sort block. Adjust the angle of 
the sort block until the stream 
flows into the center of the waste 
aspirator, and then tighten the 
screws. See Figure 1-11 on 
page 31.

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle and ensure that the seal or 
O-ring is in place. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Clogged or damaged nozzle Turn off the stream, remove the 
nozzle, and examine the nozzle tip 
under a microscope.

• If debris is visible, clean the 
nozzle. See Cleaning the 
Integrated Nozzle on page 233.

• If the nozzle appears damaged, 
replace it. See Changing the 
Integrated Nozzle on page 231.

Performance check failed Incorrect filters You may have the incorrect filters 
on the 445 array or the 375/405 
array.

• Put the proper filters into the 
445 array.

• Swap the filters for the 580/20 
array to run PE.

For information about laser 
configurations, see Laser Options 
on page 285.
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No stream or dripping 
stream

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle. See Changing the 
Integrated Nozzle on page 231 for 
instructions. 

Clogged or damaged nozzle Turn off the stream, remove the 
nozzle, and examine the nozzle tip 
under a microscope.

• If debris is visible, clean the 
nozzle. See Cleaning the 
Integrated Nozzle on page 233.

• If the nozzle appears damaged, 
replace it. See Changing the 
Integrated Nozzle on page 231.

Stream control disabled 
or no stream when 
stream control clicked

Air lock in fluidics filter Prime the system with the 
corresponding fluid. 

If the control is still disabled, 
remove the filter, install the bypass 
tubing, and repeat the priming 
procedure until you see fluid in 
the line.

When fluid is running through the 
line, remove the bypass tubing, 
install the filter, and repeat the 
priming procedure one last time.

Communication failure 
between workstation and 
cytometer

Exit the software and restart it.

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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No stream when Stream 
control clicked

Sheath tank low or empty Refill the sheath tank. See 
Refilling the Sheath Tank on 
page 127. 

Note that when the empty tank 
warning message is not closed 
after 15 minutes, the stream shuts 
off automatically. 

Air in sheath line Prime the sheath tank. See Prime 
After Tank Refill on page 213.

Air in sheath filter Purge the sheath filter. See Purging 
the Sheath Filter on page 218.

Dry filter Open the bleeder valve to purge 
the filter. See Purging the Fluid 
Filters on page 217.

Fanning around center 
stream

Nozzle inserted improperly Re-insert the nozzle. Push it gently 
all the way forward without 
rocking it from side to side.

House air or compressor is 
off (gauge reads zero)

Turn on house air or compressor.

Sheath tank lid not properly 
seated (gauge reads <80 psi)

Remove sheath tank lid, reseal 
properly.

Unstable stream Debris in flow cell or nozzle Remove the nozzle and run the 
stream with no nozzle in place for 
approximately 10 seconds. (Click 
the Stream control on, then off.) 
Sonicate the nozzle and re-install 
it.

Fluid line connected to 
ethanol shutdown tank

Move fluid and air lines to the 
sheath tank, then perform a 
fluidics startup. See Performing 
Fluidics Startup on page 119.

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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Leaking or spraying 
around nozzle

Defective or damaged 
integrated nozzle seal

Replace the defective seal with a 
standard O-ring. See Temporary 
Replacement of a Seal on 
page 236.

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle. See Changing the 
Integrated Nozzle on page 231 for 
instructions. 

Extra O-ring is blocking the 
nozzle

Remove the nozzle and use a 
cotton swab to clear out the 
cuvette.

Drop breakoff is too 
long

Bubbles in flow cell Open the flow cell access door 
and check for bubbles in the flow 
cell. If they are visible, turn off the 
stream, wait a few seconds, and 
turn on the stream again. 

Attenuation is on Turn off attenuation.

Amplitude is too low Increase the amplitude until you 
can see drops. If you need a very 
high amplitude (>70 volts) to see 
drops, there might be air bubbles 
in the flow cell.

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle and ensure that the seal or 
O-ring is in place. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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Problems using Auto 
Delay feature

Stream is not stable Make sure that the stream is stable 
before starting to run auto delay.

Diode laser does not fully 
intercept the sorting streams

Adjust the diode laser to intercept 
streams in the middle, producing 
the biggest and brightest spots in 
the left and center images.

Event rate is too low or too 
high

Adjust the flow rate to increase or 
decrease the event rate. 

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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Troubleshooting the Breakoff

Use the following examples to help troubleshoot problems with the breakoff 
image. 
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Normal stream 
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Nozzle 
inserted 
improperly

Nozzle inserted 
improperly or 
orifice is off 
center

Partial clog Wet or dirty 
strobe lens

Attenuation is 
on at wrong 
pressure

Re
co

m
m

en
de

d
So

lu
ti

on
s

Remove the 
nozzle and 
re-insert it.

Remove the 
nozzle and 
re-insert it.

Remove the 
nozzle, clean 
it, and then 
re-insert it.

Clean the lens 
as described in 
Cleaning the 
Camera 
Windows on 
page 244.

Turn off 
attenuation in 
the Side 
Stream 
window.
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Sorting Troubleshooting
Observation Possible Causes Recommended Solutions

Unstable breakoff while 
Sweet Spot is engaged

Residual ethanol in system Allow the system to run until the 
breakoff stabilizes.

Target Drop 1 value is out of 
range for drop spacing

Use an actual Drop 1 value for the 
target. Remember to repeat the 
drop delay setup each time the 
target value is changed.

Nozzle is clogged or inserted 
improperly

See Responding to a Nozzle Clog 
During a Sort with the AMO on 
page 310.

Dirty strobe lens or upper 
camera window

Clean the lens and the window as 
described in Cleaning the Camera 
Windows on page 244.

Air in sheath filter Purge the sheath filter. See Purging 
the Sheath Filter on page 218.

Debris in flow cell or nozzle Remove the nozzle and run the 
stream with no nozzle in place for 
approximately 10 seconds. (Click 
the Stream control on, and then 
off.) Sonicate the nozzle and 
re-install it.

Center stream image is 
dim or not visible in the 
Side Stream window

Camera window is dirty Clean the lower camera window. 
See Cleaning the Camera 
Windows on page 244.

Stream is not intercepting the 
diode laser 

Adjust the micrometer dial on the 
laser to make the stream intercept 
as bright as possible. See 
Figure 1-22 on page 42.

Center stream is off 
center when the plate 
voltage is turned on

Voltage center too low or too 
high

Adjust the Voltage Center slider to 
put the center stream back to 
center.

Saline spray on deflection 
plates or in sort block

Clean the deflection plates and the 
area around them. 
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Arcing between 
deflection plates

Salt bridge Clean and dry the deflection plates 
and the area around and behind 
the plates. 

ACDU sorting failure Insufficient stream voltage Increase the voltage for the far left 
stream.

Splash shield not installed Install the splash shield. See 
Installing the Sorting Hardware 
on page 192.

Side stream position 
reversal, where the 
streams appear to be 
associated with the 
wrong voltage slider.

Voltage sliders are set too far 
in or too far out.

Move sliders in or out so they 
control the correct side streams.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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No deflection or 
insufficient deflection

Insufficient voltage • Increase the side-stream 
voltages using the slider 
controls.

• Increase the plate voltage.

Stream-charging wire is loose 
or missing

Verify that the stream-charging 
wire is inserted all the way into 
the barb.

Salt bridge Turn off the stream. Remove the 
nozzle. See Changing the 
Integrated Nozzle on page 231 for 
instructions. 

Sorting paused because actual 
Drop 1 value is out of range

Wait until the Sweet Spot adjusts 
the amplitude to achieve the 
Drop 1 target. 

If this happens repeatedly during 
sorting, there might be debris in 
the nozzle or flow cell. See 
Troubleshooting the Stream on 
page 254 for suggestions.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions



 Chapter 7: Troubleshooting 263

Fanning around center 
or side streams

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle and ensure that the seal or 
O-ring is in place. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Sweet Spot is off Turn on the Sweet Spot.

Incorrect sort precision mode Verify that the sort precision mode 
is appropriate for your sorting 
requirements. See Sort Precision 
Modes on page 77.

2nd, 3rd, or 4th Drop values 
not optimized

Adjust the 2nd, 3rd, and 4th Drop 
settings to tighten the center 
stream and fine-tune the side 
streams.

Particles too big for nozzle Change the nozzle. See Changing 
the Integrated Nozzle on 
page 231.

Sort button disabled Current tube pointer not set 
to current tube

Click to move the current tube 
pointer to the appropriate tube.

Population not listed in 
Add menu on sort layout

Population defined using 
snap-to gate

Redefine the population using 
another gate type.

Viewing sort layout for 
another tube

Open or create a sort layout for 
the current acquisition tube.

Sort layout counters not 
updating

Viewing sort layout for 
another tube

Open or create a sort layout for 
the current acquisition tube.

High sort conflict rate Event rate is too high for 
drop drive frequency

Decrease the event rate.

Gating conflict Verify the gating hierarchy.

Purity mask is too high Decrease the purity mask.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Erratic sort rate Flow rate is too high Decrease the flow rate.

Unexpected sort results Incorrect drop delay Reset the drop delay. See 
Determining the Drop Delay – 
Automatic Method on page 181.

Incorrect sort precision mode Verify that the sort precision mode 
is appropriate for your sorting 
requirements. See Sort Precision 
Modes on page 77.

Sweet Spot is off Keep the Sweet Spot on during 
sorting.

Drop 1 changed after setting 
drop delay

Reset the drop delay each time 
you change the Drop 1 value. See 
Determining the Drop Delay – 
Automatic Method on page 181.

Laser delay changed after 
setting drop delay

Reset the drop delay each time 
you change the laser delay. See 
Determining the Drop Delay – 
Automatic Method on page 181.

Incorrect logic in population 
hierarchy

Verify the gating strategy.

Sorting parent and child 
populations into two 
different tubes

If you try to sort a parent and its 
child population into two tubes, 
BD FACSDiva software ignores 
the child events in both tubes.

Create a new subset under the 
parent population consisting of 
NOT (child). Sort the child 
population into one tube and the 
NOT (child) population into 
another tube.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Acquisition Troubleshooting
Observation Possible Causes Recommended Solutions

No events in plots after 
clicking Load or Acquire 
Data

Current tube pointer is not 
set to current tube

Click to move the current tube 
pointer to the appropriate tube.

Laser shutter is engaged Make sure the flow cell access 
door is completely closed.

Laser power is off Turn on the laser power.

Laser delay set incorrectly Adjust the laser-delay settings. See 
Manual Adjustment of Laser 
Delay on page 164.

Viewing plots for a different 
tube

Double-click the current tube in 
the Browser to display the plots 
for that tube.

Incorrect population(s) in 
plot

Right-click the plot and select 
Show Populations. Verify that the 
appropriate populations are 
displayed.

Uncolored events in plot • Format the plot to display all 
events.

• Assign a color to the population 
displayed in the plot.

• Verify the population drawing 
order.

Current cytometer 
configuration different from 
optical setup

Verify that the cytometer optics 
match the current cytometer 
configuration. 

No sample in the tube Add sample to the tube or install a 
new sample tube.
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No events in plots after 
clicking Acquire Data 
(continued)

Sample is not mixed properly Increase the sample agitation rate. 
See Sample Agitation on page 85.

Sample line is clogged Perform a sample line backflush. 
See Sample Line Backflush on 
page 212. If necessary, change the 
sample line. 

Sample filter is clogged Replace the sample filter.

Threshold not set to the 
correct parameter (usually 
FSC)

Set the threshold to the correct 
parameter for your application. 

Multiple threshold 
parameters not set correctly

Verify that the correct Boolean 
logic (And/Or) was used for the 
threshold parameters.

Threshold channel too low or 
too high

Adjust the threshold channel. See 
Calculating Compensation on 
page 152.

Optical filter(s) not 
completely seated

Make sure that the filters are 
pushed all the way in. 

FSC area scaling is incorrect Ensure that the FSC-A matches the 
FSC-H value.

No fluorescence signal Current cytometer 
configuration different from 
optical setup

Verify that the cytometer optics 
match the current cytometer 
configuration. 

Wrong filter installed or filter 
not completely seated

Make sure that the appropriate 
filter is installed for each 
fluorochrome. Make sure that the 
filters are pushed all the way in. 

Laser delay is set incorrectly Adjust the laser-delay settings. See 
Manual Adjustment of Laser 
Delay on page 164.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Low area signal Area scaling is too low Adjust area scaling for the 
corresponding laser. See Adjusting 
Area Scaling on page 143.

Unexpected events in 
plot

Incorrect logic in population 
hierarchy

Verify the gating strategy.

Incorrect population(s) in 
plot 

Right-click the plot and select 
Show Populations. Verify that the 
appropriate populations are 
displayed.

Incorrect drawing order Verify that the required population 
is not hidden by another 
population. Right-click the plot 
and select Order Populations by 
Count.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Erratic event rate Sample aggregates Filter the sample.

Bulk injection O-ring is worn Contact your BD Biosciences 
service engineer.

Sample is contaminated Re-stain the sample, making sure 
the tube is clean.

Sheath tank low Fill the sheath container.

Unexpectedly high event 
rate

Threshold channel is too low Adjust the threshold channel. See 
Calculating Compensation on 
page 152.

Sample is too concentrated Dilute the sample. 

Flow rate is too high Decrease the flow rate in the 
Acquisition Dashboard. 

Bubbles in flow cell Turn off the stream, wait a few 
seconds, and turn on the stream 
again. 

Unexpectedly low event 
rate

Sample not adequately mixed Increase the sample agitation rate. 
See Sample Agitation on page 85.

Threshold channel is too high Adjust the threshold channel. See 
Calculating Compensation on 
page 152.

Sample is too dilute Concentrate the sample.

Sample line is clogged or 
kinked

Backflush the sample line. See 
Sample Line Backflush on 
page 212. If necessary, change the 
sample line.

Look for visible kinks in the line. 
If kinks are found, change the 
sample line. See Changing the 
Sample Lines on page 221.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Unexpectedly low event 
rate (continued)

Sample line installed 
incorrectly

Verify the sample line installation. 
See Changing the Sample Lines on 
page 221.

Sample aggregates Filter the sample.

Memory is full Compare the processed event rate 
in BD FACSDiva software with the 
threshold counter. If the event rate 
is much lower, exit and then 
restart the application.

Distorted populations or 
high CVs

Cytometer settings adjusted 
incorrectly

Optimize the scatter parameters. 
See Calculating Compensation on 
page 152.

Flow rate is too high Decrease the flow rate in the 
Acquisition Dashboard. 

Window extension is too low Increase the window extension.

Bubbles in flow cell Turn off the stream, wait a few 
seconds, and turn on the stream 
again. 

Nozzle is clogged or dirty Clean the nozzle as described in 
Changing the Integrated Nozzle on 
page 231.

Flow cell is dirty Clean the flow cell. See Cleaning 
the Flow Cell (Daily) on page 206. 
Let DI water sit for 15 minutes 
before turning on the stream. 
Repeat as needed.

Poor sample preparation Repeat sample preparation.

Area scaling is too low Verify area scaling. See Adjusting 
Area Scaling on page 143.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Excessive amount of 
debris in plots

Threshold channel is too low Increase the threshold channel. See 
Calculating Compensation on 
page 152.

Dead cells or debris in sample Examine the sample under a 
microscope.

Sample is contaminated Re-stain the sample, making sure 
the tube is clean.

High electronic abort 
rate (>10% of system 
event rate)

Window extension is too high Decrease the window extension.

Threshold channel is too low Increase the threshold channel.

Event rate is too high Decrease the flow rate in the 
Acquisition Dashboard. 

Sample is aggregated Filter the sample.

Sample is too concentrated Dilute the sample.

Fewer events than 
expected in gated 
population

Window extension set 
incorrectly

Adjust the window extension, if 
needed. See the BD FACSDiva 
Software Reference Manual for 
information.

Laser delay set incorrectly Adjust the laser-delay settings. See 
Manual Adjustment of Laser 
Delay on page 164.

Plot is zoomed Unzoom the plot or make the gate 
bigger.

Events left out of the gate When drawing a gate, make sure 
that events on the axis are 
included.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Increasing threshold 
results in decreased area 
signal

Window extension is too low Slightly increase the window 
extension to maximize the area 
signal.

Increasing the window extension 
too much results in more 
electronic aborts or high CVs.

Area measurement off 
scale while the height 
measurement is on scale

Area scaling is too high Decrease area scaling to move the 
area measurement back on scale. If 
necessary, adjust area scaling to 
make the area measurement match 
the height measurement.

Cannot delete from 
Parameters, Threshold, 
Compensation, or Ratio 
tab views

Row not selected Select the row using the selection 
button.

Data already recorded Create a new tube.

Cannot connect to 
CS&T

External air supply is <80 PSI Check the air pressure gauge on 
the air supply panel or sheath 
tank. The air pressure should be 
80–100 PSI. 

• If the air pressure is within 
range, contact your 
BD Biosciences service engineer.

• If the air pressure is <80 PSI, 
close the release valve and 
reseal the lid.

Negative Q values Higher power lasers than in 
previous cell sorters

1 Rerun the CST baseline.

2 When the software pauses at 
the Optimized PMT Results 
window, set median channel 
values that are <200 to 200.

3 Click OK to finish the run.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Fluidics Troubleshooting
Observation Possible Causes Recommended Solutions

No fluid in line during 
system prime

Air lock in sheath or fluidics 
filter

Remove the filter for the 
corresponding fluid, install the 
bypass tubing, and run Prime 
After Tank Refill. Repeat the 
priming procedure until you see 
fluid in the line.

When fluid is running through the 
line, remove the bypass tubing, 
install the filter, and repeat the 
priming procedure one last time.

Prepare for aseptic sort 
fails

Air lock in filter Remove the filter for the 
corresponding fluid, install the 
bypass tubing, and run Prime 
After Tank Refill. Repeat the 
priming procedure until you see 
fluid in the line.

When fluid is running through the 
line, remove the bypass tubing, 
install the filter, and repeat the 
priming procedure one last time.

Fluid line is detached Verify the fluid line connections 
on the fluidics drawer and on the 
cytometer. Push firmly on each 
line to ensure that it is connected.

Fluidics air flow <80 PSI Air leak Contact your BD Biosciences 
service engineer.

Fluidics air flow 
>100 PSI

Regulator not adjusted 
properly

Contact your BD Biosciences 
service engineer.
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Fluid leak under fluidics 
drawer or below side 
door

Condensation from pressure 
relief valve

This is a normal phenomenon that 
occurs when water is condensed 
from room air. Condensation is 
greater in humid environments. To 
avoid slipping, wipe up any water 
daily.

Bleeder valve is open Check and close all bleeder valves 
for fluid and sheath filters. 

Broken fluid line Contact BD Biosciences.

Sample injection 
chamber does not close 
and causes a BISH or 
BISO error message

O-ring at bottom of sample 
injection chamber is dry and 
causing chamber to stick

Lubricate the O-ring and tube 
holder. See Lubricating the Sample 
Injection Chamber O-Ring on 
page 248.

Fluidics Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Electronics Troubleshooting
Observation Possible Causes Recommended Solutions

“Cytometer 
Disconnected” in 
Cytometer window

Cytometer power is off Turn on the cytometer main 
power.

Communication failure 
between workstation and 
cytometer

• Exit the software and then 
restart it. 

• If restarting does not work, 
reset the cytometer electronics: 
switch off the main power, wait 
10 seconds until the system is 
fully depressurized, and then 
switch the power back on. 

• Restart the computer and the 
cytometer. 

Ethernet cable between 
workstation and cytometer is 
disconnected

Unplug and then plug in the cable 
connectors and make sure they are 
secure. 

IP address changed Enter the correct IP address. Call 
BD Biosciences for assistance.

“Master DAQ 
Overflow” in 
Cytometer window

Event rate is too high Decrease the event rate or verify 
the threshold.

Dirty flow cell Clean the flow cell. See Cleaning 
the Flow Cell (Daily) on page 206.

“Cytometer not 
responding” in Status 
tab

Unknown Perform the suggestions for a 
communication failure, above.
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Supplies and Consumables

This chapter provides a list of supplies and options that are available for the 
BD FACSAria Fusion cytometer. 

• To order spare parts and consumables from BD Biosciences from within the 
US, call 877.232.8995 or go to bdbiosciences.com.

Outside the US, contact your local BD Biosciences representative.

• To order cytometer options, contact your sales representative.

This information is correct at the time of publication. For up-to-date 
information, see our website (bdbiosciences.com).

• Cytometer Supplies on page 276

• Consumables on page 282

http://www.bdbiosciences.com
http://www.bdbiosciences.com/home/
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Cytometer Supplies

Optical Components

The following filters and mirrors are mounted on the BD FACSAria Fusion 
cytometer. Use these part numbers if you need to order any replacement 
components. See Using Custom Optical Filters on page 249 for instructions.

Detector Array 
(Laser)

PMT
LP Mirror 
BP Filter

Replacement 
Part No.

Intended Dye

Octagon 
(488-nm blue laser)

A 735 343787 –

780/60 343788 PE-Cy™7

B 655 343789 –

695/40 343790 PerCP-Cy5.5 or PI

675/20 343791 PerCP

C 610 640879 –

616/23 640880 • PE-CF594

• PE-Texas Red®

D 556 343794 –

585/42 343796 PE or PI

E 502 343797 –

530/30 343798 FITC or Alexa Fluor® 
488

F 488/10 343799 SSC

 1.5 ND 
filter

53-10057-01 –
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The following filters and mirrors are provided with the violet laser option.

Octagon 
(640-nm red laser)

A 735 343787 –

780/60 19-62774-18 APC-Cy7 or APC-H7

B 690 640468 –

730/45 338830 –

C 670/30 664620 APC or 
Alexa® Fluor 647

Detector Array
(Laser)

PMT
LP Mirror 
BP Filter

Replacement 
Part No.

Intended Dye

Octagon
(405-nm violet laser)

A 502 343797 –

510/50 649421 BD Horizon™ 
BV510, V500, 

Alexa Fluor® 430

B 450/40 343801 DAPI, 
BD Horizon™ 
V450, 
Pacific Blue™, 
BD Horizon™ 
BV421, 
BD Horizon™ 
VPD450

Detector Array 
(Laser)

PMT
LP Mirror 
BP Filter

Replacement 
Part No.

Intended Dye
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The FSC photodiode is provided with a 1.5 and 2.0 ND filter. Other filters are 
available as options. Use the following part numbers to replace the filter.

To order a filter holder, use the following part numbers. 

Accessory Kit

The cytometer is shipped with an accessory kit containing the following items. 
Use these part numbers if you need to order any replacements.

Detector ND Filter
Replacement 

Part No.

FSC photodiode 0.5 33710407

1.0 33710807

1.5 340104

2.0 340105

Holder Part No.

Mirror holder 336103

Mirror retainer 345662

Mirror backup spring 344979

Filter holder 336102

Filter retainer 333830

Item Part No.

1-mL microtube holder 333457

12 x 75-mm test tube holder 333456

15-mL centrifuge tube holder 333430
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Four-way 1.5-mL Eppendorf collection tube holder 644349

Four-way 12 x 75-mm collection tube holder 641454

Two-way 12 x 75-mm collection tube holder 641613

Two-way 15-mL collection tube holder 641612

Universal top section for collection tube holders (2) 651439

O-ring for collection-tube holder (9) 337897

Integrated nozzles:

• 70 micron (2)

• 85 micron (2)

• 100 micron

• 647339

• 647340

• 647341

Nozzle locking lever (spring and plunger included) 7001349

Standard nozzle O-rings 333084

Nozzle holster 642884

Magnifying glass 337599

Sample injection tubing (12-inch lengths) 641059

Sample injection tubing (7-inch lengths) 641475

Ferrule 335108

Ferrule-removal tool 335690

Collet 19-66455-00

Collet nut 19-66456-00

Pinch valve tubing 641900

Sample line filters (35 micron) 649048

Sample line filters (50 micron) 649049

Sheath fluid filter (also used for ethanol shutdown tank 
filter)

661744

Item Part No.



280 BD FACSAria Fusion User’s Guide   

Fluid filter (for DI water, bleach, and ethanol tanks) 335916

Fitting, 1/4-28 x 1/16 barb PPL (3) 343508

Air filter, inline, 3 micron (2) 641913

Filter (Chroma) HQ710/50 640471

Mirror (Omega) 675/20 19-62774-15

Filter holders (3) 336102

Filter clip (5) 640563

Waste sensor probe (6-level) 334915

Disposable waste tank caps (pack of 12) 338854

Cap, waste tank (2 pack) 338505

Cap for 5-L container (3) 335916

Lubricant for O-rings 347306

O-ring pick tool 331430

O-rings (10) 340086

O-rings (3) 641860

O-ring, tank, ethyl and sheath 642877

Deflection plate removal tool 643197

Drop charge cable assembly 343358

Allen wrench set 98-10004-00

Adapter tray for microscope slides 335630

Swab, micro head 3.2 x 1.5 x 10, 70-mm LG (100/pkg) 643290

Cotton-tipped applicators (100/pkg) 99-30122-00

5-mL polystyrene round-bottom tubes (125/pkg) 343675

Warning labels 335600

Item Part No.
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Other Replacement Parts

The following items might be included in the accessory kit, but you can use the 
indicated part numbers to order spare or replacement parts.

Cable, extension, DB9FEM-DB (FEM, 8 feet) 332907

Power cords:

• Main power cord

• Cordset for continental Europe

• Cordset for UK

• Cordset for Australia/Asia

• 333694

• 334140

• 334141

• 334175

Item Part No.

Autoclavable 10-L container 340261

Auxiliary 5-L container 333504

Sheath sensor probe 64410907

Waste sensor probe (6-level) 334915

Auxiliary sensor probe (non-ethanol) 343835

Auxiliary sensor probe (ethanol) 642874

Air filter for ACDU cabinet (set of 3) 334821

ULPA filter and tubing replacement kit 
(set of 3, for use with the AMO)

334822

Hydrophobic filter for sort block door
(for use with the AMO)

651177

Four-way 1-mL collection tube holder 641614

Item Part No.
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Consumables

Cytometer Setup Particles 

Particle Supplier Catalog No.

BD Calibrite™ beads BD Biosciences

• Two-color kit
(unlabeled, FITC, PE)

• 349502

• Three-color kit
(unlabeled, FITC, PE, PerCP)

• 340486

• PerCP beads • 340497

• PerCP-Cy5.5 beads • 345036

• APC beads • 340487

Fluoresbrite® Yellow-Green 2-µm beads 
(for the 405-nm laser)

Polysciences Inc.
(800) 523-2575

18604

Spherotech Rainbow Calibration 
Particles, 3.0–3.4 µm

BD Biosciences • 559123 
(8 peaks)

• 556286

• 556291
(brightest 
peak in 
556286)

BD FACS Accudrop beads BD Biosciences 345249

BD FACSDiva CS&T research beads BD Biosciences 655050 
(1 vial)
655051
(3 vials)



 Chapter 8: Supplies and Consumables 283

Reagents

Reagent Supplier Catalog No.

BD FACSFlow sheath fluid BD Biosciences 342003

BD™ FACSRinse detergent BD Biosciences 340346

BD FACSClean solution BD Biosciences 340345

Ethanol Various –

Chlorine bleach (5% sodium 
hypochlorite)

Clorox® or other major 
supplier (to ensure that the 
bleach is at the correct 
concentration and free of 
particulate matter)

–

Monoclonal antibodies BD Biosciencesa

a. See the BD Biosciences Immunocytometry Products Catalog or the BD Biosciences website, 
bdbiosciences.com.

–

Dyes and fluorochromes Life Technologies
(800) 438-2209

Sigma
(800) 325-3010

–

BD FACS™ lysing solution BD Biosciences 349202

http://www.bdbiosciences.com/
http://www.bdbiosciences.com/
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Labware

Item Supplier Catalog No.

1-mL microtubes Bio-Rad Laboratories
(800) 424-6723

223-9391 
(1,000 per box)

1.5-mL Eppendorf tubes Various –

5-mL polystyrene test tubes, 
12 x 75-mm

• Uncapped, 125 per bag

• Capped, 125 per bag

• Capped, 25 per bag

• With cell-strainer cap, 
25 per bag

BD Biosciences

• 343675 

• 352054

• 352058

• 352235

15-mL conical centrifuge tubes

• Polypropylene, 50/bag

• Polypropylene, 125/bag

• Polypropylene, 50/rack

• Polystyrene, 125/bag

• Polystyrene, 50/rack

BD Biosciences

• 352196

• 352096

• 352097

• 352095

• 352099
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Laser Options

BD FACSAria Fusion systems can be configured with up to six lasers, with four 
lasers active at one time. Depending on how your system is configured, you can 
choose different laser options by adjusting the laser rotary switches on your 
power panel.

You can view your system’s configuration in the CS&T Cytometer 
Configurations window. 

The following topics are described in this chapter:

• Planning Considerations on page 286

• Detector Locations on page 287

• Detector Configurations on page 289

• Fifth PMT in the 561-nm Octagon on page 301
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Planning Considerations

When planning your experiments, keep in mind the specific combinations of 
lasers, mirrors, filters, and fluorochromes you need. You also have to properly 
account for the specific use of the 375-nm and the 445-nm lasers and how to 
name a particular fluorochrome if you want to use it with multiple lasers.

Optics Choices for the 375-nm Laser

The optics listed for the 375-nm laser are specifically intended for side 
population studies. For other experiments, you can use the optics from the 
405-nm laser with the 375-nm laser.

Optics Changes When Using the 445-nm Laser

In a system with a 445-nm laser turned on, the BP filter for the 405-nm laser 
must be changed to 480/20 (from the standard 450/40). This is because the 
405-nm laser detector picks up scattered light from the 445-nm laser and causes 
CS&T to produce incorrect results. This filter change applies to the 375-nm laser 
when using the same optics as the 405-nm laser.

Using a Fluorochrome with Multiple Lasers

If you plan to use a fluorochrome with more than one laser, you must create a 
unique name for each instance. For example, if PI is listed for a 561-nm laser on 
PMT C, you could list it as propidium iodide for the 375-nm laser on PMT B. 
You could also name them PI-561 and PI-375, or something similar, as long as 
the names are unique.
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Detector Locations

The following tables list the detector locations with respect to the number of 
installed lasers. See Detector Configurations on page 289 for complete details 
about which mirrors, filters, and fluorochromes to use.

Table 9-1  2-laser systems 

Table 9-2  3-laser systems 

Table 9-3  4-laser systems 

Octagon Location

Laser (nm) Top Left Top Right Bottom Left Bottom Right

488, 640 — 640 — 488

Octagon Location

Laser (nm) Top Left Top Right Bottom Left Bottom Right

488, 561, 640 — 640 561 488

488, 445, 640 — 640 — 488/445

488, 640, 405 405 640 — 488

488, 640, 375 375 640 — 488

Octagon Location

Laser (nm) Top Left Top Right Bottom Left Bottom Right

488, 561, 640, 405 405 640 561 488

488, 561, 640, 375 375 640 561 488

488, 445, 561, 640 — 640 561 488/445
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Table 9-4  5-laser system 

488, 445, 640, 405 405 640 — 488/445

488, 445, 640, 375 375 640 — 488/445

488, 640, 405, 375 375/405 640 — 488

Octagon Location

Laser (nm) Top Left Top Right Bottom Left Bottom Right

488, 561, 640, 405, 375 375/405 640 561 488

488, 445, 561, 640, 405 405 640 561 488/445

488, 445, 561, 640, 375 375 640 561 488/445

488, 445, 640, 405, 375 375/405 640 — 488/445

Octagon Location

Laser (nm) Top Left Top Right Bottom Left Bottom Right
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Detector Configurations

This section lists four standard sets of detector configurations along with their 
mirrors, filters, and fluorochromes.

488/640 Two-Laser System

C
B

F

A
D

G

H

E

H

E

B

F

G

A

D

C

488-nm (blue) laser 640-nm (red) laser
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This is a basic two-laser system with two octagons.

Table 9-5  488/640 configuration

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes

488-nm octagon A 735 780/60 PE-Cy7

B 655 675/20 or 
695/40

• PerCP

• PerCP-Cy5.5

C 610 616/23 • PE-CF594

• PE-Texas Red®

• PI

D 556 585/42 PE

E 502 530/30 • FITC

• Alexa Fluor® 488

F — 488/10 SSC

G, H - Unavailable or optional

640-nm octagon A 735 780/60 • APC-Cy7

• APC-H7

B 690 730/45 Alexa Fluor® 700

C — 670/30 • APC

• Alexa Fluor® 647
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488/640/405 Three-Laser System

This three-laser system supports the simultaneous use of three lasers. There are 
three octagons: 488 nm, 640 nm, and 405 nm.

Table 9-6  488/640/405 three-laser system

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes

488-nm octagon A 735 780/60 PE-Cy7

B 655 675/20 or 
695/40 

• PerCP

• PerCP-Cy5.5

C 610 616/23 • PE-CF594

• PE-Texas Red®

• PI

D 556 585/42 PE

E 502 530/30 • FITC

• Alexa Fluor® 488

F — 488/10 SSC

G, H - Unavailable

405-nm octagon640-nm octagon488-nm octagon

D
A

E

BC

F

G

H

C
B

F

A
D

G

H

E

H

E

B

F

G

A

D

C
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640-nm octagon A 755 780/60 • APC-Cy7

• APC-H7

B 690 730/45 Alexa Fluor® 700

C — 670/30 • APC

• Alexa Fluor® 647

405-nm octagon A 750 780/60 • BD Horizon™ BV786

B 690 710/50 • BD Horizon™ BV711

C 630 660/20 • BD Horizon™ BV650

D 595 610/20 • BD Horizon™ BV605

E 505 525/50 • AmCyan

• BD Horizon BV510

• BD Horizon™ V500

F — 450/40 • DAPI

• BD Horizon™ V450

• Pacific Blue™

• BD Horizon BV421

• BD Horizon VPD450

G, H - Optional

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes
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488(445)/561/640 Four-Laser System

This four-laser system supports the simultaneous use of three lasers, with the 
option to switch from the 488-nm laser to the 445-nm laser. Note that there are 
three octagons: 488 nm/445 nm, 640 nm, and 561 nm.

Switching lasers affects the supported combination of mirrors, filters, and dyes. 
These laser options are included in the following table.

Table 9-7  488(445)/561/640 configuration

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes

 488-nm octagon A 655 675/20 or 
695/40

• PerCP

• PerCP-Cy5.5

B 502 530/30 • FITC

• Alexa Fluor® 488

C — 488/10 SSC

445-nm octagon

(Optional)

A 470 510/80 • CFP

• AmCyan fluorescent 
protein

B — 445/15 SSC

C, D, E, F, G, H - Optional

640-nm octagon488(445)-nm octagon

C
B

F

A
D

G

H

E

H

E

B

F

G

A

D

C

G

E
A

F

H

B

C

D

561-nm octagon
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561-nm octagon A 735 780/60 PE-Cy7

B 630 670/14 

710/50

• PE-Cy™5

• PE-Cy5.5

C 600 610/20 • PE-CF594

• PE-Texas Red®

• Living Colors® 
mCherry

• PI

D — 582/15 PE/Ds Red

E, F - Optional 

G, H - Unavailable

640-nm octagon A 735 780/60 • APC-Cy7

• APC-H7

B 690 730/45 • Alexa Fluor® 700

C — 670/30 • APC

• Alexa Fluor® 647

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes
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488(445)/640/405(375) Five-Laser System

This five-laser system supports the simultaneous use of three lasers, with the 
option to switch from the 488-nm laser to the 445-nm laser as well as from the 
405-nm laser to the 375-nm laser.

If your system doesn’t have the 445-nm or 375-nm laser installed, the location of 
the other detectors would not change.

405(375)-nm octagon

D
A

E

BC

F

G

H

640-nm octagon

C
B

F

A
D

G

H

E

488(445)-nm octagon

H

E

B

F

G

A

D

C
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Switching lasers affects the supported combination of mirrors, filters, and dyes. 
The laser options are included in the following table.

Table 9-8  488(445)/640/405(375) five-laser system

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes

488-nm octagon A 735 780/60 PE-Cy7

B 655 675/20 or 
695/40 

• PerCP

• PerCP-Cy5.5

C 610 616/23 • PE-CF594

• PE-Texas Red®

• PI

D 556 585/42 PE

E 502 530/30 • FITC

• Alexa Fluor® 488

F — 488/10 SSC

G, H - Unavailable

445-nm octagon

(Optional)

A 470 510/80 • CFP

• AmCyan fluorescent 
protein

B — 445/15 SSC

C, D, E, F, G, H - Optional

640-nm octagon A 735 780/60 • APC-Cy7

• APC-H7

B 690 730/45 Alexa Fluor® 700

C — 670/30 • APC

• Alexa Fluor® 647
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488(445)/561/640/405(375) Six-Laser System

This six-laser system supports the simultaneous use of four lasers, with the 
option to switch from the 488-nm laser to the 445-nm laser as well as from the 
405-nm laser to the 375-nm laser. Switching lasers affects the supported 
combination of mirrors, filters, and dyes.

405-nm/375- nm 
octagon

A 750 780/60 • BD Horizon BV786

B 690 710/50 • BD Horizon BV711

C 630 660/20 • BD Horizon BV650

D 595 610/20 • BD Horizon BV605

E — 450/40 
(480/20 
with 445-
nm laser)

• DAPI

• BD Horizon V450

• Pacific Blue™

• BD Horizon BV421

• BD Horizon VPD450

F 505 525/50 • AmCyan

• BD Horizon BV510

• BD Horizon V500

G, H - Optional

375-nm octagona 
(Optional)

A 610 670 • Hoechst Red

B — 450/20 
(480/20 
with 445-
nm laser)

• Hoechst Blue

• DAPI

C - Optional

a. Use these settings for the 375-nm laser for side population studies.

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes
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With this configuration, the 405-nm and 375-nm optics are interchangeable 
unless you are doing side population studies, in which case you’ll use the optics 
specified for the 375-nm laser only.

Table 9-9  488(445)/561/640/405(375) configuration

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes

 488-nm octagon A 655 695/40

675/20

• PerCP-Cy5.5

• PerCP

B 502 530/30 FITC

C — 488/10 SSC

G

E
A

F

H

B

C

D

561-nm octagon 405(375)-nm octagon

D
A

E

BC

F

G

H

640-nm octagon

C
B

F

A
D

G

H

E

488(445)-nm octagon

H

E

B

F

G

A

D

C
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445-nm octagon

(Optional)

A 470 510/80 • CFP

• AmCyan fluorescent 
protein

B — 445/15 SSC

C, D, E, F, G, H - Optional

561-nm octagon A 735 780/60 PE-Cy7

B 630 670/14 

710/50

• PE-Cy5 

• PE-Cy5.5

C 600 610/20 • PE-CF594

• PE-Texas Red®

• Living Colors® 
mCherry

• PI

D — 582/15 PE

E, F - Optional 

G, H - Unavailable

640-nm octagon A 735 780/60 • APC-Cy7

• APC-H7

B — 660/20 APC

C - Optional

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes
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405-nm/375-nm 
octagon

A 750 780/60 • BD Horizon BV786

B 690 710/50 • BD Horizon BV711

C 630 660/20 • BD Horizon BV650

D 595 610/20 • BD Horizon BV605

E 505 525/50 • AmCyan

• BD Horizon BV510

• BD Horizon V500

F — 450/40 
(480/20 
with 445-
nm laser)

• DAPI

• BD Horizon V450

• Pacific Blue™

• BD Horizon BV421

• BD Horizon VPD450

G, H - Optional

375-nm octagona

(Optional)

A 610 670 • Hoechst Red

B — 450/20 
(480/20 
with 445-
nm laser)

• Hoechst Blue

• DAPI

C, D, E, F, G, H - Optional

a. Use these settings for the 375-nm laser for side population studies.

Laser and 
optics device

PMTs LP mirrors BP filters Fluorochromes
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Fifth PMT in the 561-nm Octagon

A system with a 561-nm laser and an optional fifth PMT includes a 685 LP 
mirror that can be used with the supplied 710/50 BP filter to run PE-Cy5.5. The 
optics in the PMTs need to be shifted to use this setup. The following drawing 
shows the optics configuration for this case.

A
C

E
G
B D

F
H

PE-Cy5.5
PE-Alexa Fluor® 700

PE-Cy5

PE-Cy7
PE

PE-Texas Red®
mCherry
PI

735 LP630 LP
685 LP 600 LP

780/60670/14
710/50 610/20

58
2/1

5

561-nm 
Octagon
with 5th PMT
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10

BD Aerosol Management Option

The BD aerosol management option (AMO) is a device that uses an attached 
vacuum source to rapidly evacuate aerosolized particles through an ultra-low 
penetrating air (ULPA) filter during routine sorting or analysis. 

The following topics are described in this chapter:

• Option Components on page 304

• Operating the BD Aerosol Management Option on page 306

• Maintenance on page 312

• Upgrades for the AMO on page 319

• Troubleshooting on page 320

• Specifications on page 323
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Option Components

The BD Aerosol Management Option (AMO) includes the following:

• An evacuator to generate negative pressure

• An ULPA filter to trap particles, with attached tubing that connects the 
evacuator to the instrument

• An air filter for the sort collection chamber door

• A hydrophobic filter on the sort block door

• A hinged cover on the sample injection chamber

The BD Aerosol Management Option is For Research Use Only. It is not for use 
in diagnostic or therapeutic procedures.

Evacuator

The evacuator holds the ULPA filter and attached tubing. Air flow is controlled 
using pushbuttons within a membrane panel on the front of the unit. The 
evacuator sits on caster wheels for easy maneuverability. It can be moved using 
the handle attached to the unit. See Figure 10-1 on page 305.

The BD Aerosol Management Option does not eliminate the health risks of 
working with biohazardous material and must be used in conjunction with 
good laboratory practice.
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Figure 10-1  AMO evacuator 

ULPA Filter

The ULPA filter used in the BD AMO captures and retains 99.9995% of all 
particles down to and including particles 0.12 microns in size, according to the 
manufacturer’s specifications. 

Figure 10-2  ULPA filter

Flow gauge

Membrane panel

Filter hold-down

Handle

ULPA filter

Tubing

7/8-inch port 

1 1/4-inch port 



306 BD FACSAria Fusion User’s Guide   

Operating the BD Aerosol Management Option

Starting Up the Evacuator

Before starting up the evacuator, make sure that:

• The ULPA filter is completely seated against the bottom of the evacuator 
filter well

• One end of the tubing is securely attached to the 1 1/4-inch (left) port on 
the ULPA filter

NOTE Ensure that the 7/8-inch (right) port is closed.

• The other end of the tubing is attached to the manifold located in the 
connection panel on the back of the cytometer

To start up the evacuator:

1 Install the splash shield or the tube holder below the aspirator drawer 
(Figure 10-3 on page 307).

The splash shield is required for sorting into a multiwell plate or onto a 
slide.

To install the splash shield:

a Close the sort block door and open the sort collection chamber door, if 
needed. 

The sort block door must be closed to open the collection chamber 
door.

Any instrument surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
instrument hardware. Wear suitable protective clothing, eyewear, and 
gloves.
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b Remove the tube holder, if one is installed.

c Insert the splash shield into the slotted fittings below the sort aspirator 
drawer. (See Figure 10-3.) Push the splash shield all the way in.

Figure 10-3  Installing the splash shield

2 Ensure that an air filter is installed in the sort collection chamber door.

The filter traps airborne dust that could clog the ULPA filter. The filter 
should be changed on a monthly basis. See Replacing the Air Filter on 
page 317.

3 Close the sort collection chamber door.

Sort collection chamber door

Air filter
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NOTE The sort collection chamber door must be closed for the evacuator 
to generate negative pressure in the chamber.

4 Switch on the main power on the back of the evacuator (Figure 10-4).

Figure 10-4  Turning on main power

5 Press the power button on the membrane panel of the evacuator. 

6 Press the up or down arrow button to set the suction control rate to 20%.

Each time either arrow button is pressed, the suction will increase or 
decrease by 10%. When two lights are lit on the suction control indicator, 
the actual air flow is the value between the two illuminated percentages. 

7 Verify that the filter flow gauge reads less than 2.4 inches of H2O 
(Figure 10-5 on page 309).

Do not set the suction control rate above 20%. Higher rates could affect 
the stability of the side streams.

Main power

Power button
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For a new filter, the gauge should read 1.1–1.4 inches of H2O. As the filter 
is used, the reading will increase. If the gauge reads 2.4 inches of H2O or 
greater, replace the filter. See Replacing the ULPA Filter on page 313.

Figure 10-5  Reading the filter flow gauge

Setting Up for Sorting

To set up for sorting:

1 Start up the flow cytometer system. See Cytometer Startup on page 116.

2 Start up the evacuator as described in Starting Up the Evacuator on 
page 306. 

3 Follow the standard sort setup procedure. See Setting Up for Sorting on 
page 170.

NOTE Always start up the evacuator before setting up for sorting. If you 
start up the evacuator after sort setup is complete, you will need to repeat 
the setup procedure.

New filter Used filter
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Responding to a Nozzle Clog During a Sort with the 
AMO

If the stream is disturbed during the sort (due in part to a clogged nozzle), the 
sort is designed to stop automatically and block the sort tubes (if Sweet Spot is 
on). The sort will not restart until the operator has cleared the clog. In the event 
of a nozzle clog, do not open the sort collection chamber door or access the sort 
tubes before following this procedure.

To clear a clogged nozzle on a system with the AMO:

1 If the stream has not already shut down automatically, turn off the stream 
by clicking the Stream button (with a checkmark) at the top of the Breakoff 
window.

This will shut off the stream, unload the sample, and close the aspirator 
drawer.

2 Increase the air evacuation rate on the AMO unit to 100%.

3 Open the aspirator drawer using software controls (see Figure 1-12 on 
page 32). 

4 Wait at least 60 seconds. 

This procedure will clear aerosols from the sort chamber.

5 Close the aspirator drawer.

6 Turn on the stream and view the breakoff.

Cell sorters that use droplet generation methods, such as the 
BD FACSAria Fusion, can produce aerosols around the sample stream. 
When acquiring biohazardous samples, follow universal precautions at all 
times. Keep the sort block door and the sort collection chamber door closed 
during sorting. Follow these steps to stop sample flow and evacuate 
potential aerosols before opening the sort collection chamber door.
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If the clog is removed, the breakoff will be similar to the breakoff before 
the clog.

7 If the clog is not cleared, turn the stream on and off several times to see if 
the clog will clear itself.

8 If the clog is not removed, turn the stream off and perform the Clean Flow 
Cell procedure with DI water (see Cleaning the Flow Cell (Daily) on 
page 206), followed by turning the stream on to see if the clog has cleared.

9 Open the aspirator drawer and evacuate for at least 60 seconds before 
closing the aspirator drawer again.

10 You can now open the sort collection chamber and remove the sort 
collection device.

11 If it is necessary to change nozzles or remove a clog from a nozzle, see 
Cleaning the Integrated Nozzle on page 233.

12 With stream turned off, open the sort block door and dry the plates and 
surfaces as needed.

13 When removing collection tubes, be aware that the outside of the tube is 
potentially contaminated. Use alcohol swabs or bleach to wipe the outsides 
of tubes.

14 Set the AMO unit back to 20% vacuum.

15 Make sure that all chamber doors are closed and restart the stream.

16 Perform these tasks if needed:

• Turn on the Sweet Spot

• Check the drop delay

• Check the side stream deflection
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Turning Off the Evacuator

Turn off the evacuator after you have finished running biohazardous samples.

1 Place the system in standby by pressing the power button on the membrane 
panel of the evacuator.

2 Switch off the main power on the back of the evacuator (Figure 10-4 on 
page 308).

Maintenance

Use the following guidelines to ensure optimal performance of the BD Aerosol 
Management Option.

• Change the ULPA filter and attached tubing when the flow gauge indicator 
is >2.4 at a 20% flow setting or when the red filter-life indicator LED is 
blinking. See Replacing the ULPA Filter on page 313.

Two spare filters and replacement tubing are included with the AMO. To 
order additional replacement kits, contact your local BD Biosciences 
representative. 

• Change the air filter in the sort collection chamber door on a monthly 
basis. The filter traps airborne dust that could clog the ULPA filter. Regular 
replacement of the air filter will extend the life of your ULPA filter. See 
Replacing the Air Filter on page 317.

• Do not touch the Filter Life Reset button during normal operation. Doing 
so could shut down the evacuator and prevent the collection of aerosols.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle the ULPA filter and attached 
tubing as if capable of transmitting infection. Dispose of waste using proper 
precautions and in accordance with local regulations. Wear suitable 
protective clothing, eyewear, and gloves.
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• Do not disconnect the tubing from the instrument manifold outlet or the 
ULPA filter unless you are changing the filter. Repeated removal and 
reattachment of the tubing could loosen the connection and disrupt airflow. 

• To ensure optimal airflow, keep the tubing free of kinks and away from 
sharp or heavy objects. Do not crush or puncture the tubing. Ensure that 
the tubing is securely attached at both ends before turning on the evacuator 
power.

• Keep the sort collection chamber free of potentially obstructive debris, such 
as Kimwipes® or disposable pipets.

• Replace the hydrophobic filter on the sort block door every six months. See 
Figure 1-13 on page 33 for the location of the filter. 

Replacing the ULPA Filter

Replace the filter when either of the following conditions occur:

• The filter-flow gauge reads 2.4 inches of H2O or greater at 20% suction.

• The red filter-life indicator LED is blinking. 

NOTE When only the red LED light is illuminated (but is not blinking), you have 
approximately 1 hour of filter life remaining. If the red light comes on during 
sorting, the filter will not stop working. Replace the filter as soon as possible 
when the red light starts blinking.

To replace the ULPA filter:

1 Turn off the evacuator main power and disconnect the electrical plug. 

2 Disconnect the tubing from the manifold.

To prevent potential shock, always turn off the evacuator main power and 
disconnect the electrical plug from the power source before installing or 
removing any filter.
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The manifold is located in the connection panel on the back of the 
cytometer.

3 Remove the spring-loaded filter hold-down.

While pushing down on the filter, pull up on the spring-loaded handle 
(Figure 10-6A), and guide the handle over the top of the filter and behind 
the metal plate in the back of the evacuator (Figure 10-6B). 

NOTE The photos in this section show the discontinued ULPA filter. The 
new ULPA filter has two ports (1 1/4-inch and 7/8-inch). See Figure 10-2 
on page 305.

Figure 10-6  Removing the filter hold-down

4 Lift off the ULPA filter and attached tubing from the evacuator and dispose 
of both the filter and the tubing. 

5 Insert the new ULPA filter into the evacuator filter well (Figure 10-7 on 
page 315).

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle the ULPA filter, attached tubing, 
and all instrument hardware as if capable of transmitting infection. Dispose 
of waste using proper precautions and in accordance with local regulations. 
Wear suitable protective clothing, eyewear, and gloves.

A B

Metal 
plate
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Figure 10-7  Inserting the new filter

6 Push down on the filter to ensure that it is seated against the bottom of the 
filter chamber (Figure 10-8). 

Figure 10-8  Seating the new filter

NOTE For optimal evacuation of aerosols, the filter must be completely 
seated in the evacuator filter well.

7 Lift the spring-loaded filter hold-down and place it on top of the filter.

8 Press and hold the Filter Life Reset button on the membrane panel for 
5-10 seconds (Figure 10-9 on page 316).



316 BD FACSAria Fusion User’s Guide   

Figure 10-9  Filter Life Reset button

All of the green, amber, and red LED lights will turn off, and then on. Hold 
down the button until the 100% indicator light is lit. This resets the 
180-hour filter-life clock.

NOTE As the life of the filter is exhausted, the indicator lights will go out, 
starting from 100%. When only the red LED light is illuminated (but is not 
blinking), you have approximately 1 hour of filter life remaining.

9 Connect one end of the replacement tubing to the 1 1/4-inch (left) port on 
the ULPA filter (Figure 10-10), and the other end to the tubing manifold on 
the back of the cytometer.

Ensure that the cover on the 7/8-inch (right) port is closed. See Figure 10-2 
on page 305.

Figure 10-10  Connecting new tubing to the ULPA filter

NOTE For optimal evacuation of aerosols, ensure that the tubing is 
securely connected at both ends.

Reset button
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10 Connect the evacuator power plug to the power source.

Replacing the Air Filter

To extend the life of your ULPA filter, we recommend that you replace the air 
filter on a monthly basis. The filter traps airborne dust that could clog the ULPA 
filter. Regular replacement of the air filter will extend the life of your ULPA filter. 

The air filter is located inside the sort collection chamber door.

To replace the air filter:

1 Slide open the sort collection chamber door.

The air filter is held in place by a cover. See Figure 10-11 on page 318.

Sort collection chamber door

Air filter
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Figure 10-11  Removing the air filter

2 Unscrew the screw at the top of the cover.

3 Pull off the cover and slide out the air filter.

Grasp the filter and then carefully slide it out of the door. While it is still 
inside the BSC, bag the air filter to avoid exposure to biohazardous agents.

4 Install a new air filter in the door.

Slide the new filter in from the right.

NOTE Make sure to install the filter with the grid side facing out so that it 
is visible through the closed door (Figure 10-12 on page 319).

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle the air filter and all instrument 
hardware as if capable of transmitting infection. Dispose of waste using 
proper precautions and in accordance with local regulations. Wear suitable 
protective clothing, eyewear, and gloves.

Opened sort collection chamber door

Sort collection chamber

Screw

Cover
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Figure 10-12  View of the air filter from the top and bottom

5 Reinstall the cover and tighten the screw.

Upgrades for the AMO

Upgrade kits are available for the AMO to improve the efficiency of the system to 
clear aerosols that can be produced during the sorting process. The components 
include a new universal tube holder top section with three holes (Figure 10-13) 
and a new sort block door with a hydrophobic filter (Figure 10-14 on page 320).

Contact BD Customer Support for information on the upgrade kits.

Figure 10-13  Universal tube holder top

Grid side faces out Non-grid side faces inside

Universal top (front view) Universal top (back view)
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Figure 10-14  Sort block door with filter

Troubleshooting

The tips in this section are provided to help you troubleshoot issues that arise 
when using the BD Aerosol Management Option. For cytometer-specific 
troubleshooting, see Troubleshooting on page 253.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

If any of the following are observed, assume that the AMO is not 
evacuating properly, and do not open the doors to the sort chamber.

Sort block door

Hydrophobic filter, 
included with AMO
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Control Panel Troubleshooting

Observation Possible Cause Recommended Solution

Evacuator indicator 
lights off

Evacuator power cord 
unplugged

Connect the evacuator power 
cord to the power source.

Evacuator power 
switched off 

Switch on the evacuator main 
power. See Figure 10-4 on 
page 308.

Evacuator motor failure Contact your local BD technical 
support representative.

Circuit breaker tripped Depress the circuit breaker on the 
rear of the evacuator into its 
original position.

Site power failure Turn off the evacuator power 
switch and wait for site power to 
be restored.

Evacuator indicator 
lights pulsing

Erratic power source Plug the power cord into a 
different outlet.

Arrow keys not 
responding

Improper operation Push each button firmly before 
removing your finger from the 
control.

Defective membrane panel Contact your local BD technical 
support representative.

Red filter-life 
indicator light on

Approaching 180 hours of 
filter use

Monitor the light. When it 
blinks, change the filter.

Filter life not reset after 
filter change

After changing the filter, press 
and hold the Filter Life Reset 
button until the 100% indicator 
light is lit.

Red filter-life 
indicator blinking

Filter used over 180 hours Replace the filter.
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Filter Flow Gauge Troubleshooting

Observation Possible Cause Recommended Solution

Zero reading on 
filter flow gauge

Power off Press the power button on the 
membrane panel of the evacuator. 

Filter defective Replace the filter.

Filter improperly seated in 
evacuator

Re-seat the filter with the 
evacuator power off.

Tubing loose or 
not connected

Ensure that the tubing is securely 
connected below the sort 
chamber and to the filter module.

Tubing kinked or damaged Inspect the tubing for kinks or 
punctures. Replace the tubing, if 
needed.

Wrong tubing type or part Ensure that the correct type of 
tubing is in use.

Erratic reading on 
filter flow gauge

Defective filter Replace the filter.

Filter improperly seated in 
evacuator

Re-seat the filter with the 
evacuator power off.

Off-scale reading on 
filter flow gauge

Tubing or sort collection 
chamber obstructed

• Inspect the tubing for kinks or 
punctures. Replace the tubing, 
if needed.

• Check for obstructions in the 
sort collection chamber. 
Remove any obstruction.

Filter clogged or saturated Replace the filter as described in 
Replacing the ULPA Filter on 
page 313. 
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Specifications

Specifications for the BD Aerosol Management Option are as follows.

Evacuator

• Greater than or equal to 7 CFM (ft3/min) normal operation rate (20% 
suction control)

• Greater than or equal to 30 CFM boost evacuation (100% suction control)

• <35 lb unpacked weight 

ULPA Filter Module

• VLSI grade

• Traps particles greater than or equal to 0.12 µm

• Three-stage filtration (pre-filter, ULPA, post-filter)

• Particulate removal efficiency >99.9995%

Air Filter

• Filter medium is an open-cell polyurethane foam

• Medium specially coated for improved fire retardation and fungi resistance

• High dust-trapping capacity, low air resistance

• Can be used in a wide variety of climatic conditions

• Rated UL 94 HF-1
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11

Biosafety Cabinet Option

The following topics are covered in this chapter:

• Biosafety Cabinet Overview on page 326

• Aerosol Management System on page 333

• Operating the AMS on page 335

• Working in the BSC on page 338

• Cleaning the Base Pan on page 340

• Replacing the Electronics Cable Plastic Sleeve on page 343

• Ergonomics Safety Guidelines on page 344
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Biosafety Cabinet Overview

The optional biosafety cabinet (BSC) is designed to be used with the 
BD FACSAria Fusion, with the sorting hardware located inside the BSC 
(Figure 11-1). Biosafety protection is provided by negative pressure and 
controlled air flow within the cabinet. Before entering the work area or leaving 
the top of the cabinet, air passes through high-efficiency particulate air (HEPA) 
filters. An integrated Aerosol Management System (AMS) operates independently 
from the BSC blower and provides additional biosafety protection. The AMS 
evacuates the sort chamber during sorting and exhausts that air through a 
separate HEPA filter. Air flow probes in the BSC and AMS monitor exhaust air 
flow. An audible alarm is triggered if the air pressure differential (BSC) or air 
flow (AMS) drops to and unsafe level.

Figure 11-1  The BSC enclosing the BD FACSAria Fusion

An optional FlexAIR® canopy can be purchased to connect the BSC to an in-
house exhaust system (Figure 11-2). The FlexAIR canopy can help alleviate 

Operating the BD FACSAria Fusion inside the BSC can generate 
temperatures above the acceptable range of 17.5°C–22.5°C (63.5°F–72.5°F). 
Monitor the temperature inside the BSC to ensure that it does not exceed 
this range.

Sash

View screen

AMS gauge and control panel

BSC gauge and control panel

Storage cabinet

Armrest/bypass
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excess heat inside the BSC. Lowering the temperature inside the lab will also help 
keep the temperature down.

Figure 11-2  FlexAIR canopy installed on the BSC

For safety information about the BSC, see the BD FACSAria Fusion Safety and 
Limitations Guide. Additional BSC information not contained in this guide can 
be found in The Baker Company Biosafety Cabinet for BD FACSAria Fusion 
Operator’s Manual.

View Screen

The view screen is made from safety plate glass and is the barrier between the 
BSC work area and the user.

• Maximum opening: The view screen can be opened to a maximum of 
18 inches to allow temporary full access to the work area.

• Minimum opening: The view screen can be fully closed. 

FlexAIR canopy
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Sash

The sash is the bottom edge of the view screen. Grip the sash and slowly:

• Pull down to close the view screen

• Push up to open the view screen

Safe Work Access Opening

The safe work access opening is marked by a red arrow located on both sides of 
the BSC frame. Ensure that the sash is at this level each time you work in the 
BSC.

The safe work access opening is 8 inches, which provides biosafety 
protection. If the sash is raised above 8 inches for more than 3 seconds, an 
alarm sounds.

View screen

Safe work access marker

Sash
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Ready Safe Mode

The ready safe mode is an energy saving mode for when the BSC is not in use. To 
put the BSC in ready safe mode:

• Keep the blower on.

• Lower the sash to fully close the view screen.

• Check the differential pressure gauge to verify that the pressure decreases. 
(See Differential Pressure Gauge on page 330 for more information.)

We recommend that you leave the BSC in ready safe mode when it is not being 
used.

Storage Cabinet

A storage cabinet is located on the left side of the BD FACSAria Fusion. Use the 
cabinet to store sample racks and tubes, squirt bottles, and other similar items to 
prevent obstruction of air flow. Open the door by gripping the knob and sliding it 
to the right.

Cabinet Gauge and Controls

The BSC differential pressure gauge and cabinet controls are located on the front 
of the BSC in the lower right corner. (The BSC and AMS controls are located on 
the same panel.) The BSC controls are on the right side of the panel 
(Figure 11-3).
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Figure 11-3  BSC Differential Pressure Gauge and Control Panel

Differential Pressure Gauge

The differential pressure gauge displays the difference in air pressure inside the 
BSC vs outside the BSC, measured in inch water column (inch WC). The reading 
should be the value obtained during certification ±20%. (See your BSC 
certification paperwork.) If the value drops below this level, the pressure alarm 
will sound and an orange indicator LED will flash. See Buttons and LED 
Indicators on page 331.

Differential pressure gauge

Cabinet controls panel

Light

Blower

Alarm reset/mute

Alarm indicator LEDs
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Buttons and LED Indicators

The following table describes the function of the BSC control buttons and the 
meaning of the LED indicators located above each button.

LED Alarm Indicators

LED indicators to the right of the Alarm button are illuminated when there is an 
alarm condition.The following table describes the LEDs and conditions that 
trigger them. 

Button Function
LED 
indicates

LED 
color

Comments

Light Turns the light on and 
off

Power 
is on

Blue Two fluorescent lamps light 
the work area.

Blower Turns the blower on 
and off

Power 
is on

Green The blower creates the air 
flow patterns inside the BSC.

Power 
is off

Flashing 
green

–

Alarm Mutes the alarm for 
5 minutes or resets it

See LED Alarm Indicators.

Alarm LED Color Condition

Sash Flashing red • The sash is raised above the 8-inch 
safe opening height.

• The sash is lowered to fully close 
the view screen (until the pressure 
decreases).



332 BD FACSAria Fusion User’s Guide   

Audible Alarms

An LED indicator to the right of the alarm button is illuminated when there is an 
alarm condition. Audible alarms differ for each alarm type. The following table 
describes the alarms and conditions that trigger them.

Pressure Flashing orange • The air pressure differential drops 
to an unsafe exhaust airflow level.

• The air pressure differential has 
not reached the proper level. (This 
occurs when the blower is first 
turned on.)

Solid orange The air pressure problem was 
corrected. Press the alarm button to 
reset the alarm.

FlexAIRa (if installed) Flashing yellow The air flow through the canopy 
drops to an unsafe level.

a. The optional FlexAIR canopy can be purchased to connect the BSC to an in-house exhaust system.

LED Indicator Audible Alarm Condition

Sash Sounds once per 
second.

The sash is positioned at an unsafe level 
for more than 3 seconds.

Pressure Sounds four times per 
second followed by a 
two-second delay.

• The air pressure differential drops to 
an unsafe exhaust air flow level.

• The air pressure differential has not 
reached the proper level. (This occurs 
when the blower is first turned on.)

FlexAIRa 
(if installed)

a. The optional FlexAIR canopy can be purchased to connect the BSC to an in-house exhaust system.

Sounds two times per 
second.

The air flow through the canopy drops to 
an unsafe level.

Alarm LED Color Condition



 Chapter 11: Biosafety Cabinet Option 333

For detailed instructions on how to use the BSC, what the alarm conditions 
indicate, and how to reset them, see The Baker Company Biosafety Cabinet for 
BD FACSAria Fusion Operator’s Manual.

Aerosol Management System

An AMS is incorporated into the BSC to rapidly evacuate aerosolized particles 
from the sort collection chamber during sorting or analysis. Equipped with a 
separate HEPA filter, the AMS operates independently of the BSC. The AMS will 
continue to operate if the BSC blower fails, providing an additional level of 
biosafety protection.

AMS Gauge and Controls

The AMS air flow gauge and controls are located on the front of the BSC in the 
lower right corner, to the left of the BSC controls.

Air flow gauge

AMS on/High

AMS on/Low

AMS off
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Air Flow Gauge

The air flow gauge indicates the amount of suction being applied to evacuate the 
sort collection chamber and the aspirator drawer. The air flow is measured in 
cubic feet per minute (CFM). 

The air flow value should be:

• Low: 14 CFM ±1 CFM

• High: >26 CFM

See Buttons and LED Indicators and Audible Alarms on page 335.

Buttons and LED Indicators

The following table describes the functions of the AMS control buttons and the 
meaning of the LED indicators located above each button.

Button Function
LED 
Color

Comments

AMS off Turns the AMS off Blue Turn the AMS off when it is 
not in use.

AMS on/Low Turns the AMS and low 
suction on. Turns low suction 
off.

Blue Use low suction during 
normal sorting.

AMS on/High Turns the AMS and high 
suction on. Turns high 
suction off.

Blue Use high suction while 
removing a clog.
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Audible Alarms

An LED indicator will flash above the corresponding button when there is an 
alarm condition. The following table describes the meaning of the LED indicators 
and the alarms and conditions that trigger them.

Operating the AMS

1 To turn on the AMS, press either the Low or the High button.

• A blue indicator LED is illuminated over the button. 

• The air flow gauge goes through a startup sequence and then 
equilibrates.

2 Operate the AMS in:

• Low during normal sorting.

• High while removing a clog. See Responding to a Nozzle Clog During 
a Sort on page 336 to troubleshoot a nozzle clog. 

3 Press the AMS Off button to turn off the AMS.

LED Indicator LED Color Audible Alarm? Condition

AMS on/Low Flashing orange Yes The air flow is outside the range of 
14 ±1 CFM. (This also occurs when 
the AMS is first turned on.)

AMS on/High Flashing orange Yes The air flow is <26 CFM. (This also 
occurs when the AMS is first 
turned on.)

The AMS does not eliminate the health risks of working with biohazardous 
material and must be used in conjunction with good laboratory practice.
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• A blue indicator LED is illuminated over the AMS off button.

• The flow air gauge shuts off.

Responding to a Nozzle Clog During a Sort

If the stream is disturbed during the sort (due in part to a clogged nozzle), the 
sort is designed to stop automatically and block the sort tubes (if the Sweet Spot 
is on). The sort will not restart until the operator has cleared the clog. In the 
event of a nozzle clog, do not open the sort collection chamber door or access the 
sort tubes before following this procedure.

To clear a clogged nozzle on a system with the AMS:

1 Keep the sort chamber door closed.

2 If the stream has not already shut down automatically, turn off the stream 
by clicking the Stream button (with a checkmark) at the top of the Breakoff 
window.

This will shut off the stream, unload the sample, and close the aspirator 
drawer.

3 Increase the air evacuation rate to high.

4 Open the aspirator drawer using the software controls (see Figure 1-12 on 
page 32). 

5 Wait at least 60 seconds. 

This procedure will clear aerosols from the sort chamber.

Cell sorters that use droplet generation methods, such as the 
BD FACSAria Fusion, can produce aerosols around the sample stream. 
When acquiring biohazardous samples, follow universal precautions at all 
times. Keep the sort block door and the sort collection chamber door closed 
during sorting. Follow these steps to stop sample flow and evacuate 
potential aerosols before opening the sort collection chamber door.
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6 Close the aspirator drawer.

7 Turn on the stream and view the breakoff.

If the clog is removed, the breakoff will be similar to the breakoff before 
the clog.

8 If the clog is not cleared, turn the stream on and off several times to see if 
the clog has cleared.

9 If the clog is not removed, turn the stream off and perform the Clean Flow 
Cell procedure with DI water (see Cleaning the Flow Cell (Daily) on 
page 206), followed by turning the stream on to see if the clog has cleared.

10 Open the aspirator drawer and evacuate for at least 60 seconds before 
closing the aspirator drawer again.

11 You can now open the sort collection chamber and remove the sort 
collection device.

12 If it is necessary to change nozzles or remove a clog from a nozzle, see 
Cleaning the Integrated Nozzle on page 233.

13 With stream turned off, open the sort block door and dry the plates and 
surfaces as needed.

14 When removing collection tubes, be aware that the outside of the tube is 
potentially contaminated. Use alcohol swabs or bleach to wipe the outsides 
of tubes.

15 Press the AMS Low button.

16 Make sure that all chamber doors are closed and restart the stream.

17 Perform these tasks if needed:

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing, eyewear, and gloves.
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• Turn on the Sweet Spot

• Check the drop delay

• Check the side stream deflection

Working in the BSC

When working inside the BSC, we recommend that you:

• Keep the blower on at all times. 

• Keep the AMS on while sorting.

• Keep the view screen closed to the safe-access opening of 8 inches each time 
you work in the BSC.

• Do not work in the BSC if an alarm sounds and the corresponding 
indicator is illuminated. See the The Baker Company Biosafety Cabinet for 
BD FACSAria Fusion Operator’s Manual for troubleshooting information. 
If additional assistance is required, contact your local BD Biosciences 
technical support representative or supplier.

• Do not block the intake grilles or the diffusers because it obstructs air flow.

• Do not store anything in front of the cytometer. Keep sample tubes and 
racks, squirt bottles, and other similar items inside the instrument storage 
cabinet to prevent obstruction of air flow.

NOTE Consult a qualified safety professional for decontamination procedures 
appropriate for you laboratory.

• Decontaminate the BSC and cytometer before:

- Turning off the blower.

- Having maintenance or service performed.
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• Keep the blower on at all times and keep the view screen closed when the 
BSC is not being used, especially if you want the inside of the BSC to 
remain contamination-free. 

• Use an adjustable chair for comfort.

Cleaning the BSC

Use this procedure to clean the BSC after sorting potentially infectious agents.

Materials

• 10% chlorine bleach (0.5% sodium hypochlorite) solution

• 70% isopropyl alcohol

• Paper towels

Procedure

To clean the BSC:

1 Wipe down the following areas using paper towels and 10% bleach (0.5% 
sodium hypochlorite) solution:

• Floor of the BSC in front of the cytometer, and on each side

• Inside and outside surfaces of the view screen

Bleach can cause stainless steel to pit and crack. Ensure that you wipe down 
the BSC with 70% isopropyl alcohol to remove the bleach solution.

Any surface that comes in contact with biological specimens can transmit 
potentially fatal disease. Use universal precautions when cleaning the BSC. 
Wear suitable protective clothing, eyewear, and gloves.
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• Armrest/bypass

• Cabinet Controls panel

• Any other areas that might be contaminated

2 Repeat step 1 using 70% isopropyl alcohol.

Cleaning the Base Pan

NOTE Before cleaning the base pan, clean the inside of the BSC. See Cleaning the 
BSC on page 339. 

Use the following procedure to clean the base pan.

Materials

• 10% chlorine bleach (0.5% sodium hypochlorite)

• 70% isopropyl alcohol

• Paper towels

• A cleaning tool to reach into the base pan

Bleach can cause stainless steel to pit and crack. Ensure that you wipe down 
the BSC with 70% isopropyl alcohol to remove the bleach solution.
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Procedure

To clean the BSC:

1 Press in on the armrest/bypass and lift it up.

2 Remove the armrest/bypass.

3 Wipe down the armrest/bypass using paper towels and 10% bleach (0.5% 
sodium hypochlorite) solution.

4 Wipe down the armrest/bypass using paper towels and 70% isopropyl 
alcohol.

5 Set the armrest/bypass aside.

6 Wipe down the base pan using a cleaning tool and a 10% bleach (0.5% 
sodium hypochlorite) solution. Ensure that you also wipe down the areas 
underneath the electronic cables.

Any surface that comes in contact with biological specimens can transmit 
potentially fatal disease. Use universal precautions when cleaning the base 
pan. Wear suitable protective clothing, eyewear, and gloves.

Armrest/bypass
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7 Wipe down the base pan using a cleaning tool and 70% isopropyl alcohol.

8 Check the position of the tabs above the base pan on either side of the BSC.

9 Reinstall the armrest/bypass by sliding it into position over the tabs.

Base pan

Electronic 
cables

Tab on left side of BSC
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10 Lock the armrest/bypass into place by pushing it down and back so that the 
bottom snaps into place behind the lip of the base pan.

Replacing the Electronics Cable Plastic Sleeve

Some of the electronics cables for the BD FACSAria Fusion are located under the 
cytometer in the base pan. The cables are wrapped in plastic sleeves to protect the 
cables from exposure to liquids. When cleaning the base pan, check the plastic 
sleeves and replace them as necessary. Replacements are located in the spares kit.

To replace the plastic sleeves:

1 Remove the armrest/bypass by following step 1 through step 5 in Cleaning 
the Base Pan on page 340.

2 Check the plastic sleeves covering the electronic cables in the left and right 
sides of the base pan.

Figure 11-4  Electronic cables in the base pan

3 If necessary, remove the plastic sleeves by carefully removing the ties at 
each end of the sleeve and peeling off the plastic sleeve.

4 Wrap the cable bundles with new plastic sleeves and secure with ties at each 
end as shown in Figure 11-4.
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Ergonomics Safety Guidelines

The following tables describe the monitor locations to provide optimum 
ergonomics for using the system monitors in a standing or seated station. A 
standing station is one where the operator stands or sits on a tall stool that places 
the operator at approximately the same height as standing, in front of the system 
monitors. A seated station is one where the operator sits on a short, office-style 
chair in front of the system monitor(s).

Table 11-1  Monitor location for standing stations

Display type Height

Single monitor 147 cm (58 in.) (maximum)

132 cm (52 in.) (minimum)

Stacked dual monitors (the primary 
monitor is the bottom monitor)

168 cm (66 in.) (maximum)

Table 11-2  Monitor location for seated stations

Display type Height

Single monitor 51.7 cm (20.0 in.) (maximum)

26.7 cm (10.5 in.) (minimum)

Stacked dual monitors (the primary 
monitor is the bottom monitor)

72.4 cm (28.5 in.) (maximum)

26.7 cm (10.5 in.) (minimum)
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12

Temperature Control Option

The BD™ temperature control option can be used to control the temperature of 
sorted samples in the BD FACSAria Fusion flow cytometer.

The following topics are described:

• Option Components on page 346

• Using the BD Temperature Control Option on page 347

• Maintenance on page 354

• Specifications on page 355
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Option Components

The BD temperature control option includes the following:

• A recirculating water bath

• Specially designed collection tube holders with ports for recirculating water

Tube holders are available in these styles: two-way 15-mL, four-way 12 x 
75-mm, and four-way 1.5-mL Eppendorf tubes. See Figure 12-1.

Figure 12-1  Temperature control option components

Four-way 12 x 
75-mm

Four-way 1.5-mL 
EppendorfWater bath

Two-way 15 mL
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The BD temperature control option is For Research Use Only. It is not for use in 
diagnostic or therapeutic procedures.

Using the BD Temperature Control Option

Note that before you start the recirculating water bath, you must attach the 
tubing to the appropriate collection device.

Setting Up the Water Bath

1 Remove the threaded plug from the output port on the water bath.

2 Ensure that the drain cock on the back of the water bath is closed by 
turning it fully clockwise.

3 Set the pump outflow to maximum by turning the knob fully counter-
clockwise.

Remove the top cover to access the knob, which is located inside the water 
bath toward the back. See the operating instructions supplied with the 
water bath for additional details on this process. This is referred to as 
position 1.

4 Connect the clear tubing end of the insulated hoses to the input and output 
ports on the water bath. (See Figure 12-2 on page 348.)

When acquiring biohazardous samples, follow universal precautions at all 
times. Keep the sort block door and the sort collection chamber door closed 
during sorting. We recommend that you use the BD Aerosol Management 
Option (for systems without a BSC) or the BD Aerosol Management System 
(for systems with a BSC) when sorting biohazardous samples into the 
temperature control tube holders. If the nozzle develops a clog, see 
Responding to a Nozzle Clog During a Sort with the AMO on page 310 or 
Responding to a Nozzle Clog During a Sort on page 336 (for systems with 
the AMS).
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Slide the tubing over the hose barbs and twist gently while installing to get 
the tubing completely over the barbs.

Figure 12-2  Input and output ports on water bath

5 Connect the insulated hoses from the recirculating water bath to the ports 
on the right side of the cytometer base (Figure 12-3).

NOTE Because the water flow direction is controlled by the water bath 
pump, the ports on the cytometer base are multi-directional. The input and 
output hoses from the water bath can be connected to either port on the 
cytometer base.

Figure 12-3  Ports for temperature control option

6 Fill the water bath with distilled water containing 0.1 g/L of sodium 
carbonate.

Sodium carbonate helps reduce corrosion. See the water bath 
manufacturer’s documentation for fill levels and other setup information.
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NOTE We do not recommend using ethylene glycol (antifreeze) in the 
water bath.

7 Plug in the water bath power cord.

NOTE Do not start up the water bath until after you have connected the 
recirculating water tubing, as described in the following sections.

Setting Up the Tube Holder

This section describes how to install the temperature control tube holder on the 
instrument and how to attach the recirculating water tubing to the tube holder. 

1 Place collection tubes in the temperature control tube holder.

Tube holders are available for 15-mL two-way sorting, 12 x 75-mm four-
way sorting, and 1.5-mL Eppendorf tube four-way sorting. For compatible 
tubes, see Supplies and Consumables on page 275.

2 Attach the recirculating water tubing to the tube holder.

a Close the sort block door and open the sort collection chamber door, if 
needed. (The sort block door must be closed to open the collection 
chamber door.)

Note that the tubing ports are labeled In and Out. Attach the input 
tubing to the port on the left side of the collection tube holder, and the 
output tubing to the port on the right side, as shown in Figure 12-4 on 
page 350.

b To attach the tubing, push it into the port until the tubing snaps into 
place.

Any instrument surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves. 
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Figure 12-4  Setting up the temperature control tube holder

If you need to remove the tubing, push in the orange collar as you pull the 
tubing out of the port.

3 Install the tube holder on the instrument.

Remove the current tube holder (if one is installed), and slide the 
temperature control tube holder into the slotted fittings below the sort 
aspirator drawer. Push the tube holder all the way in.

4 Close the sort collection chamber door and start up the water bath.

Setting Up the ACDU Stage

This section describes how to attach the recirculating water tubing to the stage 
used with the automated cell deposition unit (ACDU). 

1 Install the splash shield below the aspirator drawer.

Any instrument surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing, eyewear, and gloves. 

Input tubing Output tubing

Tubing ports inside 
collection chamber
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a Close the sort block door and open the sort collection chamber door, if 
needed. (The sort block door must be closed to open the collection 
chamber door.)

b Remove the tube holder, if one is installed. 

c Insert the splash shield into the slotted fittings below the sort aspirator 
drawer. Push the splash shield all the way in.

2 Click the Access Stage button to bring the ACDU stage to the front.

a Open an experiment, if one is not already open, and create a sort 
layout for any of the tubes.

b In the Sort Layout view, click the Access Stage button to move the stage 
to the front of the sort collection chamber.

3 Attach the recirculating water tubing to the ACDU stage.

Note that the tubing ports are labeled In and Out. Attach the input tubing 
to the port on the left side of the stage, and the output tubing to the port on 
the right side, as shown in Figure 12-5 on page 352.

To attach the tubing, push it into the port until the tubing snaps into place.
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Figure 12-5  Setting up the temperature control on ACDU stage

er

If you need to remove the tubing, push in the orange collar as you pull the 
tubing out of the port.

4 Install the appropriate collection device on the stage.

5 Close the sort collection chamber door and start up the water bath.

Tubing ports

Input tubing Output tubing



 Chapter 12: Temperature Control Option 353

Starting Up the Water Bath

NOTE To ensure that the sample collection device is at the correct temperature, 
start up the water bath (115-V and 110-V models) at least 90 minutes before you 
start sorting.

1 Switch on the main power on the water bath control panel.

2 Use the up or down arrow keys to set the required temperature.

NOTE To achieve the required sample temperature, you will need to set the 
water bath temperature slightly higher or lower (see Table 12-1). These 
settings might need adjustment depending on the ambient temperature in 
your laboratory. We recommend that you calibrate the water bath for your 
operating environment.

3 Wait at least 90 minutes to allow the recirculating water to reach the 
required temperature.

Table 12-1  Water bath settings for corresponding sample temperature

Required Sample Temp (°C) Water Bath Setting (°C)

4 2

37 37.5

42 43.2

Main power 
switch
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Maintenance

To maintain the recirculating water bath, see the documentation provided by the 
manufacturer.

Tube Holders

Remove the tube holders when you are finished using them, and clean them 
periodically before storage. 

To detach the recirculating water tubing, push in the orange collar as you pull the 
tubing out of the port.

Clean the temperature control tube holders by wiping them down with an 
appropriate cleaning fluid (for example, 70% ethanol, 5% bleach, or DI water). 
Dry them with a lint-free cloth before storage.

Recirculating Water Tubing

Inspect the tubing periodically for leaks, plugs, or contaminants. If needed, 
remove the tubing and clean it with an appropriate cleaning solution, or replace 
the tubing. Contact your BD Biosciences service representative for replacement 
tubing.

When you detach the recirculating water tubing from the tube holder, any 
fluid remaining in the tubing can leak into the sort collection chamber. To 
ensure that fluid is aspirated from the sort collection chamber, make sure 
that the sort chamber aspirator pump is on (do not turn off the instrument 
main power) before you detach the tubing. Use caution when handling 
tubing containing hot water.
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Specifications

Specifications for the recirculating water bath are as follows.

NOTE The following specifications are for the US version only.

The temperature control option includes the Lauda® Ecoline cooling/heating 
bath, model RE 106.

• Operating temperature range: –20°C–20°C

• Ambient temperature range: 5°C–40°C

• Heater power for 115 V/60 Hz: 1.3 kW

• Maximum flow rate at pump output of 5: 17 L/min

• Maximum bath volume: 4–6 L

• Power consumption for 115 V/60 Hz: 1.4 kW

For more information, see the manufacturer’s documentation.
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Index

Numerics

4-Way Purity mode 77

A

aborts
See also conflicts, sort
electronic 270

Access Stage button 110
accessory kit, contents 278
Accudrop

about 71
beads, sorting in Initial mode 180
experiment 114, 176
optimizing drop delay 178

ACDU See automated cell deposition unit
acquisition

controls 100
events to record 156
troubleshooting 265

Acquisition Dashboard 100
adding

cytometer configurations 92
folders 149
sort layouts 107, 184
sort populations 107, 184

adjusting
amplitude 68, 123
area scaling 143, 144, 145
Drop 1 68, 125
drop delay 178
flow rate 50, 100
Home location 194
laser delay 165
micrometer dial 179, 182
PMT voltages 62
side streams 194
sort block angle 31, 232
Window Extension 166

aerosol management option (AMO)
about 33
changing filters 229
components 304
evacuator components 305
maintenance 312
specifications 323
starting up the evacuator 306
troubleshooting 320
ULPA filter 305
using 303–323

agitating samples 85
air

external 44
filters, changing 229
line 119, 209
pressure 43
supply, external 44
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air flow gauge
AMS 334

alarms
AMS 335
BSC 331, 332

AMO See aerosol management option
amplitude

about 66
adjusting 68, 123

AMS
air flow gauge 334
alarms 335
buttons 334
LED indicators 334

analysis
batch 162
data 155
printing 161
sorting 160, 171, 183

application settings
about 141
adjusting area scaling 143
creating 142
optimizing PMT voltages 146
saving 147
window 150

applications
custom 92
recommended flow rates 51
recommended sort setup 103

area parameters 61
arrays, detector 40, 54
aseptic sorting 215
aspirator drawer

about 32
opening 70, 110, 186

assistance, technical xv
attenuation control 70

auto drop delay
about 72
graph 182
overview 181
using 181

autoclaving sheath tank 215
automated cell deposition unit (ACDU)

about 34
accessing stage 110
chamber 34
collection devices 195
custom devices 197
installing splash shield 192
sorting 192
troubleshooting 261

B

backflush, sample line 212
bandpass filters 57
base configurations 94
base pan

cleaning 340
batch analysis, performing 162
BD FACSAria Fusion

about 18
cytometer 21
workstation 19

BD FACSDiva software See software
beads

Accudrop 178
calibration 282
CS&T research 138
setup 136

beam splitters 56
biexponential

display 158
sort gates 183

bleach fluid line 216
bleeding filters 217
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breakoff
drop 65
setting up 123–125
troubleshooting 123, 259
window 66, 102

BSC
alarms 331, 332
cleaning 339
LED indicators 331
maintenance 339
ready safe mode 329
safe work access 328
sash 328
view screen 327

bubble detector 27
bulk sorting 171
buttons

See also controls
Access Stage 110
AMS 334
chamber light 26
emergency stop 44
Load 100
Sort 109
Unload 100
waste drawer 70

C

calculating compensation 152
cameras

about 42, 71
cleaning windows 244

cap, waste 133
chambers

ACDU 34
sample injection 26
sort block 30
sort collection 34

changing
air filters 229
fluid filters 218
nozzles 231
optical filters 249
pinch valve tubing 241
sample lines 219, 221
waste cap 133

charging drops 72
cleaning

base pan 340
BSC 339
camera windows 244
cytometer 210, 212
flow cell 206
fluidics 215
mode failure 272
modes 212
nozzles 233
optical filters 250
strobe lens 245

clogged nozzle
cleaning 233
responding to during a sort 190
responding to during a sort with 

AMO 310
responding to during a sort with 

AMS 336
closed-loop nozzle

cleaning 237
for shutdown 206
installing 208
maintenance 237
replacing tubing 238

coefficient of variation (CV), high 269
collection

devices 34, 105
optics 39
tubes, replacing 188

collet fitting 225
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compensation
calculating 152
controls, creating 151
gating data 154
setup 154

components
AMS 335
BD FACSDiva workspace 82, 101
BSC 20
cytometer 21
electronics 43
fluidics 25
optics 35
workstation 19

computer
about 19
shutting down 207, 210

configuration, cytometer
about 59, 87, 88
adding 92
and sort setup 98
copying 94
custom 92
editing 96
mismatch dialog 140
selecting 136

conflicts, sort
about 73
counting 110
printing 112
saving 108, 184
troubleshooting 263

connecting
external air 44

containers
about 22
autoclaving 215
emptying waste 132
refilling 130

containment device, sheath probe 214

controls
See also buttons
ACDU stage 110
acquisition 100
aspirator drawer 70, 110
attenuation 70
BSC 329
compensation 151
cytometer (software) 83
flow rate 100
fluidics 83
optical filter 70, 71
sorting 101, 102, 109
stream 66
Sweet Spot 66
test sort 70
tube loading 100
voltage 70
waste drawer 70

conventions, user’s guide xiv
cooling samples 85, 117
cord, fluidics cart 43
counters, sorting 110
creating

analysis objects 160
application settings 142
compensation controls 151
custom devices 103, 197
folders 149
sort layouts 107, 184
sort precision modes 78
statistics view 161

CS&T See Cytometer Setup and Tracking
custom devices 103, 197
custom optical filters 249
customer support xv
cuvette flow cell

about 28
cleaning 206
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cytometer
about 21
adding configurations 92
cleaning 210, 212
configuration 59, 87, 88, 136
controls, software 83
disconnect error 274
electronics 43
fluidics 25, 48
not responding 274
optics 35
performance 134
power 116
QC particles 282
shutting down 206, 207
starting 116
status report 90
supplies 276
workstation 19

Cytometer Setup and Tracking (CS&T)
menu selections 87
overview 134
research beads 138
window 135

D

daily shutdown procedure 206
Dashboard, Acquisition 100
data

analyzing 155, 160
gating 154, 160
recording 155, 159

data collection, overview 148
deflection

drop 73
plates 31, 172

removing 247
troubleshooting 262

deflection plate removal tool 247

delay
drop 70, 71, 176

See also Accudrop
laser 63, 165

deleting
custom devices 198
sort populations 109
sort precision modes 79

detectors 40, 54, 59
detector configurations 289
detector locations 287

devices, sorting 105, 197, 198
diode laser 42, 71
discriminating filters 57
doors, sort collection chamber 35
doublets

discrimination experiment 114
discrimination gating 149
eliminating 159

drain plug 133
drawer See aspirator drawer
drop

auto delay 181
breakoff 65
charging 72
conflicts 73
correction factors 71, 173
deflection 73
delay 70, 71, 176, 178

See also Accudrop
drive frequency 66
formation 65
satellites 124

Drop 1
about 66, 67
adjusting 68, 125
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E

editing
cytometer configurations 96
sort layouts 109
statistics view 161

electronics
aborts 270
about 43
signal processing 60
troubleshooting 274

emergency stop button 44
emission

spectra 53
emptying waste 132
error messages

cleaning mode failure 272
cytometer disconnected 274
cytometer not responding 274
Master DAQ overflow 274

ethanol shutdown
tank

capacity 126
refilling 129

events
not showing in plots 265, 267
rate, troubleshooting 268, 269
target 107, 184
troubleshooting 270

excitation optics 35
Experiment Layout 156
experiments

Accudrop 114, 176
cytometer QC 114
doublet discrimination 114
setting up 156
sorting 184
templates 114

exporting sort reports 113, 187

F

FACSAria Fusion See BD FACSAria 
Fusion

FACSDiva software See software
ferrules, removing 224, 227
fiber optics 37
filling containers 130
filters

about 55
air, changing 229
bandpass 57
changing 218, 249
discriminating 57
fluid, changing 218
holders 278
longpass 56
neutral density (ND) 58, 251, 278
optical 55, 250
purging 217
removing 218, 251
sample line 239, 240

Fine Tune mode 78
flow cell

about 28
access door 185
cleaning 206

flow rate
about 51
adjusting 50, 100
recommendations 51

fluid
bleach line 216
containers 22
filters 218
level indicators 86
line 119, 209
movement 48
out port 217
priming 131, 213
refilling 130
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fluidics
about 48
cleaning 215
components 25
containers 22
controls 83
daily shutdown 206
level indicators 86
power 43
shutdown 84, 207
startup 49, 83, 119
system 48
troubleshooting 272

fluidics cart
cord 121
power 43

fluorescence
about 53
emission spectra 53
signal, troubleshooting 266

folders, adding 149
forward scatter (FSC)

about 52
detector 59
ND filter 251, 278

removing 251
frequency, drop drive 66
FSC See forward scatter

G

Gap 66, 67
gating

compensation controls 154
data 160
during sorting 183

global worksheets
adding sort layouts 107, 184
previewing data 155
setting up 157

H

hardware, ACDU 192
hazard symbols xiv
hazards, mechanical 44
heating samples 85, 117
height parameters 61
holders

collection tube 34, 171, 350
optical filter 278
sample tube 28

Home Device 103, 194, 195
hydrodynamic focusing 51

I

index sorting
description 199
setting up for 199

Initial mode 78
installing

collection tube holders 171, 350
nozzle 231
plates 193, 352
sample line filter 239
sample tubes 28
slides 193, 352
splash shield 192

instrument See cytometer
integrated nozzle

about 29
changing 231
cleaning 233
replacing seal 236

interrogation point 28

L

labels, parameter 156
label-specific tubes 151
labware, parts list 284
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lasers
about 35
configurations 36
delay 63, 165
diode 42, 71
laser options 285
shutting down 207, 210
starting 116, 117
warmup time 116, 117

layout See sort layouts
leaks, troubleshooting 273
LED indicators

AMS 334
BSC 331

lens, strobe 245
levels

fluid 86
sample 26

lever, nozzle 120, 231
light

detection 54
injection chamber 26
scatter signals 52
voltage warning 31

limitations xvi
Link & Save 154
Load button 100
loader, plate 35
loading tubes 28, 50
long clean 272
longpass filters 56

M

maintenance
AMO 312
BSC 339
scheduled 211
temperature control option 354
unscheduled 230

managing aerosols 32
AMO 306
AMS 335

Masks
about 73
default precision modes 77
Phase 76
Purity 75
Yield 74

Master DAQ overflow error 274
micrometer dial 42, 179, 182
mirrors, dichroic 56
mismatch dialog

configuration 140
cytometer settings 151

modes
defining 78
deleting 79
sort precision 73, 77

monitoring sorts 111, 187

N

ND filters 58, 251, 278
neutral density filters 58, 251, 278
nozzles

See also closed-loop nozzle
about 29
breakoff patterns 125
changing 231
cleaning 233
integrated 29
lever 120, 231
O-ring 279
responding to clogs 190
responding to clogs with AMO 310
responding to clogs with AMS 336
sizes 103, 231
spare 279



 Index 365

O

octagon
about 39, 40, 54

opening
aspirator drawer 70, 110, 186
sample injection chamber 28

Optical Filter control 70, 71
optical filters

about 55
changing 249
cleaning 250
custom 249

optics
about 35
collection 39
excitation 35
fiber 37
filter holders 278
reordering 276
stream-viewing 42

optimizing
cytometer settings 148
drop delay 178
PMT voltages 146
streams 194

ordering supplies 275
O-ring

nozzle 279
sample injection chamber 248

P

parameters
about 61
adding 59, 88, 92
labels 156
measuring 62
scatter, distorted 269

parts, replacement 281
pausing sorting 68, 110, 189

performance
check, running 138
tracking 88

phase
field 71
masks 74, 76

photodiodes 59
photomultiplier tubes (PMTs)

about 40, 59
applying voltages 62
assigning 59, 88, 92
optimizing for application 

settings 146
pinch valve

changing tubing 241
collet fitting 243

plate loader 35
plate voltage 71
plates

deflection 31, 172
removing 247

installing 193, 352
sorting into 192

plots
excessive debris 270
no events in 265
unexpected events in 267

PMTs See photomultiplier tubes
populations

sorting 72, 107, 183, 184
troubleshooting 263, 270

power
cytometer 116
fluidics cart 43

precision modes 73, 77
See also sort precision modes

preferences, user 160
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pressure
air 43
sample 50
sheath 49, 84
sort, default values 103
troubleshooting 272

priming fluids 131, 213
printing

sort reports 113, 187
worksheets 161

pulse, electronic 60
purging filters 217
Purity

Masks 75
mode 77, 184

Q

quality control (QC)
experiment 114
particles 282

R

ready safe mode 329
reagents, parts list 283
recording

data 155, 159
during sorting 186

refilling
ethanol shutdown

tank 129
plastic containers 130
sheath tank 127

removal tool, deflection plate 247
removing

deflection plates 247
ferrules 224, 227
filters 218, 249, 251
sample line filter 239

replacement parts 281

replacing
closed-loop nozzle tubing 238
tubes 187

reports
cytometer status 90
printing 113, 187
sort 112, 113

results, troubleshooting 264
rotating sort block 31, 232
running performance check 138

S

safety, general 44
sample

agitation 85
core diameter 51
flow 48, 50
injection chamber

about 26
lubricating O-ring 248
sample line 240

interrogation 28
line

backflush 212
changing 219, 221
filter 239, 240

pressure 50
temperature 85, 117
tubes, replacing 188

samples
heating 85, 117
running 159

sash
BSC 328

satellites, drop 124
Save Conflicts 108, 184
saving

application settings 147
sort conflicts 108, 184
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scatter
light 52
parameters, distorted 269

second laser
adjusting delay 165

settings
See also application settings
optimizing 148

setup
beads 136
compensation 154
values, sort 103, 104

sheath
flow 49
line 217
pressure 49, 84
reservoir, autoclaving 215

sheath filter
purging 218

sheath probe
containment device 214
removing 213

sheath tank
capacity 126
changing air filter 229
connectors 127
refilling 127
required location 128

shutdown tank, ethanol
capacity 126
refilling 129

shutting down
computer 207, 210
daily procedure 206
fluidics 84, 206, 207
lasers 207, 210

side scatter (SSC) 52
side streams

optimizing 194
window 69, 102

signals
about 52
detection 54
fluorescence 53
generating 60
low Area 267
no fluorescence 266
scattered light 52
troubleshooting 271

Single Cell mode 78
slides

installing 193, 352
sorting into 192

software
about 19
cleaning modes 212
components 82, 101
cytometer controls 83
templates 114

sort
block 30, 33
collection

chamber 34
devices 34

Sort button 109
sort layouts

about 72
creating 107, 184
custom 103, 197
editing 109
entering populations 107, 184

sort menu 102
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sort precision modes
4-Way Purity 77, 184
about 73
creating 78, 102
defaults 77
deleting 79
Fine Tune 78
Initial 78
Purity 77
Single Cell 78
Yield 78

sort reports
about 112
exporting 113, 187
printing 113, 187

sort setup values 103, 104
sort, test 70, 173

sorting
about 64, 169
Accudrop beads 180
analysis 160, 171, 183
aseptic 215
aspirator drawer control 70, 110
bulk 171
collection devices 105
conflicts 73, 108, 110, 184, 263
controls 101, 109
counters 110
experiment 184
gates 183
index 199
into plates 192
into slides 192
into tubes 171
monitoring 111, 187
pausing 68, 110, 189
populations 72, 107, 183, 184
recording data 186
resuming 187, 189
setup 170
starting 109, 185
stopping 109
troubleshooting 260

specifications
temperature control option 355

splash shield, installing 192
stage, accessing 110
starting

cytometer 116
fluidics 49, 83, 119
lasers 116, 117
sorting 109, 185
stream 121

statistics view, creating 161
status, cytometer report 90
Stokes shift 53
stop button 44
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stopping sorting 109
stream

centering 70, 173
control 66
deflecting 71
flow rate 49
setting up 194
starting 121
troubleshooting 121, 254
viewing 42

stream-charging wire 73
strobe lens, cleaning 245, 246
supplies, cytometer 276
Sweet Spot

about 65, 68
control 66

symbols, hazard xiv

T

tanks See containers
target events 107, 184
technical assistance xv
temperature control option

about 34
maintenance 354
setting up ACDU 350
specifications 355
using 346–355
water bath 347

temperature, sample 85
templates, experiment 114
Terasaki plate adapter 203
test sort 70, 173, 195
threshold, troubleshooting 271
trap, waste 133

troubleshooting
ACDU 261
acquisition 265
AMO 320
breakoff 123, 259
CVs 269
deflection 262
electronic aborts 270
electronics 274
event rate 268, 269
fluidics cart 272
leaks 273
low Area signal 267
populations 263, 270
pressure 272
scatter parameters 269
signals 266, 271
sorting 260, 263, 264
stream 121, 254
threshold 271

tubes
adding sort layouts 107, 184
agitating 85
compensation 151
heating/cooling 85, 117
holders 28, 34
label-specific 151
loading 28, 50
replacing 188
sorting into 34, 171
unloading 28, 50

typographical conventions xiv

U

ULPA filter on AMO 305
Unload button 100
unloading tubes 28, 50
user preferences 160
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V

View Configurations selection 88
view screen

BSC 327
viewing global worksheets 157
views

statistics 161
violet laser

configuration 37
detector 54, 277
laser delay 63

voltage
adjusting PMT 62
controls 70
optimizing PMT 146
warning light 31

W

waste
aspirator 32
cap, changing 133
container parts 132
emptying 132

water bath 347, 353
width parameters 61
Window Extension

adjusting 166
windows

See also views
about 82, 101
Acquisition Dashboard 100
Breakoff 66
camera, cleaning 244
CS&T 135
cytometer configuration 88
device setup 195
Side Stream 69
strobe lens 246

worksheets
See also global worksheets
printing 161
viewing 157

workspace
components 82, 101
setting up 148
setting up CS&T 135

workstation
about 19
shutting down 207, 210

X

X-mount optical plate 37

Y

Yield
mask 74, 76
mode 78
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